
 

   

Ohio Department of Transportation 

October, 2012 

GEOPAK V8i SELECTseries 1, Road 2 



  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 
 
 
 
 
 
 
 
 
Ohio Department of Transportation 

GEOPAK Road Training Guide for MicroStation V8i SELECTseries 1, October, 2012 
 
 
 
 
 
 
 
 
 
 
 
The information provided in this manual is a product of ODOT and is not to be sold or otherwise 
distributed for profit.  If this manual is copied proper acknowledgment is to be given to GEOPAK 
Corporation and Bentley Systems, Incorporated for its content in this manual.  There are no expressed 
or implied warranties concerning the accuracy, completeness, reliability or usability of this information. 
Further, ODOT assumes no responsibility for any incorrect results or damage resulting from the use of 
this information.  All users shall expressly hold ODOT harmless from any liability or loss due to any 
computer or software generated problems associated with this product or manual. 
 
GEOPAK is a registered trademark of GEOPAK Corporation. MicroStation is a registered trademark and 
ModelServer is a trademark of Bentley Systems, Incorporated.  Windows and Windows NT are 
registered trademarks of Microsoft Corporation.  All other brands and products names are trademarks 
of their respective owners. © GEOPAK Corporation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
 Page i 
 

Table of Contents 

1 Getting Started ............................................................................................................ 1-1 

1.1 Course Outline/Prerequisites .......................................................................................1-1 

1.2 GEOPAK Support..........................................................................................................1-2 

1.3 ODOT CADD Standards for MicroStation and GEOPAK ..................................................1-3 
1.3.1 Standard Directory Structure ................................................................................... 1-3 
1.3.2 Standard MicroStation Design File Names............................................................... 1-4 

1.4 Provided Data ..............................................................................................................1-5 

Exercise 1 ................................................................................................................................1-6 
1. Create the Project Directories ................................................................................. 1-6 
2. Download the Training files ..................................................................................... 1-7 
3. Create a GEOPAK Project ......................................................................................... 1-8 

2 Existing Ground Cross Sections ..................................................................................... 2-1 

2.1 Overview .....................................................................................................................2-1 

2.2 Pattern Lines ...............................................................................................................2-2 
2.2.1 Pattern Line Design File............................................................................................ 2-3 
2.2.2 Draw Patterns Dialog Box ........................................................................................ 2-4 
2.2.3 Pattern Lines in Intersection Areas .......................................................................... 2-9 

2.3 Working Alignment Definition: Pattern ...................................................................... 2-10 
2.3.1 By Station ............................................................................................................... 2-10 
2.3.2 By Design File ......................................................................................................... 2-12 

2.4 Extracting Existing Ground Cross Sections ................................................................... 2-14 
2.4.1 Cross Section Design Files ...................................................................................... 2-14 
2.4.2 The Draw Cross Sections Dialog Box ...................................................................... 2-15 

The XS Cells Tab ..................................................................................................... 2-18 

The Surfaces Tab .................................................................................................... 2-21 

Draw ....................................................................................................................... 2-24 

2.5 Working Alignment Definition: Cross Section .............................................................. 2-25 

2.6 Cross Section Navigator ............................................................................................. 2-26 

Exercise 2 .............................................................................................................................. 2-31 

3 Underground Utilities .................................................................................................. 3-1 

3.1 Overview .....................................................................................................................3-1 

3.2 The Draw Ancillary Features Dialog ..............................................................................3-2 
3.2.1 Intersecting Elements .............................................................................................. 3-4 
3.2.2 Display Settings ........................................................................................................ 3-7 
3.2.3 The Draw Ancillary Features List Box ....................................................................... 3-9 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page ii  
 

3.2.4 File Options ............................................................................................................ 3-10 
3.2.5 Update Options ...................................................................................................... 3-10 

3.3 Cross Section Utility Processing Example .................................................................... 3-11 

3.4 Processing Multiple Utility Lines of the Same Type ..................................................... 3-13 
3.4.1 Drafting Utility Lines with Adhoc Attributes .......................................................... 3-15 
3.4.2 Adhoc Attribute Manager ...................................................................................... 3-16 
3.4.3 Processing Utilities with Adhoc Attributes ............................................................ 3-18 

3.5 Exercise 3 .................................................................................................................. 3-20 

4 Superelevation ............................................................................................................ 4-1 

4.1 Overview .....................................................................................................................4-1 
4.1.1 Disclaimer ................................................................................................................. 4-1 
4.1.2 Superelevation Overview ......................................................................................... 4-1 
4.1.3 Shape Design Files .................................................................................................... 4-2 

4.2 Shoulder Shapes - Are They Needed? ...........................................................................4-3 

4.3 How to Shape ..............................................................................................................4-3 

4.4 Components of the Shape ............................................................................................4-4 

4.5 Shape Cluster Parameters ............................................................................................4-5 

4.6 Dependent and Independent Shapes ............................................................................4-6 

4.7 Transitional or Non-Transitional Shapes .......................................................................4-8 

4.8 Superelevation Shape Manager Tools ...........................................................................4-9 

4.9 Automated Superelevation ........................................................................................ 4-10 
4.9.1 Computation Process ............................................................................................. 4-11 
4.9.2 File Menu ............................................................................................................... 4-12 
4.9.3 Populating the Automated Superelevation Dialog ................................................ 4-15 
4.9.4 Autoshape Input File Format ................................................................................. 4-23 
4.9.5 Autoshaping and Shifts .......................................................................................... 4-26 

4.10 Design Exceptions ...................................................................................................... 4-27 

4.11 Processing the Autoshape Input File ........................................................................... 4-29 

4.12 Shape Maker ............................................................................................................. 4-30 
Creating the Shape ................................................................................................. 4-36 

4.13 Shape Analyst ............................................................................................................ 4-38 

4.14 Shape Profiler ............................................................................................................ 4-42 

4.15 Shape Editor .............................................................................................................. 4-47 

4.16 Shape Selector ........................................................................................................... 4-48 

4.17 Shape Properties ....................................................................................................... 4-49 

4.18 Shape to DTM Surface ................................................................................................ 4-51 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
 Page iii 
 

4.19 Working Alignment Definition: Shapes ....................................................................... 4-53 

4.20 Pavement Shapes and Intersection Areas ................................................................... 4-54 

Exercise 4 .............................................................................................................................. 4-55 
Optional Exercise: Jameson Road Shapes .............................................................. 4-56 

5 Proposed Cross Sections .............................................................................................. 5-1 

5.1 Overview .....................................................................................................................5-1 
Corridor Modeling with Roadway Designer ............................................................. 5-1 

Cross Section Criteria Files ....................................................................................... 5-1 

5.2 Criteria Files ................................................................................................................5-1 

5.3 Requirements for Processing Proposed Cross Sections ..................................................5-2 

5.4 Pavement Shapes ........................................................................................................5-3 

5.5 Plan View Graphics ......................................................................................................5-3 

5.6 Variables .....................................................................................................................5-4 

5.7 Inclusion Sequence ......................................................................................................5-4 

5.8 Left Side/Right Side Processing ....................................................................................5-5 

5.9 ODOT Standard Criteria Library ....................................................................................5-6 

5.10 Criteria Processing Example .........................................................................................5-7 
5.10.1 XS DGN File ............................................................................................................... 5-9 
5.10.2 Pattern ................................................................................................................... 5-10 
5.10.3 Existing Ground ...................................................................................................... 5-12 
5.10.4 Shapes .................................................................................................................... 5-13 
5.10.5 Shape Clusters ........................................................................................................ 5-14 

Shape Clusters ........................................................................................................ 5-15 

Side Slope Condition .............................................................................................. 5-16 

Criteria Files ........................................................................................................... 5-19 

5.10.6 Define DGN Variables ............................................................................................. 5-22 
5.10.7 Define Variables ..................................................................................................... 5-24 

Criteria Documentation ......................................................................................... 5-26 

5.10.8 Plot Parameters...................................................................................................... 5-27 
Cross Section Lines ................................................................................................. 5-27 

Text......................................................................................................................... 5-28 

Plot ......................................................................................................................... 5-28 

5.10.9 Drainage ................................................................................................................. 5-30 
5.10.10 Processing the Criteria Run .................................................................................... 5-31 

5.11 Updating the Working Alignment Definition ............................................................... 5-34 

EXERCISE 5A - Criteria Processing using Shapes ....................................................................... 5-35 

5.12 Shapeless Criteria Processing ..................................................................................... 5-37 
5.12.1 5.11.1 What Is Needed To Process Shapeless Criteria? ......................................... 5-37 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page iv  
 

5.12.2 Processing A Shapeless Criteria Run ...................................................................... 5-37 

Exercise 5B – Shapeless Criteria Processing ............................................................................. 5-39 

5.13 Processing Multiple Shape Clusters ............................................................................ 5-40 

6 Cross Section Labeling .................................................................................................. 6-1 

6.1 Overview .....................................................................................................................6-1 

6.2 The Cross Section Labeler Dialog ..................................................................................6-3 
6.2.1 Text Options ............................................................................................................. 6-3 

Computed Inserts or User Inserts ............................................................................ 6-4 

6.2.2 Parameters Options ................................................................................................. 6-6 
6.2.3 Shape Options .......................................................................................................... 6-7 
6.2.4 Leader Options ......................................................................................................... 6-8 
6.2.5 Rotation Options ...................................................................................................... 6-9 
6.2.6 Styles Options ........................................................................................................ 6-10 
6.2.7 Pull-Down Menu Options ....................................................................................... 6-13 

Style File Options ................................................................................................... 6-13 

Options ................................................................................................................... 6-14 

7 Earthwork Quantities ................................................................................................... 7-1 

7.1 Overview .....................................................................................................................7-1 

7.2 Creating an Earthworks Run .........................................................................................7-2 

7.3 Configuring the Earthwork Dialog Box ..........................................................................7-4 
7.3.1 XS DGN File ............................................................................................................... 7-5 
7.3.2 Soil Types ................................................................................................................. 7-6 
7.3.3 Earthwork Shapes .................................................................................................. 7-10 
7.3.4 Output Format ....................................................................................................... 7-11 
7.3.5 Add/Subtract Volume ............................................................................................ 7-13 
7.3.6 Centroid Adjustment .............................................................................................. 7-14 
7.3.7 Skip Areas ............................................................................................................... 7-15 
7.3.8 Ignore Areas ........................................................................................................... 7-16 
7.3.9 Sheet Quantity ....................................................................................................... 7-17 

Including Common Excavation (Cut) End Areas in the Earthwork ASCII File ......... 7-18 

Including Fill End Areas in the Earthwork ASCII File............................................... 7-19 

Including Common Excavation (Cut) Volumes in the Earthwork ASCII File ........... 7-20 

Including Fill Volumes in the Earthwork ASCII File ................................................. 7-21 

Sheet Quantity File Format .................................................................................... 7-22 

7.4 Processing an Earthworks Run .................................................................................... 7-23 
7.4.1 Diagnosing Problems.............................................................................................. 7-24 

Exercise 7 .............................................................................................................................. 7-25 

7.5 Undercut ................................................................................................................... 7-26 
7.5.1 Undercut Quantities ............................................................................................... 7-29 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
 Page v 
 

Including the Undercut in the Sheet Quantities .................................................... 7-31 

Column 1 ................................................................................................................ 7-31 

Column 3 ................................................................................................................ 7-32 

Column 2 and Column 4 ......................................................................................... 7-32 

7.6 Special Benching ........................................................................................................ 7-33 
7.6.1 Functional Classes .................................................................................................. 7-33 
7.6.2 Excavation Limits .................................................................................................... 7-34 
7.6.3 Configuring an Earthworks Run for Special Benching ............................................ 7-35 

Soil Types ............................................................................................................... 7-35 

Earthwork Shapes .................................................................................................. 7-36 

Output Format ....................................................................................................... 7-37 

Including the Special Benching in the Sheet Quantities ........................................ 7-39 

Column 1 ................................................................................................................ 7-39 

Column 3 ................................................................................................................ 7-40 

Column 2 and Column 4 ......................................................................................... 7-40 

7.7 Concrete Removal ..................................................................................................... 7-41 
7.7.1 Soil Types ............................................................................................................... 7-41 
7.7.2 Defining the Asphalt Pavement Soil Type .............................................................. 7-42 
7.7.3 Defining the Concrete Removal Soil Type .............................................................. 7-43 
7.7.4 Defining the Excavation Limits ............................................................................... 7-44 
7.7.5 Processing Notes .................................................................................................... 7-45 
7.7.6 Earthwork Log File: Grand Summary Totals ........................................................... 7-48 
7.7.7 Including the Concrete Removal in the Sheet Quantities ...................................... 7-49 

Column 1 ................................................................................................................ 7-49 

Column 2 ................................................................................................................ 7-50 

Column 3 ................................................................................................................ 7-51 

Column 4 ................................................................................................................ 7-52 

8 Seeding Quantities ....................................................................................................... 8-1 

8.1 Overview .....................................................................................................................8-1 

8.2 Generating Seeding Quantities .....................................................................................8-1 

8.3 Adding Seeding Quantities to the Cross Section Sheets .................................................8-8 
8.3.1 Manually Placing Seeding Quantities on Cross Section Sheets ............................... 8-8 

Exercise 8 .............................................................................................................................. 8-10 

9 Limits of Construction .................................................................................................. 9-1 

9.1 Overview .....................................................................................................................9-1 

9.2 GEOPAK Limits of Construction ....................................................................................9-2 

9.3 The Profile Grade Report .............................................................................................9-5 
9.3.1 Criteria “Key Point” Text .......................................................................................... 9-5 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page vi  
 

9.3.2 Processing the Profile Grade Report ........................................................................ 9-6 

9.4 Exercise 9 .................................................................................................................. 9-12 

10 Cross Section Sheets ....................................................................................... 10-1 

10.1 Overview ................................................................................................................... 10-1 

10.2 ODOT_XSBoundary.mvba .......................................................................................... 10-2 

10.3 ODOT_CombineQuantities.exe ................................................................................... 10-4 

10.4 ODOT_XSQuantities.mvba ......................................................................................... 10-5 

Exercise 10A – Cross Section Boundaries ................................................................................ 10-8 

10.5 Cross Section Sheet Design Files ................................................................................. 10-9 

10.6 Processing Cross Section Sheets ............................................................................... 10-10 
10.6.1 Preparing the XS Cell File for Processing .............................................................. 10-10 
10.6.2 Cross Section Sheets ............................................................................................ 10-10 
10.6.3 File Menu ............................................................................................................. 10-11 
10.6.4 XS DGN File ........................................................................................................... 10-13 
10.6.5 Sheet DGN File ..................................................................................................... 10-15 
10.6.6 Sheet Dimensions / Cell ....................................................................................... 10-17 
10.6.7 XS Search Criteria ................................................................................................. 10-18 
10.6.8 Sheet Stack Orientation ....................................................................................... 10-19 
10.6.9 Sheet Stack Columns ............................................................................................ 10-20 
10.6.10 Margins and Spacing ............................................................................................ 10-21 
10.6.11 Station Labels ....................................................................................................... 10-22 
10.6.12 Offset Labels......................................................................................................... 10-23 
10.6.13 Elevation Labels ................................................................................................... 10-24 
10.6.14 Earthwork Quantity Labels ................................................................................... 10-25 
10.6.15 Sheet Labels ......................................................................................................... 10-28 
10.6.16 Digital InterPlot .................................................................................................... 10-29 
10.6.17 Layout Sheets ....................................................................................................... 10-30 
10.6.18 Post Processing Considerations ........................................................................... 10-31 

XS Ground Lines ................................................................................................... 10-31 

Offset Labels......................................................................................................... 10-31 

Match Lines and Cross Sections ........................................................................... 10-32 

Reference Levels .................................................................................................. 10-33 

10.7 Preparing XS Sheet Files for Electronic Submission .................................................... 10-34 

Exercise 10B ........................................................................................................................ 10-35 
 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
Chapter 1 – Getting Started Page 1-1 
 

1 Getting Started 

1.1 Course Outline/Prerequisites 

This class in intended for ODOT personnel involved in the production of roadway construction plans.  It 
is recommended that students have knowledge of the following: 
 

 Familiarity with ODOT design policies, procedures and CADD Standards 

 A working knowledge of Windows 7 

 A working knowledge of MicroStation V8i SELECTseries 1 

 Completion of GEOPAK Road 1 
 
This class is a continuation of the ODOT GEOPAK Road 1 training class. During this class, we will develop 
the existing and proposed cross sections for State Route 185. 
 

Day 1 CPD Credit* 

01 Getting Started 1.0 hours 

02 Exiting Ground Cross Sections 2.0 hours 

03 Underground Utilities 2.0 hours 

04 Superelevation 3.0 hours 

Day 2 CPD Credit* 

05 Proposed Cross Sections 8.0 hours 

Day 3 CPD Credit* 

06 Cross Section Labeling 1.0 hours 

07 Earthwork Quantities 3.0 hours 

08 Seeding Quantities 1.0 hours 

09 Limits of Construction 1.0 hours 

10 Cross Section Sheets 2.0 hours 

 
* Please note that final determination on what qualifies for CPD credit ultimately lies between the 
license holder and the State Board for Professional Engineers and Surveyors. 
 

 

Start Time: 7:30 AM 
End Time: 3:30 PM 

 

Web Browsing: Please limit web browsing to 
break times and lunch. 

 

Breaks: 15 Minutes per half day 

 

Email: Please limit email usage to break times 
and lunch. 

 
Lunch: 45 Minutes 

 

Cell Phones: Please set cell phones to vibrate 
and take calls only at break times and lunch. 
Please refrain from texting during the class 
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1.2 GEOPAK Support 

The Office of CADD and Mapping Services has been designated to provide GEOPAK Support and training 
for ODOT personnel.  The Office is also responsible for establishing, maintaining and distributing all 
ODOT CADD Standards. 
 
The Office of CADD and Mapping Services maintains a MicroStation/GEOPAK support website on the 
ODOT website: 
 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/default.aspx 
 
This training guide is available on-line in Abode Acrobat format at the following URL: 
 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/GPKManual.aspx 
 
The Design Resource Reference Center is a centralized reference center to help locate online or printed 
material.  Additionally, several mailing lists are available to keep you informed about updates to ODOT 
standards.  A CADD Standards mailing list is also available. Visit the Design Resource Reference Center at 
the following URL: 
 

http://www.dot.state.oh.us/drrc/Pages/default.aspx 
 
The Bentley community offers another great way to get support with MicroStation and GEOPAK 
problems. For more information, see the following URL: 
 

http://communities.bentley.com/ 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/default.aspx
http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/GPKManual.aspx
http://www.dot.state.oh.us/drrc/Pages/default.aspx
http://communities.bentley.com/
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1.3 ODOT CADD Standards for MicroStation and GEOPAK 

ODOT CADD Standards for MicroStation and GEOPAK are maintained and distributed by the Office of 
CADD and Mapping Services. The ODOT CADD Engineering Standards manual for MicroStation and 
GEOPAK is available in Adobe Acrobat format at the following URL: 
 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/CADDManual.aspx 
 
Each ODOT District, and Central Office, maintains a copy of the ODOT CADD standards on a network 
drive, usually the “i” drive, in the “ODOTstd” subdirectory. 

1.3.1 Standard Directory Structure 

The ODOT CADD Engineering Standards Manual, Section 301, defines the standard project directory 
structure to be used on all ODOT projects. This training class will use the directory structure for a Minor 
project. See the ODOT CADD Engineering Standards Manual for more information on directory 
structures. 
 
A Visual Basic program is available to assist the project manager with the task of setting up the standard 
project directory structure. ODOT personnel can access the program from the following directory: 
 

i:\ODOTstd\V8istd\vba\ODOT_Directory.exe 
 
The application can also be accessed by selecting ODOT > File Management > New Project Directory 
from the MicroStation pull-down menu. 

 
Documentation for the program is available on the ODOT CADD Support website. 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/CADDManual.aspx
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1.3.2 Standard MicroStation Design File Names 

The ODOT CADD Engineering Standards Manual, Section 303, defines the standard MicroStation DGN 
file names to be used on all ODOT projects. See the ODOT CADD Engineering Standards Manual for more 
information. 
 
A program is available to assist the project manager with the task of creating design files following the 
standard naming convention and the standard directory structure. The application can be accessed by 
selecting ODOT > File Management > New Design File from the MicroStation pull-down menu. 
 
When the application is opened, the dialog shown below is opened. 

 
Note: This application has been rewritten for MicroStation V8i as a MicroStation Visual Basic 
Application. As such, the application runs directly in MicroStation V8i. Previous versions of the 
application were written as a stand-alone Visual Basic 6 executable and required the user to close 
MicroStation in order for the application to create new the new design files. This version no longer 
requires the user to close MicroStation, although GEOPAK will be deactivated. 
 
Documentation for the program is available on the ODOT CADD Support website, or by selecting the 
Help icon located at the upper right of the dialog. 
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1.4 Provided Data 

This course is a continuation of the ODOT GEOPAK Road 1 course. We will use the horizontal and vertical 
alignments developed for State Route 185 in the previous class to generate existing ground cross 
sections, calculate superelevation, generate proposed cross sections, calculate the earthwork and 
seeding quantities, and generate final cross section sheets. 
 
For this training class, you have been provided the following files: 
 

File Name Description 

job185.gpk GEOPAK Coordinate Geometry Database containing the survey data and the 
horizontal and vertical alignments for the project from the GEOPAK Road 1 course. 

12345exgr.tin Digital Terrain Model representing the existing ground. 

12345BE001.dgn 2D MicroStation design file containing the ground survey data. 

12345BF001.dgn 2D MicroStation design file containing the graphics for the S.R. 185 existing and 
proposed profile. 

12345BP001.dgn 2D MicroStation design file containing the graphics for the proposed roadway. 

12345BU001.dgn 2D MicroStation design file containing the graphics for the existing underground 
utilities. 

 
The GEOPAK Coordinate Geometry Database, job185.gpk, contains the following COGO elements: 
 

Chain Name Description 

CLXS185 Approximate centerline of existing S.R 185. 

CLPS185 Centerline for the proposed relocation of S.R. 185. 

CLXJAME Approximate centerline for Jameson Road. 

CLPJAME Centerline for the proposed relocation of Jameson Road. 

 

Profile Name Description 

XS185P The existing ground profile along the proposed centerline of S.R. 185. 

PS185P The proposed vertical alignment for the S.R. 185 relocation. 

XJAMEP The existing ground profile along the proposed centerline of Jameson Road. 

PJAMEP The proposed vertical alignment for Jameson Road. 
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Exercise 1 

In this exercise, we’ll create the Directory structure to house the training files, download the files from 
the ODOT website, and create a new GEOPAK Project for the class. 

1. Create the Project Directories 

Create the following subdirectory for Darke County to house the project files: 
 

c:\GPKclass\DAR\ 
 
Create the project folders in the c:\GPKclass\DAR\ directory using the PID number 12345. 
 
Use the ODOT Standard Directory application, ODOT_Directory.exe, to create the project folders. Use 
the Create Minor Project Directory Structure option as shown below. 
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2. Download the Training files 

Download the Road 2 project files from the ODOT website: 
 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/GPKManual.aspx 
 
Unzip the project files to the c:\GPKclass\DAR\12345\ directory. Be sure to toggle on the Use Folder 
Names option. 
 
After unzipping the files, list the sub-directory where the files are located in the table below: 

 

File Name Sub-Directory 

job185.gpk  

12345exgr.tin  

12345BE001.dgn  

12345BF001.dgn  

12345BP001.dgn  

12345BU001  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/GPKManual.aspx
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3. Create a GEOPAK Project 

Open the proposed basemap dgn file for the project 12345BP001.dgn. Use the GEOPAK Project 
Manager to create a GEOPAK “Project” named 12345 and a new “User” using your name. 
 
Refer to the ODOT GEOPAK Road 1 Training Guide for details on creating a GEOPAK Project. 
 

What should you name the GEOPAK Project Manager file (.prj)? 
 

Which sub-directory should be used to create the project .prj file? 
 

Which sub-directory should you assign as the Working Directory? 
 
Create a Working Alignment Definition for S.R. 185 and for Jameson Road using the information below: 
 

Working Alignment Name SR185 JAMESON 

Plan View 
   Design File 
   Chain 

 
12345BP001.dgn 
CLPS185 

 
12345BP001.dgn 
CLPJAME 

Plan View: Pattern 
    

Select the By Design File 
option. Set the Placement 
parameter to the level 
GK_Patterns 

Select the By Design File 
option. Set the Placement 
parameter to the level 
GK_Patterns 

Profile View 
  Design File 
  Existing Profile 
  Proposed Profile 

 
12345BF001.dgn 
XS185P 
PS185P 

 
12345BF001.dgn 
XJAMEP 
PJAMEP 

Profile Location Use the “Identify Cell” option 
to set the parameters (open 
the file 12345BF001.dgn to 
identify the profile cell) 

Use the “Identify Cell” option 
to set the parameters (open 
the file 12345BF001.dgn to 
identify the profile cell) 

Cross Section View 
   Existing Ground 

Select the By Design File 
option. Set the Placement 
parameter to the level 
XS_X_Ground_Line 

Select the By Design File 
option. Set the Placement 
parameter to the level 
XS_X_Ground_Line 

DTM 
  Existing Ground TIN 

 
12345exgr.tin 

 
12345exgr.tin 

 
 
Set the working alignment definition for SR185 as the active working alignment. The training class will 
focus on S.R. 185. 
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2 Existing Ground Cross Sections 

2.1 Overview 

Existing ground cross sections can be extracted from a GEOPAK DTM at user defined intervals along a 
specified COGO chain. 
 
The location(s) where the cross section(s) will be extracted is defined by establishing Pattern Lines at 
the desired interval and width for the cross section(s). 
 
The lines can be drawn manually using MicroStation commands or by use of the GEOPAK Draw Pattern 
Lines dialog box. 
 
An example of Pattern Lines drawn at 25’ intervals along the Jameson Road is shown below. 

 
The Pattern Lines are used to intersect the TIN file to read the elevation and offset at every place the 
pattern line crosses a triangle edge. The elevation and offset is used to compute the existing ground 
cross section at each pattern line location. The cross sections are drawn in the MicroStation design file 
specified by the user. 
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2.2 Pattern Lines 

Pattern Lines are used to designate the location(s) where the existing ground cross section(s) are to be 
extracted from the TIN file. GEOPAK provides two methods to define these Pattern Line location(s): 
 

 Pattern by DGN 

 Pattern by Station 
 
Each option is summarized below: 
 

Pattern by DGN 
When using this method, MicroStation line elements are drawn into a 2D plan-view design file, 
one for each desired cross section. The Pattern Lines are typically placed perpendicular to the 
selected chain at even stations or placed individually at user specified locations. Pattern lines 
can also be placed at a user defined skew angle from the selected chain. The Pattern Line 
elements must intersect the centerline chain in order for the software to draw a cross section. 
 
The Pattern by DGN option is advantageous since it provides the user with the option to extract 
cross sections at odd station locations simply by drawing a pattern line at the desired location. 
Additionally, cross sections can be omitted at specific stations, such as a bridge location, by 
simply deleting the pattern line(s) placed by GEOPAK. 
 
Pattern by Station 
When using this method, cross sections are generated at a specified interval along a selected 
COGO chain. All cross sections are generated perpendicular to the centerline chain. No graphics 
are drawn in the design file to represent the pattern line locations. 
 
The Pattern by Station option is useful in cases where there is no need for skewed cross sections 
of for sections at odd station locations. 

 
Typically, ODOT personnel will use the Pattern by DGN option. 
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2.2.1 Pattern Line Design File 

According to ODOT CADD Standards, Pattern Lines are drawn in a separate design file containing only 
the Pattern Lines. See the ODOT CADD Engineering Standards Manual for information on standard 
design file names. Use the ODOT application ODOT_Files.mvba to create design files using file names 
according to ODOT Standards. 
 
The ODOT_Files application can be accessed by selecting ODOT > File Management > New Design File 
from the MicroStation pull-down menu. 
 
Select the option to create the pattern line design file as shown below. 

 
There is no need to create a separate design file for the Pattern Lines on projects where you will extract 
cross sections for multiple alignments. Patterns lines for each alignment of your project can be drawn in 
the same design file as long as each set of pattern lines for a specific alignment is drawn with unique 
symbology. 
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2.2.2 Draw Patterns Dialog Box 

To generate the Pattern Lines, select Draw Pattern from the GEOPAK Project Manager. 

 
The Select Run dialog, show below, is opened. 

 
By default, a run named Untitled is always created. To create a new run, select Run > New... from the 
Select Run dialog box to access the New Run Name dialog box shown below. 
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Key-in the Run Name and Description for the new run. Select OK to create the new run. The new run 
name will appear in the Select Run dialog box. 
 
Select the new run from the list box and then pick OK. The GEOPAK Draw Pattern Lines dialog box shown 
below is opened. 

 
The following dialog items are filled in with the values specified for the currently selected Working 
Alignment Definition: 
 

Job 
Specify the Job number of the COGO data base containing the chain that will be used to draw 
the pattern lines. 
 
Chain 
Specify the COGO chain that will be used to draw the pattern lines. The Chain name can be 
manually entered or identified by the Select button. 

 
The remaining dialog items are described on the following pages. 
 
 Profile 

Specify the name of the Profile to be used when pattern lines are placed using the Control 
Points-Vertical option described on the following page. The Profile name can be manually 
entered or identified by the Select button. 
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 Left Offset(+), Right Offset(+) 
These options are used to assign the distance, in Master Units, that the pattern lines will extend 
to the left and right of the specified Chain. The distance is always specified as a positive value. 
 
Beginning Station 
Enter the Beginning Station along the specified COGO Chain to start the pattern lines. The 
Beginning Station can be entered manually or identified graphically by using the Begin Station 
button to the right of the key-in field. 
 
Ending Station 
Enter the Ending Station along the specified COGO Chain to start the pattern lines. The Ending 
Station can be entered manually or identified graphically by using the End Station button to the 
right of the key-in field. 
 
The option button, shown below, allows the user to specify whether pattern lines will be drawn 
along the chain at a user specified increment, at a single station, or at Horizontal, Vertical, or 
Superelevation key-point locations. These options are described below. 

 
Increment 
The Increment option will draw the first pattern line at the Beginning Station and all 
subsequent pattern lines at the user specified interval. For example, given a beginning 
station of 35+90.72 and a distance of 50, the first pattern line is drawn at station 
35+90.72, the second at 36+40.72, the third at 36+90.72, etc... 
 
Even 
The Even option will draw all pattern lines at a station divisible by the value keyed in for 
the distance. For example, given a beginning station of 35+90.72 and a distance of 50, 
the first pattern line will be drawn at station 35+90.72, the second at 36+00, the third at 
station 36+50, etc... 
 
Once 
Pattern lines can be placed at a single user specified station by using the Once option. 
When the Once option is selected, the Ending Station information is grayed and not 
available for user input. Also the distance key-in field is unavailable. The Beginning 
Station information is used to identify the station and offsets for the pattern line to be 
drawn. 
 
Control Points- Horizontal 
Pattern lines will be placed at the key points along the specified COGO Chain (PC, PT, SC, 
ST, etc.). 
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Control Points- Vertical 
Pattern lines will be drawn at the beginning (VPC) and ending (VPT) station for each 
vertical curve in the specified COGO Profile. In addition, pattern lines are drawn at the 
high point or low point for each vertical curve. 

 
Superelevation Transitions 
The current design file and any attached reference files are scanned for superelevation 
shapes created with the specified Chain. A pattern line is drawn at the beginning and 
ending of each superelevation shape. See Chapter 4, Superelevation, for more 
information on superelevation shapes. 

 
Skew 
Pattern lines can be drawn at a Skew angle relative to the standard pattern line (perpendicular 
to the baseline) as shown in the example below. Toggle on the Skew option and key in the 
desired angle as show below. A positive Skew angle rotates the pattern line clockwise. A 
negative Skew angle rotates the pattern line counter-clockwise. 

 
Level Symbology 
The Level, Style, Color, and Weight for the pattern lines can be set by double-clicking the 
symbology display as shown below. 
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Each COGO chain for which you wish to extract cross sections will have its own set of Pattern 
Lines and each set of Pattern Lines must have unique symbology. The levels in the table below 
have been established for GEOPAK Pattern Lines. 

 

Level Name ByLevel Color ByLevel Style ByLevel Weight 

GK_Patterns 0 0 0 

GK_Patterns2 1 0 0 

GK_Patterns3 2 0 0 

GK_Patterns4 3 0 0 

GK_Patterns5 4 0 0 

 
If you opt to place the Pattern Lines for multiple alignments on the same level, be sure to 
change the color of the pattern lines to make them unique for each COGO Chain. 

 
Draw Pattern Lines 
Select the Draw Pattern Lines button to initiate placement of the Pattern lines. GEOPAK Pattern 
Lines are drawn into the current MicroStation design file using the settings of the GEOPAK Draw 
Pattern Lines dialog. 
 
An example of the pattern lines drawn at even 25' increments for Jameson Road, from station 
9+50 to Station 16+00, is shown below. 
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2.2.3 Pattern Lines in Intersection Areas 

Cross sections and quantities within the limits of an intersection can be handled in a variety of ways. 
One option is to delete the pattern lines within the limits of the intersection and add pattern lines at the 
radius returns as shown in the example below. 

 
The Once option can be used to draw individual pattern lines at the desired locations. Earthwork 
quantities within the limits of the intersection will need to be computed manually and added into the 
cross section quantities. 
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2.3 Working Alignment Definition: Pattern 

From the Road Project dialog, select Define to access the Working Alignment Definition dialog shown 
below. When the Pattern option is selected, the dialog changes dynamically as shown below. 

 
Two options are available to designate which pattern line method is used for the alignment: By Design 
File, or By Station. 

2.3.1 By Station 

When By Station is selected, the dialog dynamically changes as shown below. 

 
When using this method, cross sections will be generated at the specified interval along the centerline 
COGO chain. All cross sections are generated perpendicular to the centerline chain. No graphics are 
drawn in the design file to represent the pattern line locations. Use this option when you do not need 
any kinked or skewed cross sections, or cross sections at odd stations. 
 
The options are detailed on the following page. 
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Horizontal Scale 
Key-in the value for the Horizontal Scale for the cross sections. This should normally be 1 for 
ODOT projects. 
 
Vertical Scale 
Key-in the value for the Vertical Scale for the cross sections. This should normally be 1 for ODOT 
projects. 
 
Begin Station 
Key-in the Beginning Station for the cross sections. 
 
End Station: 
Key-in the Ending Station for the cross sections. 
 
Increment 
The Increment option will draw the first pattern line at the Beginning Station and all 
subsequent pattern lines at the user specified interval. For example, given a beginning station of 
35+90.72 and a distance of 50, the first pattern line is drawn at station 35+90.72, the second at 
36+40.72, the third at 36+90.72, etc... 
 
Even 
The Even option will draw all pattern lines at a station divisible by the value keyed in for the 
distance. For example, given a beginning station of 35+90.72 and a distance of 50, the first 
pattern line will be drawn at station 35+90.72, the second at 36+00, the third at station 36+50, 
etc... 
 
Left Offset 
This option is used to assign the distance, in Master Units, that the pattern lines will extend to 
the left of the specified Chain. 
 
Right Offset 
This option is used to assign the distance, in Master Units, that the pattern lines will extend to 
the right of the specified Chain 
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2.3.2 By Design File 

When By Design File is selected, the dialog dynamically changes as shown below 

 
The By Design File option is used to define the symbology settings for Pattern Lines that have been 
previously drawn in a MicroStation Design File. The following options are available: 
 

Horizontal Scale 
Key-in the value for the Horizontal Scale for the cross sections. This should normally be 1 for 
ODOT projects. 
 
Vertical Scale 
Key-in the value for the Vertical Scale for the cross sections. This should normally be 1 for ODOT 
projects. 
 
Design File: 
Key-in the name of the design file where the pattern lines have been drawn. The File button can 
be used to select the name of the design file. 
 
Match 
The Match button can be used to graphically pick the pattern line elements from the design file 
to set the correct symbology (LV Names, LV Numbers, Colors, Styles, Weights, Types) in the 
Working Alignment Definition dialog box. Toggle on the symbology items that you wish to 
match, select the Match button, and select one of the pattern lines. The values are read from 
the pattern line element into the Working Alignment Definition dialog box as shown in the 
example above. 
 
Display 
Select the Display button to highlight MicroStation elements matching the currently defined 
symbology. 
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Reset 
Select the Reset button to clear the values specified for the symbology items (LV Names, LV 
Numbers, Colors, Styles, Weights, Types). 
 
Placement 
Double click the symbology display to access the GEOPAK Set Feature dialog shown below. Use 
this dialog to set the symbology for the placement of the pattern lines. 

 
Note: Each set of pattern lines for each alignment in your project must have unique symbology. 
ODOT Standards include multiple levels for the placement of pattern lines. If there are not 
enough levels available, pattern lines for multiple alignments can be placed on the same level by 
setting the Color, Style, and Weight uniquely for each set of pattern lines. 
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2.4 Extracting Existing Ground Cross Sections 

2.4.1 Cross Section Design Files 

When existing ground cross sections are generated by GEOPAK, the cross sections are drawn in the 
active MicroStation design file. The cross sections should always be drawn in their own design file. The 
ODOT_File.mvba application can be used to easily create a cross section design file using ODOT standard 
design file names. See the ODOT CADD Engineering Standards Manual for information on standard 
design file names. 
 
The ODOT_Files application can be accessed by selecting ODOT > File Management > New Design File 
from the MicroStation pull-down menu. 
 
Select the option to create the cross section design file as shown below. 

 
ODOT does not recommend placing the cross sections for multiple alignments in the same design file. 
Create a separate design files for each set of cross sections.  
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2.4.2 The Draw Cross Sections Dialog Box 

From the Road Project dialog box, select Existing Ground Cross Sections to create a new existing ground 
cross section run, or to access a previously created run. 

 
The Select Run dialog box, shown below, is opened. 

 
By default, a run named Untitled is always created. To create new run, select Run > New... from the 
Select Run dialog box to access the New Run Name dialog box shown below: 
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Key-in the Run Name and Description for the new run. Select OK to create the new run. 
 
Select the new run from the list box and then pick OK. The Draw Cross Sections dialog box shown below 
is opened. 

 
The dialog consists of a menu bar with three listings: 
 

File 
Standard file utilities to load, or save settings, plus a dialog exit option. 
 
Edit 
Options to save settings, clear lists, etc. 
 
Update Options 
User-defined options on how the software handles the redrawing of cross sections. The options 
supported on the Update menu are shown in the exploded view below. 
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The options are toggled off / on by clicking on the option. The check to the left of the option 
indicates the option is active. Only one option may be active at any given time. The options are 
detailed below. 
 
Delete Existing Elements and Redraw 
When this option is activated, any existing ground lines previously drawn with this tool are 
deleted and new ground lines are drawn. 
 
Delete Non-modified Elements and Redraw 
When this option is activated, only existing ground lines previously drawn with this tool that 
have not been modified are deleted and new ground lines are drawn. Ground lines previously 
drawn with this tool which have been modified are left intact. 
 
Draw on Top of Existing 
When this option is activated, any previously drawn ground lines are ignored and a new set is 
drawn, resulting in two sets of ground lines. 
 
Query 
When activated, the user is prompted each time the Draw button is pressed, as shown below. 
 
The user must select one of the three options and press the Apply button to commence 
processing. Pressing the Cancel button closes the dialog with no subsequent processing. Note: 
the user is prompted only if the design file contains a set of cross sections for the selected chain. 

 
Information stored with the Working Alignment Definition is shared with the Draw Cross Sections dialog 
box. The following information is taken from the active Working Alignment Definition: 
 

Job Number 
The GEOPAK COGO data base job number. 
  
Chain 
The name of the COGO Chain along which to extract cross sections. 
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Two tabs on the dialog support the input data required to draw cross sections: 
 

XS Cells 
Information on this tab is used to define the location, scale, and spacing of the cross sections. 
 
Surfaces 
This tab is used to define the surfaces used for drawing cross sections. Multiple surfaces may be 
drawn in a single processing. 

 
The settings for each tab are detailed on the following pages. 

The XS Cells Tab 

When the XS Cells tab is pressed, the dialog dynamically changes as shown below. 

 
Three options are available to define the cross section Pattern Line locations, as detailed below: 
 

Pattern By Station 
Use this option when no pattern lines have been drawn in the DGN file.  
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Pattern By DGN File 
Use this option when pattern lines have been drawn in the DGN file to represent the locations 
where the cross sections will be extracted. 

 
The Pattern Line information is read from the current Working Alignment Definition. If the 
Pattern Line information has not been defined in the Working Alignment, the Match button can 
be used to set the Pattern Line symbology as previously detained in this manual. 
 
In Existing Only 
This option draws existing ground cross section lines only for cross section cells that have been 
previously drawn in the active design file. No other pattern requirements are needed. 

 
Scale 
These values are used to specify the Horizontal and Vertical scales at which cross sections are to be 
plotted. 

 
The ratio of the scales values is used to distort the vertical scale of the cross section relative to the 
horizontal scale value. The actual horizontal scale of the cross sections is unaffected.  
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Spacing 

 
Horizontal 
This option enables the user to define the horizontal distance from the left edge of one cross 
section cell to the left edge of the cross section cell in the adjoining column. Use of this feature 
will prevent cross section elements associated with one cross section cell from overlapping the 
cross section elements of cells in adjoining columns. 
 
Vertical 
This option enables the user to define the vertical distance separating GEOPAK cross section 
cells. Use of this feature will prevent cross section elements associated with one cross section 
cell from overlapping the cross section elements in the cell above or below it. 
 
Number of XS by Column 
Cross sections are placed in vertical columns. This field determines how many sections are 
placed in each column. 
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The Surfaces Tab 

When the Surfaces tab is pressed, the dialog dynamically changes as shown below. 

 
The Surfaces tab is used to select the GEOPAK TIN file to be used as the source data to extract the 
existing ground cross sections. Multiple surfaces from a variety of sources can be drawn in a single 
processing. 
 
Each surface to be drawn must be added to the list box. This is accomplished via the action/edit buttons 
on the right side of the dialog. Cross section lines or line strings are drawn for each surface listed. When 
the list box is populated, pressing the Draw button in the upper right corner initiates the processing. 
 
Edit Buttons 
 

Add 

 To add to the list box, simply select the source TIN File, and then populate the Display 
Settings, Filter Tolerances and Text Settings. Then press the Add button to the right.  
 
Modify 

 Modify a line by highlighting the desired line in the list box, make the desired changes in the 
fields directly below the list box, then press the Modify button.  
 
Delete 

 To delete a line from the list box, simply highlight the line to be deleted and press the 
Delete button. 

 
The lower half of the dialog box, encompassed in the Details group, is used to select each TIN File that 
will be used to extract the cross sections and to specify the symbology. Once these Details have been 
set, the Add button is used to add the information to the list box. Each item in the Details group is 
described on the following pages. 
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Tin File:  
This key-in field is used to specify the name of the TIN File that will be used to extract the existing 
ground cross sections. Alternately, users can press the Browse TIN File icon, located to the right of the 
key-in field, to open the Select TIN File. 
 
Method: 
Two methods are supported to control how the triangle model is read to generate the existing ground 
cross sections. 
 

Triangle method 
Given the intersection between a pattern line and a triangle side, all intersections between the 
pattern line and the triangle side will be included in the creation of the ground line. 
 
BreakLine method 
Given the intersection between a pattern line and a triangle side, if each vertex of the triangle 
lies on a break line the intersection of that triangle side will be ignored in the creation of the 
ground line. 

 
Type 
Cross section lines can be drawn as Lines or Line Strings. We recommend using the Line String option. 
 
Display Settings 
The Display Settings group box is used to specify the symbology for the cross section elements. 
 
Set the option to By Level Symbology, and then double click on the symbology graphic. This opens the 
GEOPAK Set Feature dialog, wherein the symbology can be specified. The existing ground cross sections 
should be plotted using following settings in accordance with the ODOT CADD Engineering Standards 
Manual. 
 

Level Name Color Weight Style 

XS_X_Ground Line 2 (ByLevel) 1 (ByLevel) 2 (ByLevel) 
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Set the option to By Feature to select an item from the Design and Computation Manager database 
representing the existing ground cross section symbology. Select the Browse button to access the dialog 
shown below. Select the X_EXGR feature as shown below. 

 
Once the feature has been selected, it is available in the Display Settings item as shown below. 

 
Text Settings  
When the Elevation toggle is activated, the elevation of the surface at the baseline location is placed on 
each cross section. The symbology for the text can be set by double clicking on the text graphic to open 
the GEOPAK Set Feature dialog. 
 
Filter Tolerances  
Both Horizontal and Variance filter tolerances are considered together for each pair of cross section 
segments. The middle point is deleted if both segment lengths are less than the Horizontal filter 
tolerance and the projected distance between the mid-point and the chord between the two end points 
is less than the Variance tolerance. 
 
Void  
If a cross section crosses a Void area in the triangle model, the Void Plot Parameters are used to define 
how the cross section lines are drawn across the void. Double clicking on the element opens the 
GEOPAK Set Feature dialog, wherein the desired parameters may be set. We recommend using the 
values shown below to define the Void symbology. 
 

Level Name Color Weight Style 

XS_X_Ground Line 0 1 (ByLevel) 2 (ByLevel) 
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Draw 

After you have completed the GEOPAK Ground Cross Sections dialog box, select the Draw button to 
initiate placing cross sections. The cross sections are placed in the currently active MicroStation design 
file. 

 
Toggle on the DP Origin option to specify the location where the first cross section will be placed in the 
design file.  
 
An example of a GEOPAK Ground Cross Section is shown below. 

 
GEOPAK places a control cell for each cross section as shown above. This cell is used by GEOPAK to 
associate the cross section with the correct chain and station on the chain. These cells should never be 
deleted.  
 
We refer to MicroStation levels by the level name. Each level still has an associated level number. By 
default, GEOPAK will place the cross section control cells on the level numbered 63. The level GK_Cells 
has been defined in the ODOT DGN Library as level number 63 to contain the cross section cells. If there 
is not a level numbered 63 in the design file or the DGN Library, GEOPAK will place the cross section cell 
on level named “default”. 
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2.5 Working Alignment Definition: Cross Section 

After extracting the existing ground cross sections, add the existing ground cross section information to 
the Working Alignment definition. 

 
The Cross Section View item is used to identify the XS DGN File containing the cross sections. The Chain, 
Begin Station and End Station are automatically read from the cross section cells in the selected design 
file. 
 
The Existing Ground item is used to designate the symbology of the elements that make up the existing 
ground in the Cross Section View design file. Use the Match button to read the symbology by selecting 
an element from the design file. 

 
The Placement option is used to set the default symbology for the existing ground cross sections. The 
values set here will be used in the Draw Cross Sections dialog box. 
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2.6 Cross Section Navigator 

The Cross Section Navigator tool is a quick and simple method of scanning through cross sections or 
locating specific sections. It also includes tools for drawing cross section lines and setting active angles. 
 
To access the cross section navigator, select Applications > GEOPAK Road > Cross Sections > Navigator, 
or select the icon from the Road Tools palette as shown below: 

 
The frame is resizable and dockable for ease of use. Within the title bar, the Chain name and the 
Horizontal and Vertical scale of the cross sections is displayed. 

 
Station Display 
The current station is displayed in a drop-down list as shown below. Note the station is display only and 
is not a user input field. To go to a specific station, simply select the station from the list. 

 
If cross sections based on multiple chains are drawn within the file, all chains are listed and the desired 
chain may be selected to access the cross sections. GEOPAK defaults to the first set drawn. 
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The Station Keyin option, selected by the icon at left, can be used to key in the station directly 
instead of using the scrolling menu above. 

 
Scrolling tools 
The scrolling buttons enable the user to quickly scan both forwards and backwards within the cross 
section range. The single arrows move forward (>) or backward (<) one section each time the button is 
pressed. The double arrows move to the first section (<<) or last section (>>). The reset navigator (center 
button on the dialog) returns the user to the first cross section; however, the entire section is placed on 
the screen. Therefore, the relative window is not maintained. 

 
Drawing tools 
Four tools are supported to assist the user in the placement of elements on cross sections. These include 
(from left to right): 

 
 DP Offset Elevation 

 DP Delta Distance Slope 

 XS Active Angle Tool 

 Draw XS Line 
 
The drawing tools are described on the following pages. 
 

DP Offset Elevation 
This dialog can be used to send a data point to MicroStation for an Elevation and Offset value 
keyed in by the user, or to get the station and offset from the cursor in the MicroStation design 
file. 

 
The example below illustrates placing a cell representing a drainage pipe at a user specified 
elevation and offset using the MicroStation Place Cell command with the Send Data Point 
function. 
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The Get Cursor XS Position button is used to report the elevation and offset of the cursor 
location within the MicroStation design file. Press the button, and then move the cursor on the 
cross section. The information is displayed in the Cursor Elevation and Offset fields. 

 
DP Delta Distance Slope 
In this dialog, the Horizontal Distance is specified in terms of master units. Supported options for 
Slope include Rise:run, run:rise, slope (%), and slope (unit/unit). After setting the dialog, select 
the MicroStation place line command and select the starting endpoint via a MicroStation data 
point. To generate the other endpoint of the line, press the DP button in the dialog below. 

 
XS Active Angle 
Several Types of Active Angles are supported within this dialog, including: Slope options for 
run:rise and rise:run, slope(%), slope (unit/unit) and Add 180. As each type is selected, the 
remaining dialog dynamically changes to reflect the current selection. After setting the dialog, 
press the Set AA button to set the Active Angle for use within the MicroStation command. 
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Draw XS Line 
This dialog automatically calls the MicroStation place line command, and then uses the 
information to place the line from the location specified by the user. The Delta Distance is 
defined in terms of master units, i.e., feet or meters, and is measured horizontally. Slope options 
include rise:run, run:rise, slope (%), and slope (unit/unit). Activating a toggle locks the current 
data. A deactivated toggle allows for dynamic placement. 

 
Profile Elevation 

Selecting the Profile Elevation icon will open the Profile Elevation dialog shown below. 
The Profile Elevation dialog will allow you to send a data point to any MicroStation 

command using the elevation from a profile selected from the COGO database, and the offset 
defined relative to an optionally selected COGO chain. The elevation is read from the profile at 
the location where the current cross section intersects the selected profile. 

 
Job Number 
Specify the Job Number of the COGO database containing the chain that was used to 
draw the pattern lines. The Job Number can be manually entered or specified with the 
Select button. 
 
Use Alt. Chain 
Specify the name of the COGO chain that will be used to define the offset from the 
center of the cross section when the DP Button is pressed. The chain name can be 
manually entered or specified with the Select button. If Use Alt. Chain is toggled off 
when the DP button is selected, an offset value of 0 is used for the location of the DP 
sent to the active MicroStation command. 
 
Profile Name 
Specify the name of the COGO profile that will be used to define the elevation of the 
data point that is sent to the active MicroStation command when the DP button is 
selected. The Profile Name can be typed in or specified with the Select button. 
 
Profile Offset 
This field is used to specify a vertical offset, from the selected Profile Name, for the data 
point sent to the active MicroStation command when the DP button is pressed. Positive 
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values result in offsets above the selected profile elevation. Negative values result in 
offsets below the selected profile elevation. 
 
DP Button 
Once the dialog is populated, pressing the DP button in the upper right corner of the 
dialog will send a data point to the currently active MicroStation command. 

 
Open View Control Dialog 

Selecting the Open View Control icon will open the XS View Control dialog shown below. 
This dialog will allow you to “sync” multiple MicroStation views when the cross section 

navigator scrolling tools are used. 

 
Note: Toggling on/off the individual views in the XS View Control dialog does not open the 
corresponding MicroStation view window. 
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Exercise 2 

In this exercise we will draw the pattern lines and extract the existing ground cross sections for State 
Route 185. 
 

 Use the ODOT_Files application to create a new design file to contain the pattern lines for S.R. 
185. Draw pattern lines for S.R. 185 at even 50' increments along the centerline alignment. Each 
pattern line should extend 100' to the left and right of the centerline chain. 

 
 Delete the pattern lines in the intersection of S.R. 185 and Jameson Road. 

 
 Add pattern lines on S.R. 185 at the radius returns in the intersection of S.R. 185 and Jameson 

Road. 
 

 Update the Working Alignment definition for SR185 to reflect the settings for the pattern lines. 
 

What is the name of the pattern line design file? 
 
Which directory is the pattern line design file stored in? 

 
 Use the ODOT_Files application to create a new design file for the S.R. 185 cross sections. 

Extract the existing ground cross sections for S.R. 185 in this file. 
 

What is the name of the cross section design file? 
 
Which directory is the cross section design file stored in? 

 
 Update the SR185 Working Alignment definition to include the information for the cross 

sections. 
 
 
Extra Credit 
 

 Draw pattern lines and extract cross sections for Jameson Road. Be sure to update the Working 
Alignment information for Jameson Road. 

 
Which design file should you use for the Jameson Road Pattern Lines? 

 
Which design file should you use for the Jameson Road cross sections? 
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3 Underground Utilities 

3.1 Overview 

Underground utilities, or other ancillary features such as right-of-way lines, can be drawn on cross 
sections and profiles by use of the Draw Ancillary Features tool. 
 
The underground utility location is represented on the cross sections or profile by placement of a cell or 
a symbol. Text labels can also be drawn with the cells or symbols. An example of a sanitary line plotted 
on the cross section is shown below. 

 
It should be noted that not all utilities can be plotted on the cross section or profile as summarized 
below: 
 

 In Cross Section mode, only underground utilities that intersect the cross section Pattern Lines 
are plotted on the cross sections at the offset and elevation where the utility line crosses the 
Pattern Lines. Utility lines that run parallel to the pattern lines are not plotted on the cross 
sections. 
 

 In Profile mode, only underground utilities that cross the centerline that was used to extract the 
profile are plotted on the profile. The utility location is represented on the profile by the 
placement of a cell at the station and elevation where the utility line crosses the centerline 
chain. 

 
This chapter will focus on placing the underground utilities on the cross sections. 
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3.2 The Draw Ancillary Features Dialog 

The Draw Ancillary Features dialog is accessed from the GEOPAK Road tool palette as shown below. 

 
The application can also be accessed by selecting Applications > Road > Cross Sections > Draw Ancillary 
Features from the MicroStation pull-down menu. 
 
Once selected, the Draw Ancillary Features dialog box, shown below, is opened. 
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The Draw Ancillary Features dialog, shown above, is divided into four sections. 
 

 The top portion of the dialog is used to define the profile or cross sections that will be used to 
plot the ancillary information. 

 

 The list box in the middle of the dialog is used to build a collection of ancillary features to be 
plotted. 
 

 The Intersecting Elements portion of the dialog is used to define the elements that represent 
the location and elevation of the ancillary data to be plotted. 
 

 The Display Settings section is used to define how the ancillary information will be plotted on 
the cross sections or profile. 
 

Each portion of the dialog will be described in detail on the following pages. 
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Job 
Specify the Job Number for the GEOPAK Coordinate Geometry database (GPK file) where the 
Chain and Profile are stored. 
 
Label Scale 
Use this key-in field to set the scale for text labels placed with the ancillary information. Note: 
This option is only used if the text setting is set to Scale, not Fixed. 
 
Chain 
Select the name of the Chain used to generate the cross section or profile cell. 
 
View 
This option is used to select either Cross Section or Profile for the placement of the ancillary 
data. Note: When set to Profile, the list of available chains is taken from the GPK file specified 
by the Job field. When set to Cross Section, the list of chains is determined by reading the cross 
section cells in the active design file. 
 
Station Range 
Key-in the Begin and End stations for cross section or profile processing. 

3.2.1 Intersecting Elements 

The Intersecting Elements portion of the Draw Ancillary Features dialog, shown below, is used to define 
the elements that represent the plan view location and elevation of the ancillary data to be plotted. 

 
Four options are available as detailed below: 

 
Each option is described on the following pages. 
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Chain 
Select the Chain option to define the plan view location of the ancillary data by a COGO Chain. The chain 
can be selected from the drop down list or graphically via the Identify Chain icon. When Chain is 
selected, the default option for the elevation definition is a COGO Profile as shown below. Select the 
desired Profile from the list. 

 
Survey Chain 
Select the Survey Chain option to define the plan view location of the ancillary data by a Survey Chain. 
The Survey Chain can be selected from the drop down list or graphically via the Identify Chain icon. 
When Survey Chain is selected, by default the elevation definition for the ancillary data is the Survey 
Chain itself. 

 
Level Symbology 
This option is used to define the plan view location of the ancillary data by locating elements drawn in a 
MicroStation design file. The process will scan the selected DGN File to find elements matching the 
specified level symbology. 

 
To specify the symbology for the plan view elements representing the ancillary data location, select the 
Symbology icon to access the Intersecting Element Symbology dialog box, toggle on the desired 
symbology options, and use the Match button to select the utility line element from the plan view 
design file. 
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Feature 
This option is used to define the plan view location of the ancillary data by locating elements drawn in a 
MicroStation design file. The process will scan the selected DGN File to find elements matching the 
symbology defined by selecting a feature from the Design and Computation Manager database. 

 
Select the Browse Feature button to open the Design and Computation Manager database. Select the 
desired feature from the list. 
 
Extract Elevation 
Toggle on Extract Elevation to access the four options shown below. 

 
Each option is described below. 
 
TIN 
Select the TIN option to specify the TIN File that will be used to extract the ancillary data elevation. The 
Vertical Offset option can be used to specify an offset above or below the TIN model for the ancillary 
data. For example, to place a utility line with a depth of cover of 3’, set the Vertical Offset value to -3. 

 
Level Symbology 
Use this option to define the elevation of the ancillary data relative to a graphic element drawn in the 
profile or the cross sections. The process will scan the profile or cross section to find elements matching 
the defined symbology, and then apply the Vertical Offset to determine the elevation of the ancillary 
data. 

 
To define the profile or cross section element, select the symbology button to access the Extract 
Element Elev Symbology dialog box. 
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Feature 
The Feature option works identically to the Level Symbology option with the exception that the 
symbology for the profile and cross section elements is defined by a Feature in the Design and 
Computation Manager Database rather than by level symbology. 

 
Adhoc Attribute 
Scans the limits of the cross section or profile cell and uses any element with the specified adhoc 
attribute. To use a depth of cover, set the Vertical Offset field. 

 

3.2.2 Display Settings 

The Display Settings section of the Draw Ancillary Features dialog is used to define how the ancillary 
information will be plotted on the cross sections or profile. 

 
The ancillary data can be drawn on cross sections or a profile using the three options detailed below: 
 
Cell 
This option is used to place a cell on the cross sections or profile at the location of the ancillary data. 
Key-in the Cell name in the dialog. The MicroStation configuration variable MS_CELLLIST is used to 
define the cell libraries that will be searched if the cell is not contained in the currently attached cell 
library. 

 
To set the symbology for the cell, toggle on the option button to the right of the cell name field, and 
then double click the Symbology box. 
 
The Scale option can be used to specify the size of the cell. If the cell is placed on a profile or cross 
section that was plotted with a vertical exaggeration, click on the Apply Vertical Exaggeration option. 
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The orientation for the cell can be specified by use of the Justification options. The cell orientation is 
relative to the station, offset (cross section View only), and elevation point where the cell will be drawn. 
 
Symbol 
When the option is toggled to Symbol, the Display Settings appear as shown below. 

 
The Symbol option is used to place one of the predefined symbols shown at right. 
 
The justification for the Symbol can be set using the Justification options. 
 
The level symbology for the Symbol can be defined by double clicking the Symbology box to 
access the Symbol Symbology dialog box. 
 
The Width and Height of the symbol can be defined using the Fixed or Adhoc Name options. 
For more information on using the Adhoc Name option, see section 3.4.1. 
 
Text 
Select the Text option to place labels on the profile or cross sections. 

 
Double-click the Sample field to define the text symbology using the Text Symbology dialog box shown 
at right below. 
 
The text scale can be set as described below. 

 
Select the TH/TW Fixed option to use the Th and Tw values 
entered in the dialog. 
 
Select the Scale TH/TW option to apply the Label Scale value to 
the Th and Tw values entered in the dialog. 
 
The Traverse Offset and Radial Offset values are used to 
specify the location of the text labels in relation to the utility 
location. 
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Angle 
The text can be rotated by specifying a rotation angle. 
 
Label: 
Use the Label field to enter the text string to be placed on the profile or cross sections. Several 
calculated values can be entered into the Label field as shown below. Select the ? icon to show a 
list of Computed Text values that can be inserted into the label. 

 

3.2.3 The Draw Ancillary Features List Box 

The list box in the center of the Draw Ancillary Features dialog box, shown below, is used to build a 
collection of ancillary features to be plotted on the profile or cross sections. 

 
Once you have completed the Display Settings and the Intersecting Elements portions of the Draw 
Ancillary Features dialog, the three buttons to the right of the list box are used to Add, Modify, and 
Delete rows from the list box. 
 

 Add Element Set 
Select this button to add the current settings as a new row in the list box. Multiple rows can be 
defined to draw several ancillary features simultaneously. 
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 Modify Element Set 
Use this button to modify the settings of the selected line in the list box. Select the line, make 
the desired changes, then select Modify Element Set to apply the changes. 
 

 Delete Element Set 
Use this button to delete a line from the list box. Highlight the desired line, and then select 
Delete Element Set. 

 

3.2.4 File Options 

The File options are used to Save and Load the Draw Ancillary Features Dialog settings. The default 
extension is .afd. 

3.2.5 Update Options 

The four options are detailed below. 

 
Delete Existing Elements and Redraw 
When this option is activated, any ancillary data previously drawn with this tool is  deleted and new data 
is drawn. 
  
Delete Non-modified Elements and Redraw 
When this option is activated, any ancillary data previously drawn with this tool is deleted and new data 
is drawn. 
  
Draw on Top of Existing 
When this option is activated, any previously drawn ancillary data is ignored and a new set is drawn, 
resulting in two sets of ancillary data. 
  
Query 
When activated, the user is prompted each time Draw is clicked.  
 
The user must select one of the three options and click Apply to commence processing. Clicking Cancel 
closes the dialog with no subsequent processing. 
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3.3 Cross Section Utility Processing Example 

This section will demonstrate use of the Draw Ancillary Features dialog to draw a symbol and text 
representing an existing 6” gas line on the cross sections with a 3.0’ depth of cover. The gas line location 
will be read from MicroStation graphics. The elevation will be determined from the existing ground TIN 
file provided with the Survey Data. 
 

The dialog at left shows the settings to 
draw a symbol, representing the gas 
line, on the cross sections. 
 
Tips: 
Set the Vertical Offset to a negative 
value to place the symbol below the 
TIN surface. 
 
Set the Justification to Center Top to 
properly represent the Depth of 
Cover. 
 
The Width, and optionally the Height, 
is entered in decimal feet. 
 
After you have defined the first row 
with the settings to place the symbol, 
be sure to select the Add Element Set 
button. 
 
 
 

 
To configure the dialog to place a label for the 6” Gas line, take the following steps: 
 

 The settings for the Intersecting Elements portion of the dialog box are identical to the settings 
used to place the Symbol. No changes need to be made. 

 Toggle the Display Settings item to Text. 
 Set the symbology for the text placement using the Text Symbology dialog shown on page 3-8. 
 Key in the label for the text 
 Select the Add Element Set icon to add the text item to the list. 

 
The dialog will appear as shown below after the text item is added to the list. 
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After you have added rows defining the Symbol and Text placement, select the Draw button. An 
example of the gas line utility as drawn on the cross sections is shown below. 
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3.4 Processing Multiple Utility Lines of the Same Type 

The Draw Ancillary Features dialog will allow you to locate multiple plan view utility lines for placement 
on the profiles or cross sections. In the example below, two utility lines have been defined: a 4” Gas line, 
an 8” Gas Line. 

 
This works very well when the Intersecting Elements are defined using the Chain or Survey Chain 
options. However, when multiple utility lines of the same type are processed using the Level Symbology 
or Feature options to read plan view graphics for the utility line location, the potential for duplicate 
symbols and text labels exists. 
 
In the example above, each gas line has been defined by finding elements in the DGN File with 
symbology matching the Level Symbology for an existing gas line on the level UT_X_Gas. According to 
ODOT Standards, existing gas lines are drawn with the following symbology: 
 

Feature Level Weight Line Code Color 

Gas Line UT_X_Gas 0 gasex 4 

 
ODOT CADD Standards do not provide a way to differentiate the 4” gas line from the 8” gas line. In this 
case, the Draw Ancillary Features dialog will plot each gas line on the profile or cross section as both a 4” 
Gas line and an 8” Gas line as shown in the example below. 
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The user has three options to resolve this problem: 
 

Option 1: Copy and Delete 
The user may elect to copy the plan view DGN File, delete one of the utility lines, and then 
configure the Draw Ancillary Features dialog to process only the remaining gas line. After 
processing the first gas line, the user must copy the plan view design again, delete the other 
line, and process the remaining line. 
 
Option 2: Temporarily Change Symbology 
The user may elect to temporarily change the symbology of one of the gas lines so that they 
have unique symbology. 
 
Option 2: Adhoc Attributes 
Adhoc attributes can be used to “tag” supplemental information to MicroStation elements. This 
supplemental information can be read by various GEOAK functions and used for a variety of 
applications. The Draw Ancillary Features dialog can be configured to read the Adhoc attribute 
values from MicroStation elements and use these values to set the Symbol size and the content 
of the Text label that will be placed on the profile or cross sections. 
 
Using Adhoc Attributes, any number of plan view elements defining one utility type can be 
processed simultaneously in one run without copying design files, or changing the element 
symbology. 
 
Adhoc attributes are assigned to MicroStation elements by use of the GEOPAK Design and 
Computation Manager or the Adhoc Attribute Manager. The procedure to use Adhoc attributes 
for ancillary data processing is detailed in the following sections. 
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3.4.1 Drafting Utility Lines with Adhoc Attributes 

Each item in the ODOT Design and Computation Manager Database that has been configured for an 
existing utility line has been also been configured with the Adhoc attributes “SPAN”, ”RISE” and “LABEL”. 
The SPAN and RISE attributes are used to designate the size for the symbol placed on the profile or cross 
sections. The LABEL attribute is used to specify the text description that will be placed with the utility 
line symbol on the profile or cross sections. The example below depicts the procedure to place an 
existing 12” water line assigning a SPAN and RISE value of 1.0, and a text LABEL of “12” Water”. 

 
Note: The SPAN and RISE attributes must be specified in Master Units. 
 
The Design and Computation Manager can also be used in Set mode to assign these Adhoc attributes to 
previously drawn utility lines. 
 
Set mode is used to set an existing MicroStation element to match the symbology of the selected Design 
and Computation Manager Item. It can also be used to assign Adhoc attributes to previously drawn 
elements as shown in the example above. See the ODOT GEOPAK Road 1 Manual, Chapter 5, for more 
information on the use of the GEOPAK Design and Computation Manager dialog. 
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3.4.2 Adhoc Attribute Manager 

The Adhoc Attribute Manager is used to store, review and modify Adhoc attributes. The Adhoc 
Attribute Manager can be accessed from the GEOPAK Road tool palette as shown below, or by selecting 
Applications > Road > GEOPAK 3PC Adhoc Attributes from the MicroStation pull down menu. 

 
The AdHoc Attribute Manager dialog, shown below, is opened. 

 
See the GEOPAK on-line help for complete details regarding the use of the Adhoc Attribute Manager. 
The procedure to edit and set the Adhoc attributes for selected MicroStation elements is detailed 
below. 
 

 Use the Identify Element icon, as shown at right, to 
select a MicroStation Element that has been previously 
placed with or without Adhoc attributes assigned. Once 
the element is selected, any Adhoc attributes stored 
with the element are shown in the dialog.  
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 To change the value of an attribute, select the attribute 
Value from the AdHoc attribute Manager dialog and key 
in the new value. 

 
 Use the Set Attributes icon, as shown at right, to assign 

the Adhoc attributes to a MicroStation element by 
selecting the element and accepting it. 
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3.4.3 Processing Utilities with Adhoc Attributes 

The Display Settings portion of the Draw Ancillary Features dialog can be configured as shown below to 
read the SPAN and RISE Adhoc attributes to define the Width and optionally the Height of the Symbol to 
be placed on the profile or cross sections. 

 
Note: If the SPAN and RISE values are the same, it is not necessary to define the Height item in the 
Display Settings. 
 
To place text labels using the LABEL Adhoc attribute, toggle the Display Settings to Text and select the 
string adhoc attribute item as shown below. 

 
The Label field is populated with the information to use an Adhoc attribute to compose the label as 
shown in the example below. 

 
Edit the text “insert name here” with the name of the Adhoc attribute as shown on the following page. 
 
 
 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
Chapter 3 – Underground Utilities Page 3-19 
 

 
The Label field will appear as shown in the example below when you have completed the edit. 
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3.5 Exercise 3 

The file 12345BU001.dgn contains the plan view graphics for a 6” Gas line and a 12” Sanitary line. Use 
the Draw Ancillary Features dialog to place symbols and text for a 6” Gas line and a 12” Sanitary line on 
the S.R 185 cross sections. Use the following settings to place each utility: 
 

Utility Line Plan View Definition Elevation 

6” Gas DGN File = 12345BU001.dgn Depth of Cover = 2.0’ 

12” Sanitary DGN File = 12345BU001.dgn Depth of Cover = 3.5’ 

 
The 6” Gas line has been tagged with the Adhoc attributes SPAN, RISE, and LABEL. Use the processing 
options to read the Adhoc attributes for the symbol and text placement. 
 
The 12” Sanitary line has not been tagged with any Adhoc attributes. Process this utility line by keying in 
the value for the Symbol Height and the Text Label. 
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4 Superelevation 

4.1 Overview 

4.1.1 Disclaimer 

Superelevation transition stations and cross slopes can be computed using the preference files provided 
by ODOT, which are detailed in this Chapter. The user of these preference files should check all 
computed values for accuracy. ODOT will assume no responsibility for the results obtained by use of the 
provided superelevation preference files, or the accuracy of the calculations. 

4.1.2 Superelevation Overview 

GEOPAK supports several options for defining the pavement widths and cross slopes on the proposed 
cross sections. The pavement width and cross slope is represented by a series of complex shapes, drawn 
in a MicroStation file, which are tagged with the cross slope information. 
 
A simple example of two pavement shapes is shown in the graphic below. Each shape represents one 
lane of pavement. This example contains two lanes of pavement with the profile grade line defined at 
the center of the pavement. The cross slope for each shape, -1.60%, is tagged at the end of the shape. 

 
The pavement shape definition can be as simple as a single shape with slope specification on each end 
of the shape, to a series of shapes representing multiple roadways, each with its own superelevation 
transitions. 
 
The most basic condition is the roadway where no superelevation transitions are required, i.e., the slope 
for all pavements can be specified as a single value. In this case, the pavement cross slope can be 
defined with the proposed cross section processing and no pavement shapes are required. Therefore, 
this method is identified as “shapeless”. 
 
Another option is the definition of superelevation transitions where roadways have a constant width 
without tapers. In these areas, the Automated Superelevation tool can be used. Superelevation shapes 
are generated based on a user-defined design speed and the geometry of the specified roadway. After 
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processing the data, GEOPAK draws pavement representations as complex shapes into a MicroStation 
2D design file. 
 
The last option is the definition of superelevation transitions where roadways do not have a constant 
width, i.e., gore areas, approach tapers, departure tapers, acceleration and deceleration lane tapers, 
etc. In these areas, graphics elements within a MicroStation 2D design file are used to create complex 
shapes which define the superelevation transitions. 
 
A combination of these tools can be used within a project, or even within a single roadway. The 
shapeless mode is excellent for widening and resurfacing projects where the existing cross slopes will be 
maintained, while the automated method quickly generates automated shapes for more complex 
roadways. Any area which cannot be defined via the automated method can be augmented by the 
graphical method. 
 

4.1.3 Shape Design Files 

Superelevation Shapes for the entire project can be stored in the same design file. The ODOT_Files 
application can be used to create the design file for the shapes as shown below. 
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4.2 Shoulder Shapes - Are They Needed? 

Usually, the paved roadway is shaped. This is true of the mainline lanes, but what about the shoulders? 
It's usually better not to shape the shoulders, but to use GEOPAK criteria files to draw the shoulder 
slopes on normal (non-skewed) cross section processing. This allows more flexibility to draw variable-
width shoulders, with cross slopes based on the adjoining mainline pavement slopes and standard 
rollovers on superelevated areas. See Chapter 5 Proposed Cross Sections for a description of criteria files 
and their use. 
 

4.3 How to Shape 

Now that the decision has been made on what to shape, the process is done in three parts. Let's review 
the process in general and then look specifically at each step: 
 

1. Automated superelevation computations, the first step in producing shapes, is used where a 
standard width lane can be defined by two offsets from a defined alignment. In this step, 
GEOPAK computes superelevation based on user-defined parameters and produces an 
Autoshape text input file. This ASCII file can be modified if the user chooses to override the 
computed superelevation values. 

 
2. Process the Autoshape file created in step one to draw shapes into a MicroStation design file. If 

desired, the automated superelevation step can be skipped and the Autoshape file can be 
generated manually using any ASCII text editor. Regardless of how the Autoshape file is created, 
there are several advantages of auto shaping: 

 

 If the alignment changes, the obsolete shapes can be deleted and the auto-shaping can 
be run in a minimum amount of time compared to graphics shaping. 

 It can produce shapes faster than graphics shaping. 

 The shapes are placed automatically. 

 It produces fewer errors when processing proposed cross sections since it does not rely 
on graphic lane lines, which are not as accurate as the parallel chains used in auto 
shaping. 

 
3. Once the processing of the Autoshape file is complete, other irregular areas such as tapers, turn 

lanes, and gore areas can be shaped using the Shape Maker tool. 
 
It is advisable to place the shapes in their own file, while referencing the plan view. See the ODOT CADD 
Engineering Standards Manual for standard design file names. The ODOT_Files.exe application, available 
from the ODOT CADD Support Website, can be used to create design files using the proper file naming 
convention. 
 
Before discussing how each tool is used, a discussion of the components of a shape needs to be 
addressed. 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page 4-4 Chapter 4 – Superelevation 
 

4.4 Components of the Shape 

The GEOPAK Superelevation shapes are placed in the design file as complex shapes. They consist of a 
series of connected elements (lines, line strings, arcs, and curve strings) that form a closed shape. The 
elements that form the shape can be classified into two types: 
 
Longitudinal Edges 
Longitudinal Edges define the longitudinal breaks between slope areas. Typically the longitudinal edges 
consist of only the roadway pavement lane width edges. A longitudinal edge could form a crown or a 
lane line. Longitudinal lines will generally coincide with the roadway geometric elements (lane width, 
edge of pavement) contained in the plan view MicroStation file. 
 
Filler Lines 
Filler lines define the limits of constant slope or the limits of superelevation transition. These lines are 
radial to lane width edges except where some form of lane transition occurs. 

 
A primary distinguishing factor differentiating longitudinal edges and filler lines is that filler lines always 
represent a slope while longitudinal edges do not. If the shape represents a superelevation transition 
section, each filler line represents a different slope. 
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4.5 Shape Cluster Parameters 

Every shape has four hidden attributes which cannot be seen by the user unless the GEOPAK Element 
Attributes or Shape Analyst tools are used. All shapes with common attributes are defined as a 
"cluster". These attributes include: 
 

Baseline 
The Baseline defines the GEOPAK chain representing the proposed alignment for a shape 
cluster. 
 
Profile   
The Profile defines the vertical geometry for a particular roadway. 
 
Tie 
The Tie parameter is used to establish the location of the Profile relative to the Baseline chain. 
The Tie can be defined as a constant offset, or as a variable offset by use of a COGO chain. Each 
option is described below: 
 

Tie defined by an offset 
The Tie value represents a constant offset distance, measured from the Baseline chain, 
to define a Profile Grade Line (PGL) location. Note: The profile is defined using the 
centerline stationing. The Tie value is calculated from the baseline to the PGL location. 
 
Tie defined by a PGL-Chain 
The PGL-Chain option is used to specify a GEOPAK chain that defines the Profile Grade 
Line (PGL) location. This option is only used when the offset distance from the Baseline 
to the Profile location is not a constant value. For example, this option would be used 
for a divided facility where the PGL follows the inside edge of pavement and the median 
width is transitioning. 

 
The Baseline, Profile, Tie and PGL-Chain parameters are interpreted by the proposed cross-section 
software to determine the following: 
 

1. A stationing reference expressed as a GEOPAK chain. The stationing reference is defined by the 
Baseline parameter. 

 
2. The Profile Grade Line (PGL). The PGL can be defined by either a PGL-Chain or the combination 

of a Baseline and Tie. If the Tie option is used, the PGL-Chain cannot be specified. 
 

3. Vertical geometry expressed as a GEOPAK profile. This is defined by the Profile parameter. 
 
All shapes with common attributes define a shape"cluster." If any of the four elements are changed, it 
defines a new cluster. For example, on a divided highway, one roadway has a proposed alignment NB, 
profile NBPRO and a tie of 20. This is one cluster. A second cluster would be defined on the other side of 
the roadway with a proposed alignment SB, profile SBPRO and a tie of -20. In practical terms, shapes 
representing adjacent areas of pavement not separated by medians or other physical breaks will 
typically belong to the same shape cluster. There is no limit to the number of shape clusters in a project. 
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4.6 Dependent and Independent Shapes 

There are two types of shapes, Dependent and Independent, which refer to how elevations on the 
pavement surfaces represented by the shapes are calculated. 
 

Dependent shapes   
The starting elevation for the shape is determined directly from the profile. The software 
computes the proposed profile and uses the information to draw the shape width and slope on 
the cross section. 
 
Independent shapes  
The starting elevation for the shape is taken from the adjacent shape, not from the profile. A 
right turn lane is an example of an independent shape. 

 
Each cluster must have a minimum of one dependent shape. If two adjacent shapes straddle the PGL 
location, either shape could be defined as a dependent shape. In this case, choose one of the lanes as 
the dependent shape. 
             
In cases where the dependent shape is not adjacent to the baseline, care must be exercised as shown in 
the example below. 

 
The cross section pattern line intersects two shapes that refer to the same PGL, defined by a Tie of -20, 
Profile and Baseline. Within this group of shapes only one shape can be a Dependent shape. The other 
shape must be an Independent shape. The proposed cross-section software will first determine the 
elevation at the Profile Grade Line (PGL). In the example above, the PGL coincides with the inside edge 
of pavement so the elevation of the profile at this station is applied to point A. The elevation at point B 
is determined by projecting the 1.56% grade across the width of the Dependent shape. The elevation at 
point C is determined by projecting the -1.56% grade across the width of the Independent shape. A 
cross-section view for this example is shown on the following page. 
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The elevations of the pavement surfaces would be determined differently if the PGL remained along the 
inside edge of pavement but the assignment of Dependent and Independent shapes were reversed. This 
case is illustrated below. 

 
In this situation, the PGL is not coincident with the edge of a Dependent shape. The rule applied by the 
proposed cross-section software is to project the profile elevation onto the closest edge of the closest 
Dependent shape. As shown in the cross-section below, the elevation at the PGL is projected to Point B 
at a slope of -1.56%. The elevations at Points A and C are then determined by projecting the 1.56% and 
the -1.56% grades across each shape. 
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4.7 Transitional or Non-Transitional Shapes 

Each shape also has two slope options, Transition or Non-Transition. 
 

 The Non-Transition shape has a constant slope the entire length of the shape. These are 
common in tangent sections of the roadway. 

 

 Transition shapes have a different slope at each end of the shape and the software interpolates 
between the two slopes. 

 
The software defaults to a linear interpolation for its transitions which is the method ODOT uses. 
However, the software also provides the options for an unlimited number of parabolic transitions. 

 
In the example above, the left-hand and right-hand shapes start at a constant slope of -1.6%. The right-
hand shape then transitions from a -1.6% to +8.0% slope and the left-hand shape transitions from a -
1.6% to -8.0% slope. At the end, the left-hand shape is a constant -8.0% and right-hand shape is a 
constant +8.0%. There is no visual representation as to whether the shape is a linear or parabolic 
transition. 
 
Note that the sign of the slope is important. A +1.6% slope is going up as it goes away from the PGL. A 
slope of -1.6% is going down as it goes away from the PGL. A text label representing the slope (including 
the negative sign if necessary) at each superelevation transition is drawn inside each shape. If the 
MicroStation area fill view attributes option is active, the shapes appear filled. 
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4.8 Superelevation Shape Manager Tools 

GEOPAK provides a comprehensive set of shape tools to generate, evaluate, and edit superelevation 
shapes. The shape tools can be accessed from the Road tool palette, or from the MicroStation pull down 
menu by selecting Applications > Road > Cross Sections > Superelevation Shape Manager Tools. Once 
selected, the Superelevation Shape Manager Tools palette shown below appears. 

 
The tools in the Superelevation Shape Manager have the following functions: 

 
Automated Superelevation - Performs the superelevation calculations and stores the results in 
an ASCII file known as the Autoshape input file. 

 
Autoshape Builder - Processes an Autoshape input file and draws the pavement shapes in the 
specified 2D file. 
 
Shape Maker - The Shape Maker tool provides a graphical method for drawing irregular 
pavement shapes. 

 
Shape Analyst - The Shape Analyst tool provides information, such as cross slope, elevation, 
etc., at any point on the shape. 
 
Shape Profiler - The Shape Profiler tool provides elevations at user defined increments along the 
shapes. 
 
Shape Editor - The Shape Editor enables the user to edit the shapes including station ranges, 
cross slope, etc. 
 
Shape Selector - The Shape Selector tool is used to highlight or select shapes based on a wide 
range of user queries or filters. 
 
Shape Properties - The Shape Properties tool provides information on any GEOPAK shape. In 
addition, this shape information can be modified on individual shapes or selections of shapes. 
 
Shape to DTM - The Shape to DTM tool is used to read GEOPAK superelevation shapes to create 
a DAT file for use in the Build Triangles tool in the DTM tool frame. 
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4.9 Automated Superelevation 

The GEOPAK Superelevation tools enable the user to quickly create, edit, and run an Autoshape input 
file using a previously stored COGO alignment. The Automated Superelevation dialog can be accessed 
from the Road Project dialog, or by selecting the Automated Superelevation icon from the 
Superelevation Shape Manager Tools as shown below. 

 
If you are using the GEOPAK Project Manager, you will be prompted to select or create a Run. When the 
command is selected, the dialog shown below is opened. 

 
In this dialog, the user selects which Preferences File is to be used for a given run, along with many 
other parameters such as the Baseline, Profile, etc. When the Generate Superelevation Transitions 
button is pressed, an Autoshape input file and a log file are generated. The log file, which has the same 
name as the input file but with a .log extension, gives the user detailed information on the decisions and 
computations made in the course of generating the input file. 
 
The superelevation rates and transition stations which are written to the Autoshape input file should be 
checked, and, if desired, modified. After reviewing the input file, the shapes are created by use of the 
Autoshape Builder tool as described in Section 4.11. 
 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
Chapter 4 – Superelevation Page 4-11 
 

A description of how GEOPAK computes superelevation transitions is detailed below, followed by a 
description of the components of the Automated Superelevation dialog. 

4.9.1 Computation Process 

This section describes the process used by GEOPAK to calculate the superelevation from an engineering 
standpoint and explains how the various preference settings affect that process. 
 
The following is a flow chart showing the major stages which take place in the process of calculating 
superelevation in the order those stages take place. 

 
Using the radius of each curve, superelevation rates (e) are computed.  
 

 Using the computed e-value, Runoff Lengths are computed as if the roadway had only two 
lanes. This Runoff Length is termed here Unadjusted Length.  

 

 Using the Unadjusted Lengths, true Runoff lengths (Adjusted Lengths) are computed based on 
the actual roadway widths (or number of lanes).  

 

 Filler line stations are computed using the true Runoff lengths.  
 

 Curve Conflicts are then checked and corrected if possible.  
 

 Finally, filler line stations are written to the autoshape input file which is then used to create 
roadway shapes in the design file. 

 
Disclaimer 
The ODOT superelevation preference files are provided to assist the designer in generating the 
autoshape input file. Before processing the input file, it is the responsibility of the designer to review the 
results for compliance with ODOT standards, and correct the results as necessary, before processing the 
superelevation transition calculations. 
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4.9.2 File Menu 

The Automated Superelevation dialog supports several options from the File pull-down menu in the 
upper left corner. These options are detailed below. 

 
Directories 
Selection of File > Directories opens a dialog that enables the user to view and change the four 
directories used by GEOPAK Superelevation. 

 
Each of the four directories can be assigned a default value by the use of MicroStation 
Configuration Variables. To the right of each field are buttons that allow the user to select a 
directory by browsing or to restore the given directory to its default value. If the Configuration 
Variable is defined, the Default button sets the directory to the value defined by the variable. If 
not, Default button sets the value either to the GEOPAK\bin directory or the user's current 
Working Directory. The four Configuration Variables are described below: 

 
GPK_SUPER_PREFDIR 
This variable is used to assign the default directory that GEOPAK will search for the 
superelevation preference file. The variable has been defined as follows for ODOT personnel: 
 

GPK_SUPER_PREFDIR = i:\ODOTstd\V8istd\geopak\road\super\ 
 

GPK_SUPER_EDIR 
This variable is used to assign the default directory to search for e-computation .csv files. The 
variable has been defined as follows for ODOT users: 
 

GPK_SUPER_EDIR = i:\ ODOTstd\V8istd \geopak\road\super\ 
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GPK_SUPER_LENGTHDIR 
This variable is used to assign the default directory to search for length-computation .csv files. 
The variable has been defined as follows for ODOT users: 
 

GPK_SUPER_LENGTHDIR = i:\ ODOTstd\V8istd \geopak\road\super\ 
 
GPK_SUPER_AUTOSHAPEINPUTDIR 
This variable is used to assign the directory that will be used to write the Autoshape input files 
and log files. Not setting this configuration variable would cause the tool to store the Autoshape 
input file and the log file in the user's current Working Directory. This variable has not been 
deined for ODOT users. 

 
 

Preferences 
Select File > Preferences to access the Superelevation Preferences dialog shown below.  

 
The Superelevation Preferences dialog gives the user control over every aspect of the 
superelevation computation process. AASHTO Method V is available as a default, along with the 
ability to employ user-defined lookup tables both for e (superelevation rate) and for runoff 
length. User-defined equations may also be entered to compute these values. Options are 
available for resolving the superelevation conflicts of reverse curves, compound curves, broken 
back curves, and short curves. 
 
Superelevation preferences are saved as an ASCII text file with an extension of .sep. Two ODOT 
standard superelevation preference files are available as listed below: 
 

i:\ ODOTstd\V8istd \geopak\road\super\ODOT2006_Divided.sep 
 
i:\ ODOTstd\V8istd \geopak\road\super\ODOT2006_Undivided.sep 
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These preference files require the following supporting files: 
 

i:\ ODOTstd\V8istd \geopak\road\super\ODOT2006_RadiusTbl.csv 
 
i:\ ODOTstd\V8istd \geopak\road\super\ODOT2006_RGtable.csv 

 
Note: You do not need to access the Superelevation Preferences dialog unless you wish to edit 
or review the settings of the ODOT preference files. See the GEOPAK on-line help for complete 
information on the Superelevation Preferences dialog. Use of these preference files is detailed in 
section 4.9.3. 

 
 

Level Symbology 
When File > Level Symbology is selected, the dialog shown below opens. 

 
This dialog is used to define the element symbology for the shapes. Float the cursor over the 
symbology boxes to reveal the current settings for the Dependent Shapes and the Independent 
Shapes. To change the values, double click on the Symbology box to open the GEOPAK Set 
Feature dialog shown below. 

 
The Level GK_Shapes has been defined for the placement of pavement shapes. The Color, Style, 
and Weight parameters can be defined as desired by the user. 
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4.9.3 Populating the Automated Superelevation Dialog 

After setting the preferences, user directories, and shape symbologies, the next step is populating the 
Automated Superelevation dialog. A sample dialog is shown below. 

 
Job 
Key-in the Job number for the Coordinate geometry database where the desired chains and profiles are 
stored. 
 
Design Speed 
Key-in the Design Speed to be used for computation. 
 
Station Range 

Chain - This drop down menu is used to select the COGO chain for which superelevation 
transitions are to be calculated. This chain is also called the “Shape Cluster Baseline” in the 
Autoshape input file.  
 
Begin - When the chain is defined, GEOPAK populates the Begin station item with the beginning 
station of the chain. To compute superelevation for part of a chain, adjust the station by keying 
in a new Begin station value or by use of the DP button. 
 
End - When the chain is defined, GEOPAK populates the End station item with the ending station 
of the chain. To compute superelevation for part of a chain, adjust the station by keying in a new 
End station value or by use of the DP button. 
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Preference File 
The Preference File combo box is used to select which preference file will be used for the superelevation 
computations. The Preference File item lists any .sep files found in the Preference Files Path (see the 
Superelevation File Directories dialog on page 4-11). The following two preference files have been 
configured for ODOT use: 
 

 ODOT2006_Divided.sep 

 ODOT2006_Undivided.sep 
 
ODOT2006_Divided.sep has been configured to compute superelevation transitions for four-lane 
divided highways according to the January 2006 revision of the ODOT Location and Design Manual 
Volume 1 – Roadway Design, Figure 202-5bE. 
 
ODOT2006_Undivided.sep has been configured to compute superelevation transitions for undivided 
highways according to the January 2006 revision of the ODOT Location and Design Manual Volume 1 – 
Roadway Design, Figure 202-5aE. 
 
Once the Preference File is selected, the e Selection and L Selection combo boxes are populated 
according to the selected Preference File. The user chooses the desired superelevation table from the e 
Selection box. The following tables are available: 

 
e selection 
The e Selection options are named according to the corresponding figure in the ODOT Location and 
Design Manual Volume 1 – Roadway Design. Each of these options represents a Radius Table contained 
within the following file: 
 

i:\ODOTstd\V8istd\geopak\road\super\ODOT2006_RadiusTbl.csv 
 
 
L selection 
The L Selection is used to select the Relative Gradient Table to be used to compute the length of the 
Tangent Runout. The following file has been configured to set the Relative Gradient values according to 
the ODOT Location and Design Manual Volume 1 – Roadway Design, Figure 202-4E: 
 

I:\ODOTstd\V8istd\geopak\road\super\ODOT2006_RGtable.csv 
 
ODOT uses the Relative Gradient values defined in Figure 202-4E for all cases. Using the ODOT 
preferences, there is only one option for the L Selection dialog item.  
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Facility 
Facility determines whether the roadway cross section is to be Divided or Undivided. 
 
 
Create Input File 
Key in the name of the Autoshape input file that will be created. If no path is specified, the input file will 
be saved in the current Working Directory. Note: This file is given a .inp extension. 

 
It is recommended that you use the name of the chain for the superelevation input file as shown in the 
example above. 
 
 
Generate Superelevation Transitions 
After the Automated Superelevation dialog has been completed, select this button to generate the 
Autoshape input file. See page 4-20 for an example of a completed Autoshape input file. 

 
 
 
Left / Right tabs 

 
The area enclosed in the Left / Right tabs is used to define the shape clusters. If the Facility option is set 
to Undivided, then the Left tab is for the left lane(s) while the Right tab is for the right lane(s). If the 
Facility option is set to Divided, then the Left tab is for the entire left roadway, while the Right tab is for 
the entire right roadway. 

 
Profile 
This drop down menu is used to select the COGO profile that will be used for the shape cluster. 
All available profiles are displayed in the menu. 
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Tie 
The Tie value is used to specify the horizontal distance between the Chain and the Profile 
location (PGL). This can be a constant Offset value or a tapering width specified by a PGL Chain. 
Each case is discussed below: 
 
If the distance is a constant value, toggle the Tie option to Offset. Key-in the Offset in the field 
to the right. In the example below, the PGL is at the centerline so an Offset of 0 is used. 

 
If the horizontal distance between the Profile location (PGL) and the Chain is a varying distance, 
then a chain must be defined in COGO designating the PGL location. Toggle the Tie option to 
PGL Chain. Select the desired Chain from the option box on the right. 

 
An example of where this option would be used is a divided facility where the PGL follows the 
inside edge of pavement and the median width is transitioning. 

 
List Box Options 
The list box at the bottom of the Automated Superelevation dialog is used to enter the parameters for 
each lane in the proposed roadway. 

 
% Slope 
Cross slope in percent format of each shape in normal crown. A negative sign denotes the 
roadway slopes down and away from the PGL. A normal crown section of 1.6% would, therefore, 
be entered as –1.6. 
 
Offset 
Offsets define the width of each shape (usually a lane) by two offset distances from the 
baseline. Note that tapers are not supported. Offset distances are negative if measured to the 
left. Lane offset values are entered in terms of master units, i.e., feet or meters. 
 
Dependency 
Shapes can be either Dependent or Independent as detailed in Section 4.6. There must be at 
least one dependent shape per cluster. 
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Edit buttons 

  New Lane 
To add a line to the list box, press the New Lane button. The values for the % Slope, Offsets, and 
Dependency can be edited by clicking on them as shown in the example below. 
 

  Delete 
To delete a line, highlight the desired line and then press the Delete button. 
 

  Quick Entry 
When pressed, the dialog shown below opens. Populate the dialog with the desired data, and 
then press the OK button to close the Quick Entry dialog and populate the main dialog. The 
example below shows the Quick Entry dialog settings to define two 12' lanes with a normal 
crown cross slope of -1.6%. 

 
After pressing the OK button, the Left and Right side tabs on the GEOPAK Automated 
Superelevation dialog are populated as are shown below 

 
NOTE: When the Quick Entry option is used, the Dependency for both shapes is set to 
Dependent for Undivided roadways. Be sure to review the results and change the Dependency 
as required. 
 
An example for a 4 lane divided facility is detailed below. 
 
In this example, the total median width is 40'. The PGL line follows the inside edge of pavement 
so the Tie: is set to Offset with a value of 20' for each side (negative to the left). The typical 
section for this lane configuration is shown below. 
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The completed Left and Right tabs for the GEOPAK Automated Superelevation dialog are shown 
below. Note that the Left tab contains all the information for both pavement lanes on the left 
side of the centerline chain. The Right tab contains all the information for the 2 pavement lanes 
to the right of the centerline. Also note that each side, Left and Right, must contain at least one 
dependent shape. 

 

 
NOTE: If the Quick Entry option is used to populate the Left and Right list boxes, the sign for the 
% Slope is not adjusted for multiple lanes. In the sample dialog below, a Nominal Percent Slope 
of -1.6 is keyed in. This will result in the % Slope for each of the 4 lanes being set to -1.6. It is 
necessary to adjust the sign of the % Slope from -1.6 to 1.6 on the GEOPAK Automated 
Superelevation dialog, as shown above, to correct the sign of the slope. 

 

  Rectify Lanes 
This option is used to check the pavement lanes that have been entered in the dialog to 
eliminate any gaps or overlaps between lanes, ensuring that one lane starts where the other 
lane ends. For example, if one lane is set to 0 and 12, while the next lane is set to 10 and 24, 
there's an overlap between 10 and 12.  Clicking Rectify Lanes will leave the 0 to 12 lane intact, 
and change the second lane to 12 and 26, maintaining the width of the second lane but 
eliminating the overlap. 

 
After the Automated Superelevation dialog has been completed, select the Generate Superelevation 
Transitions button. Three things happen after the button is selected. First, the superelevation 
transitions as computed by GEOPAK are written to the Autoshape input file specified by the user. 
Second, the log file is written. Finally, the Autoshape Input File is loaded into the text editor running 
within MicroStation. The GEOPAK Text Editor, loaded with a sample Autoshape input file, as shown on 
the following page. 
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This Text Editor dialog has a Create Superelevation Shapes icon at its top which allows the Autoshape 
Input File to be processed. Autoshape Input files can also be processed from the Autoshape Builder as 
detailed in Section 4.11. 
 
The stations for all shape clusters should be checked for compliance with ODOT roadway design 
standards before running the superelevation shape input file. If changes are necessary, the stations and 
cross slopes can be edited with any ASCII text editor, or the GEOPAK Text Editor. 
 
NOTE: If you use the Text Editor to modify the Autoshape input file, be sure to save the changes by 
selecting File > Save before selecting the Create Superelevation Shapes button. 
 
A sample Autoshape input file is shown below and continuing on the following page. 
 
/* Superelevation Settings and Parameters: 

  

Project Name:  C:\GPKclass\DAR\12345\geopak\12345_Design.prj 

User:          C:\GPKclass\DAR\12345\geopak\projdbs\Training 

Run Name:      SR185 

Unit System is english. 

Created input file "CLPS185_Superelevation.inp". 

Created activity log file "CLPS185_Superelevation.log". 

Created on Tue, Feb 17, 2009 at 12:37. 

Using Preference File "ODOT2006_Divided" 

Using e Selection of "8% eMax 202-7E". 

Using Length Selection of "all cases" 

Using Design Speed of 55.000000. 

  

*/ 

  

auto shape 

job number = 185 
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   auto shape set 

      shape cluster baseline   = CLPS185 

      shape cluster profile    = PS185P 

      shape cluster tie        = 0.0000 

      dependent shape 

      chain  /  offset 

         CLPS185    -12.0000 

         CLPS185    -0.0000 

      filler line station / slope 

         53+00.000000      -1.6000 

         60+74.981871      -1.6000 

         62+38.981871      -8.0000     /* Spiral PS18512B, Curve PS18512 */ 

         71+12.796686      -8.0000     /* Curve PS18512, Spiral PS18512A */ 

         72+76.796686      -1.6000 

         77+50.000000 R 2      -1.6000 

  

   auto shape set 

      shape cluster baseline   = CLPS185 

      shape cluster profile    = PS185P 

      shape cluster tie        = 0.0000 

      independent shape 

      chain  /  offset 

         CLPS185    0.0000 

         CLPS185    12.0000 

      filler line station / slope 

         53+00.000000      -1.6000 

         59+92.981871      -1.6000 

         62+38.981871      8.0000     /* Spiral PS18512B, Curve PS18512 */ 

         71+12.796686      8.0000     /* Curve PS18512, Spiral PS18512A */ 

         74+51.270000 R 2      -1.6000 

         77+50.000000 R 2      -1.6000 

  

   Plot Parameters 

      Dependent Shape 

         lvname = GK_Shapes 

         co = 40 

         lc = ByLevel 

         wt = ByLevel 

      Dependent Text 

      lvname = GK_Shapes 

      co = 40 

   Independent Shape 

      lvname = GK_Shapes 

      co = 87 

      lc = ByLevel 

      wt = ByLevel 

   Independent Text 

      lvname = GK_Shapes 

      co = 87 

 

Write shapes into dgn = C:\GPKclass\DAR\12345\roadway\basemaps\12345KS001.dgn 
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4.9.4 Autoshape Input File Format 

The Autoshape input file can be generated using the GEOPAK Automated Superelevation procedure or 
the user may manually type the ASCII file independent of any automated calculations. If you use the 
Automated Superelevation procedure, the Autoshape input file will contain a header similar to that 
shown below. 
 

/* Superelevation Settings and Parameters: 

  

Project Name:  C:\GPKclass\DAR\12345\geopak\12345_Design.prj 

User:          C:\GPKclass\DAR\12345\geopak\projdbs\Training 

Run Name:      SR185 

Unit System is english. 

Created input file "CLPS185_Superelevation.inp". 

Created activity log file "CLPS185_Superelevation.log". 

Created on Tue, Feb 17, 2009 at 12:37. 

Using Preference File "ODOT2006_Divided" 

Using e Selection of "8% eMax 202-7E". 

Using Length Selection of "all cases" 

Using Design Speed of 55.000000. 

  

*/ 

 
The header is included as a comment and does not include any commands that will be processed. It is 
not necessary to include a header in the Autoshape input file. Comments require a /* at the beginning of 
the first line and a */ at the end of the last line. 
 
The first two commands in the Autoshape file are shown below. The auto shape command is required to 
tell the software what type of input file is being processed. The second line is used to identify the GPK 
file that contains the chain and profile that will be used to generate the shapes. 
 

auto shape 

job number = 185 

 
A new auto shape set must be established for each different shape cluster, every set of dependent 
shapes, every set of independent shapes, every unique set of GEOPAK chain and offset combinations 
and every unique parabolic transition option. 
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The portion of the Autoshape input file shown below defines the pavement shapes for the left side of 
the roadway (see the chain/offset values below).  

    

   auto shape set 

      shape cluster baseline   = CLPS185 

      shape cluster profile    = PS185P 

      shape cluster tie        = 0.0000 

      dependent shape 

      chain  /  offset 

         CLPS185    -12.0000 

         CLPS185    -0.0000 

      filler line station / slope 

         53+00.000000      -1.6000 

         60+74.981871      -1.6000 

         62+38.981871      -8.0000     /* Spiral PS18512B, Curve PS18512 */ 

         71+12.796686      -8.0000     /* Curve PS18512, Spiral PS18512A */ 

         72+76.796686      -1.6000 

         77+50.000000 R 2      -1.6000 

 
The number of created shapes is always one less than the number of specified “filler line stations”. Note 
also that the region is specified for station 77+50. This is only necessary when the region is greater than 
one. Also note that these shapes have been defined as Dependent shapes. 
 
In this instance, 5 shapes are created for the left lane of SR 185. The shapes through the superelevation 
transition into the curve are shown below. The first shape would consist of a constant -1.6% slope from 
station 53+00 to station 60+74.98. The second shape would be a transition shape from -1.6% at station 
60+74.98 to -8.0% at station 62+38.98. 

 
If you wish to override the superelevation values calculated by the GEOPAK Automated Superelevation 
procedure, simply edit the ASCII file to include the desired filler line station / slope values. 
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The next auto shape set defines the shapes for the right side of the roadway. Note that this shape set 
has been defined as Independent shapes. The improper identification of shape cluster elements or the 
improper classification of shapes as dependent or independent will result in incorrect proposed cross 
sections. 
 

   auto shape set 

      shape cluster baseline   = CLPS185 

      shape cluster profile    = PS185P 

      shape cluster tie        = 0.0000 

      independent shape 

      chain  /  offset 

         CLPS185    0.0000 

         CLPS185    12.0000 

      filler line station / slope 

         53+00.000000      -1.6000 

         59+92.981871      -1.6000 

         62+38.981871      8.0000     /* Spiral PS18512B, Curve PS18512 */ 

         71+12.796686      8.0000     /* Curve PS18512, Spiral PS18512A */ 

         74+51.270000 R 2      -1.6000 

         77+50.000000 R 2      -1.6000 

 
The next grouping of lines represents the plot parameters for the shapes and associated text. 
 

   Plot Parameters 

      Dependent Shape 

         lvname = GK_Shapes 

         co = 40 

         lc = ByLevel 

         wt = ByLevel 

      Dependent Text 

      lvname = GK_Shapes 

      co = 40 

   Independent Shape 

      lvname = GK_Shapes 

      co = 87 

      lc = ByLevel 

      wt = ByLevel 

   Independent Text 

      lvname = GK_Shapes 

      co = 87 

 
The different parameters specified for dependent and independent shapes will be used by the software 
for the complex shape elements as well as the area fill. Parameters which can be specified include level, 
weight, line code, and color. Text parameters also include level, weight, line code, and color. Note that 
font, justification and text size are not user-definable as they are determined by GEOPAK. The text 
parameters are for the slope labels at each end of the shape. 
 
NOTE: By default, the color for the text is set to the same value as the shape in the Autoshape input file. 
If you have your MicroStation View Attributes set with “Fill” toggled on, the text will not be visible since 
it is the same color as the shape. Changing the text color to something other than the shape color will 
allow the text to be seen. 
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The last line of the ASCII Autoshape file dictates to the software the name of the MicroStation design file 
where the shapes are to be drawn. This graphical file will serve as input when generating proposed cross 
sections. Note: It is necessary to designate the path for the design file (either by a full path or a relative 
path) if the file is not located in the Working Directory. 
 

Write shapes into dgn = C:\GPKclass\DAR\12345\roadway\basemaps\12345KS001.dgn 
 
Shapes are typically drawn in a separate design file containing only the shape elements. The shapes for 
each alignment of your project are typically drawn in the same design file. This file must be created 
before running the Autoshape input file. See the ODOT CADD Engineering Standards Manual for 
information on standard design file names. Use the ODOT application ODOT_Files.exe to create design 
files using file names according to ODOT Standards.  

4.9.5 Autoshaping and Shifts 

Autoshape sets cannot cross over a shift. Each Autoshape set represents a continuous pavement surface 
offset from a PGL. A shift on the PGL within an Autoshape set will cause the road surface to move with 
the shift, creating an abnormal pavement surface shape. The cross-hatched area in the figure below is 
an example of a shift area. 
 

 
For proposed cross section processing, two options are available to define the pavement cross slope in a 
shift area: 
 

 If no shape is present, the additional widening can be automatically drawn at the same cross slope 
as the adjacent pavement lane by use of ODOT’s pavement criteria. Criteria will be discussed in 
Chapter 5. 

 

 Or, a shape can be generated using the Shape Maker tool (see Section 4.12) 
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4.10  Design Exceptions 

Two COGO commands are supported which enable the user to force particular superelevation 
parameters to a specified curve or spiral. These commands are typically used for special design 
situations where a curve or spiral requires a specific rate of superelevation: (1) Where a curve or spiral 
requires a specific rate of superelevation different from that normally calculated from the design speed 
and alignment geometry, or (2) a design speed different than the project design speed is to be used to 
compute the superelevation. 
 
Store Rate of Superelevation 
 
 Formats: A) S CUR name S rate_of_super 
   B) S SPI name S rate_of_super 
 
These key-in commands store a rate of superelevation with the specified curve or spiral. This command 
is typically used for special design situations where a curve or spiral requires a specific rate of 
superelevation different from the rate of superelevation normally calculated from the design speed. The 
curve or spiral name must be defined in the alignment chain and the rate_of_super is expressed in 
decimal values. If a Print Chain, Print Curve or Print Spiral command is issued subsequent to the store 
rate of superelevation command, an additional line is added within the display to include the revised 
rate of superelevation. 
 
 Examples: 
  S CUR PS18501 S 0.06 
  S SPI PS18501A S 0.05 
 
To remove the specific rate of superelevation stored with a particular curve or spiral, store a 
rate_of_super = 0. 
 
Store Design Speed Command 
 
 Formats: A) S CUR name V design_speed 
   B) S SPI name V design_speed 
 
These key-in commands store a design speed with the specified curve or spiral. This command typically 
is applied to design circumstances where the design speed for a curve or spiral deviates from the 
specified design speed. There must be a corresponding design speed within the active superelevation 
table on each application of this command. 
 
 Examples: 
  S CUR PS18501 V 50 
  S SPI PS18501B V 40 
 
To remove the design speed stored with a particular curve or spiral, store a design speed of 0. 
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The COGO e and V values can also be assigned or modified using the COGO Navigator as shown below. 
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4.11  Processing the Autoshape Input File 

Previously generated superelevation Autoshape input files are processed using the GEOPAK Autoshape 
Builder dialog box. 

 
Use the Select Autoshape Input File button to browse the directory structure to select the desired 
superelevation shape input file, or manually type in the name of the file. 
 
Toggle on the Override Input File Level Symbology option to gain access to the two symbology settings 
for Dependent Shapes and Independent Shapes. Double click on the Symbology box to set new values 
for the level symbology of the shapes. 
 
Select the Draw Superelevation Shapes button to initiate drawing the shapes. The shapes are drawn in 
the design file specified within the input file. The Pavement Shapes are drawn into the MicroStation 
design file specified in the input file. If Display Only is checked, the shapes are displayed but not written 
to the design file. 
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4.12  Shape Maker 

The Shape Maker tool permits graphical and interactive creation of superelevation shapes. Interactive 
shape creation is typically required only for those areas where the longitudinal edges of the shapes have 
not been stored as GEOPAK chains or offset chains. The right-turn bay shown below is an example of a 
shape that is typically created from the Shape Maker dialog. One side of this shape is a curve element 
creating the right-turn lane. Since the taper element is not concentric to the baseline and since a 
GEOPAK chain was never created for this transition geometry, Autoshape is unable to create the shape. 

 
The Shape Maker dialog is invoked by selecting the Shape Maker icon from the Superelevation Shape 
Manager Tools palette shown below, or by selecting Superelevation Shapes from the GEOPAK Project 
Manager dialog. 

 
The Superelevation Shape Maker dialog is shown on the following page. 
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The dialog is divided into three groups: 
  
 1) Shape Parameters 
 2) Filler Lines 
 3) Complete Shape 
 
Before creating shapes, certain data must be provided in the Shape Parameters group box. The 
Baseline, Profile, Tie/PGL Chain, Class, Transition ID and Symbology must be defined. 
 
Once the parameters are set, Filler Lines must be defined for each shape. Filler lines must be drawn at 
superelevation transition break locations and are created by one of three methods listed on the Filler 
Lines group box. 
 
The shape can be created by either one of three methods: 
 

 Automatic 

 Semi-automatic 

 Manual 
 
The shape creation method is defined at the bottom of the dialog box. The Draw button becomes 
available once the minimum number of required filler lines has been defined. Press the Draw button to 
create the shape. 
 
The various parameters of the Superelevation Shape Maker dialog are described on the following pages. 
 

Baseline 
Select the COGO chain defining the horizontal geometry for which superelevation transitions are 
to be calculated. 
 
Profile 
Select the COGO profile that will be used for the shape cluster. 
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Tie 
If the horizontal distance between the Profile location (PGL) and the Baseline Chain is a constant 
value, key in the value in the Offset field. In the example below, the PGL is at the centerline so 
type in an offset of 0. 
 
PGL Chain 
If the horizontal distance between the Profile location (PGL) and the Baseline Chain is a varying 
distance, then a chain must be defined in COGO designating the PGL location. In this case, select 
the name of the chain to be used in the PGL Chain field. An example of where this option would 
be used is a divided facility where the PGL follows the inside edge of pavement and the median 
width is transitioning. If the median width is constant, use the Tie option. 
 
Class 
The Class option is used to set the shape as either Dependent or Independent. 
 
Transition ID 
The software can compute either linear or parabolic transitions. ODOT uses linear transitions. 
For linear transitions, set the Transition ID = 0. 
 
Symbology 
To review the current level symbology settings for the shape, float the cursor over the 
Symbology item as shown below. Double-click the Symbology item to set the values. 

 
Slope Label 
To set the desired symbology for the slope labels which are placed at the filler line locations of 
the shape, double click on the Slope Label graphic to change the settings. 
 
Identify Shape  
To use the parameters of a previously placed shape, take the following steps: 
 

 Click Identify Shape. 

 Identify and accept a previously defined shape with a data point. 
 
The Baseline, Profile, PGL Chain, Trans ID, and Tie parameters associated with the shape are 
displayed on the Superelevation Shape Maker dialog and become active parameters. 
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Filler Line Group Box 
The Filler Line group box is used to define superelevation transition locations. At least one filler 
line must be defined for a non-transition shape. Transition shapes require two filler lines. The 
fields in the group box are detailed below. 
  
Transition 
A non-transition shape represents a pavement area of constant slope. By contrast, the transition 
shape represents a change in the roadway pavement cross slope from one end of the shape to 
the other end. When the toggle is turned off, a non-transitional shape is drawn. When toggled 
on, a transitional shape is drawn. 
 
Slope 
Cross slope of the shape in percent format. The behavior of the Slope key-in field varies 
according to the setting of the Transition toggle. If the Transition toggle is turned on, the Slope 
key-in field will clear after each filler line creation. The Slope field will not clear the keyed in 
value when the Transition toggle is turned off. 
 
 
Method 
Three methods are supported for identifying filler lines. Two different methods may be used for 
the same shape. 

 
To create a Filler Line By DP: 
 

o Activate the Transition toggle (if desired) and enter the Slope 
o Click DP 
o Select a Data Point for one end point of the filler line 
o Select a Data Point for the other end point of the filler line 

  
To create a Filler Line By Line 
 

o Activate the Transition toggle (if desired) and enter the Slope 
o Press the ID Line button, then select and accept a line representing the filler line. The 

length of the line once selected will visually appear exaggerated in both directions 
although the actual selected element in the active or reference MicroStation file is not 
modified. 
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To create a Filler Line By Station: 
 

o Key in the Station value into the key-in field. The Station is applied to the GEOPAK chain 
listed in the Baseline field in the Parameters group box. In lieu of typing, the Station 
may be defined graphically by pressing the DP button and identifying a point on the 
screen. The point is projected back onto the chain and the computed station is displayed 
in the Station field. 

o Activate the Transition toggle (if desired) and enter the Slope. 
o Press the Create button. The software draws a line, extending 500 feet in either 

direction, radial to the Baseline chain at the specified station. 
 

Note that a region can be optionally specified. Regions denote the presence of station 
equation(s) and are necessary only when the station value is not unique in the chain and the 
station is located in a region other than region one. For example, 11+00 r 3 specifies station 
11+00 in region 3. 

  
 

Create 
Action button which creates the specified filler line. 
  
Delete 
Pressing this button causes the most recently defined filler line to be visually removed and 
eliminated from further consideration. If two filler lines were defined, pressing the Delete push 
button twice eliminates both filler line definitions. Note this button appears only after a filler 
line is identified. 

 
Complete Shape 
The bottom line of the Superelevation Shape Maker dialog controls the actual creation of the shape. 
Three methods are available to compose the shape: 

 
No one method will be used exclusively. Each method is suitable to specific design circumstances. In 
order to promote the efficient creation of shapes and in order to ensure the integrity of the data serving 
as input to the proposed cross section generation software, several general rules are listed on the 
following page. 
 

 Do not specify a series of MicroStation elements that can form more than a single closed path 
when using the Manual method. If the Automatic method is used, the software will find the 
smallest closed shape if there is more than one choice. The Semi-Automatic method will prompt 
for the correct path allowing the user to determine the shape. 

 

 Be sure that no cross section will cut across more than a single Dependent shape belonging to 
the same shape cluster. 
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 Be careful to properly distinguish between longitudinal edges and filler lines. Filler lines have 
specific slopes stored as attribute data. Therefore, improper identification of longitudinal edges 
and filler lines will result in incorrect proposed sections. When using the Automatic and Semi-
Automatic methods, be sure to define all filler lines before selecting the Draw button. 

 

 The PGL associated with a shape cluster should not be interior to Dependent shapes. The shapes 
should be constructed such that the PGL is coincident with the edge of the Dependent shapes or 
lie exterior to the Dependent shapes. 

 

 Care should be taken to properly specify Baseline, Profile, and either the Tie or PGL Chain fields 
in the Parameters group box. Shapes with incorrect parameters will result in incorrect proposed 
cross sections. 

 
Manual Mode 
The Manual mode applies to design situations where longitudinal elements forming the sides of shapes 
can overlap and intersect. With this method, it is not mandatory that every longitudinal element 
connect with every other longitudinal element at end points. The Shape Maker algorithm will 
compensate for such element discontinuities and draw the correct shape. 
 
Semi Automatic Mode 
In some cases where the Automatic mode is not the best option, the Semi-Automatic method may be 
used. In this case, the user selects the first element to belong to the shape, rather than a data point 
inside the shape as with the Automatic method. 
 
Automatic Mode 
Automatic mode is the easiest way to create shapes with the Superelevation Shape Maker dialog. The 
Automatic mode is, however, not applicable to all circumstances. For example, areas where there are 
numerous lines which could form longitudinal elements may be more efficiently done with the Semi-
Automatic mode where the user can distinguish the correct elements defining the shape. 
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Creating the Shape 

The following example illustrates a complete sequence of operations necessary to create a shape with 
the Automatic mode. 
 

1. To create a shape for the entire right-turn lane, it will be necessary to define the longitudinal 
edges of the shape. Place the graphics as shown below to form the longitudinal elements of the 
shape to be made. 

 
2. Adjust the parameters on the Shape Parameters group box as shown below. Set the shape Class 

to Independent. 

 
Set the Level to GK_Shapes for the shape Symbology and the Slope Label. 

 
3. Set the Filler Line settings as shown below. In this example, the filler line will be created at a 

specific station and will be a superelevation transition line. Hence the Job No. and Station values 
must be keyed in. Press the Create push button to draw the filler line. Once the Create button 
has been pressed, the filler line will be drawn at the specified station. 
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4. The second filler line will also be created at a specific station and it also will be the other end of 
the superelevation transition. Set the Filler Line settings as shown below. Once the Filler Lines 
group box settings are satisfactory, press the Create button. Once the Create button has been 
pressed, the filler line will be drawn at the specified station. 

 
5. Set the option mode to Automatic in the bottom line of the dialog. With the filler lines in place, 

press the Draw button in the lower right-hand corner of the Superelevation Shape Maker dialog. 

 
6. The user is prompted to place a data point INSIDE the shape to be created. The software will 

then seek out the smallest shape which includes the data point. As the software is searching for 
the correct path, it will draw a circle with the radius value shown in the dialog above at each 
vertex of the shape. These will be automatically removed when the shape is completed. 

 
The completed shape shown above is for the transition portion of the right-turn only lane. All the shapes 
for the turn lane will be placed in Exercise 4. 
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4.13   Shape Analyst 

The Shape Analyst tool is used to display slope and elevation information on any point within a GEOPAK 
superelevation shape. The information is displayed within the GEOPAK Shape Analyst dialog and can 
also be written to the MicroStation design file. 
 
The dialog is accessed by selecting the Shape Analyst icon from the Superelevation Shape Manager 
Tools palette as shown below. 

 
Before using the Shape Analyst, it is advisable to check the user preferences. To access the User 
Preferences dialog, select User > Preferences from the upper left corner of the GEOPAK Shape Analyst 
dialog. These preferences are used to control which information will be drawn into the MicroStation 
design file, and how it is displayed. The preferences can also be used to toggle on/off the ability to store 
3D COGO points in the GPK file. The GEOPAK on-line help provides a complete description of the Shape 
Analyst User Preferences dialog. 
 
While most of the GEOPAK Shape Analyst dialog is display information, some user input is required as 
detailed below. 
 
Job 
Specify the Job number for the COGO database where the chains and profiles are stored for the shapes. 
 
Display Only 
When active, a flow arrow and elevation text are displayed on screen but not written to the file. When 
inactive, all text and graphics are placed in the file. 
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Cross Section 
When the toggle is not activated and a data point is issued within a shape, the elevation of the data 
point and a flow arrow are displayed as shown below. 

  
When the toggle is activated, a line is placed through the data point, perpendicular to the shape cluster 
baseline. In addition to the elevation and flow arrow placed at the data point, elevations and cross 
slopes are displayed where the cross section line intersects any superelevation shape. 

 
Several fields are required in order to compute the shape information and are detailed below. 
 

Chain 
Shape cluster baseline used to create the shape. The chain is selected from the list of all chains 
stored in the current coordinate geometry database. 
 
Profile 
Shape cluster profile. This is a display only field, populated by GEOPAK when the data point is 
defined and the intersecting shapes are determined. 
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Station / Offset 
When the DP or Dynamic option is selected, GEOPAK automatically populates these fields by 
projecting the data point onto the specified chain, and calculating the station and corresponding 
offset. 
 
When the By Sta/Offset option is selected, the station and the offset values in the key-in fields 
are projected back onto the shape cluster baseline. The station and offset fields must be 
manually entered. 
 

Three options are supported to define the desired point as detailed below. The buttons are located at 
the bottom of the dialog. 
 

By Sta/Offset 
The Station and Offset values shown in the key-in fields are projected back to the shape cluster 
baseline and the elevation of the projected point is displayed. If the user keys in an Offset value 
that is outside the limits of the shape, GEOPAK will extend the cross slope of the nearest shape 
to calculate the elevation. 
 
DP 
Select the DP button and then issue a data point in the design file. The data point is projected to 
the baseline Chain to compute the Station, Offset, and associated output information. After the 
DP button is pressed, numerous data points can be entered without pressing the DP button 
again. Each corresponding Station and Offset is displayed along with the associated output 
information. If the data point is outside the limits of the shape, GEOPAK will extend the cross 
slope of the nearest shape to calculate the elevation. 
 
Dynamic 
This button activates the dynamic mode. As the cursor is moved across the design file, any 
momentary pause places the elevation and flow arrow in the MicroStation file and computes 
and displays the analysis information. If the cursor is outside the limits of the shape, GEOPAK 
will extend the cross slope of the nearest shape to calculate the elevation. 

 
The right side of the Elevation Information section of the dialog contains the output information. This 
information is display only and cannot be written to an output file. A brief description of these display 
fields follows below: 
 

Elevation 
The elevation at the data point, dynamic point, or by Sta/Offset point location. 
 
PGL Elevation 
The elevation of the point, projected onto the PGL. 
 
PGL Slope 
The slope of the PGL at the projected point. 
 
 
 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
Chapter 4 – Superelevation Page 4-41 
 

Cross Slope 
Slope from PGL to the data point. This is along the projection from the PGL to the data point. 
When the data point is outside the shape, this field is blank. 
 
Longitudinal Slope 
The longitudinal slope at the data point, not the PGL. In areas of non-transition, this is identical 
to the PGL slope. However, in transition areas, the transition affects the slope, therefore it is not 
identical to the PGL slope. When the data point is outside the shape, this field is blank. 
 
Flow Slope 
Vector sum of the Cross Slope and Longitudinal Slope, indicating the actual slope at the point. 
This is useful as a water flow indicator. When the data point is outside the shape, this field is 
blank. 
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4.14   Shape Profiler 

The Shape Profiler tool provides elevations incrementally along the superelevation shapes, or the shape 
slope can be projected to provide elevations along a user specified MicroStation element. Select Shape 
Profiler from the Superelevation Shape Manager Tools palette to access the GEOPAK Shape Profiler 
dialog shown below. 

 
Before using the Shape Profiler, it is advisable to check the user preferences. To access the User 
Preferences dialog, select User > Preferences from the upper left corner of the GEOPAK Shape Profiler 
dialog. These preferences are used to control which information will be drawn into the MicroStation 
design file, and how it is displayed. The preferences can also be used to toggle on/off the ability to store 
3D COGO points in the GPK file. The GEOPAK on-line help provides a complete description of the shape 
User Preferences dialog. 
 
The fields at the top of the Shape Profiler dialog are detailed below.  
 

Job 
Specify the Job number for the COGO database where the chains and profiles are stored for the 
shapes. 
 
Display Only 
When active, a flow arrow and elevation text are displayed on screen but not written to the file. 
When inactive, all text and graphics are placed in the file. 
 
Graphic Grade 
Currently the only option supported. The elevations are drawn graphically in the design file. 

 
The next group of fields relates to the superelevation shape. The fields are detailed below. 
 

Chain 
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Shape cluster baseline used to create the shape. The chain is selected from the list of all chains 
stored in the current coordinate geometry database. 
 
Identify Shape 
Press the button, then select and accept the shape to be used for the grade computations. 
 
From/To Station 
After the shape has been selected, GEOPAK populates the From and To Station fields with the 
stations of the filler lines or ends of the shape. If the graphic grade is not needed for the entire 
shape, the DP buttons may be used to define the desired station range. Press the DP button, 
and then identify a data point. The station is automatically adjusted to reflect the data point. 
Users may also key in the desired stations. 

 
Three options are supported to define the distance between the graphic grade points. They are detailed 
below. 
 

Even 
The Even option is used to compute Graphic Grade points at the increment keyed in by the user 
at every station that is evenly divisible by this value. Note: If the From Station is not evenly 
divisible by the keyed in value, the first Graphic Grade point will be the first even station 
divisible by the keyed in value greater than the From Station value. 
 
Increment 
The Increment option operates identically to the Even option with the exception that the 
Graphic Grade points are computed incrementally along the chain starting from the From 
Station.  
 
Intersect 
The Intersect option is used to create Graphic Grade points at every location where a user 
selected MicroStation element intersects the edges of the pavement shapes. When Intersect is 
selected, the Elevation Along option (described below) can only be toggled to Element. 
Elevation Along  
The Elevation Along option has two options: Shape or Element. Each option is described below. 

 
Elevation Along Shape 
Press the Identify Element button at the bottom of the dialog. Once the Shape has been 
identified, the elevations and flow arrows are drawn along each longitudinal edge of the shape 
at the specified interval from the filler lines as shown in the example below. 
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Elevation Along Element 
Press the Identify Element button at the bottom of the dialog. Then select and accept any 
MicroStation Element, i.e., line, line string, curve, curve string, or complex chain. GEOPAK 
calculates the elevations along the selected element. One sample is shown below. The identified 
element can be within, or outside the limits of the selected shape. Any elevations outside the 
shape are calculated by projecting from the edge of the shape at the superelevation slope.  

 
 
Another option within the Elevation Along Element option is Continuous Extrapolation. Activate the 
Continuous Extrapolation option, and then press Identify Element. Once first the element is selected 
and accepted (the edge of pavement in the example below), a supplemental dialog is displayed, as 
shown below. 
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The general workflow is as follows: 
 

 From the main dialog, toggle on Continuous Extrapolation. 
 

 Click Identify Element and ID an element along the edge of the shape where elevations at the 
requested interval are desired 

 

 At this point the Extrapolate To Next Element dialog pops up. 

 
There are two modes, Non-Transitional Extrapolation and Transitional Extrapolation. Setting the option 
to either Transitional or Non-transitional extrapolation determines the fields in the rest of the dialog as 
shown on the following page. 
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In the Transitional Extrapolation, the From Slope and To Slope must be specified in the input fields. The 
location where each slope is to be applied is defined graphically via the DP buttons. Then press the ID 
Next Element button and identify the element to which the slope is projected. If the Complex Chain 
toggle is active, the user may select a string of elements. If the toggle is not active, the user may select 
only a single element. 
 
Three options, Radial to Baseline, Radial from Element, Radial to Element, are presented to continue 
extrapolation to the next element at the specified slope. If you want to continue extrapolating 
elevations to another element, first key in the Fixed Slope. Next select one of the three options 
controlling how the elevations are extrapolated. Finally pick the ID Next Element button and select the 
desired element. An example is shown below. 
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4.15   Shape Editor 

The Shape Editor tool enables the user to dynamically change parameters of a previously created shape. 
This includes changing the station limits which dynamically moves and updates the selected shape and 
the shape adjacent to the one being edited. The user also has the option to change the cross slope if 
desired. When the Shape Editor tool is selected, the dialog shown below is opened. 

 
Job 
Specify the Job number for the COGO database where the chains and profiles are stored for the shapes. 
 
Tolerance 
The Tolerance field is used to specify the acceptable gap size, in Master Units, between elements 
forming the shapes. 
 
Identify Shape 
Press the Identify Shape button then select and accept a previously drawn superelevation shape. Once 
accepted, GEOPAK populates the From and To group boxes with the data of the selected shape. 
 
From/To 
To modify the Station, you can simply key-in the new station value, use the DP button to graphically 
identify the station, or use the Dynamic button to graphically select the station. The DP and Dynamic 
options will both project the selected data point back to the baseline to determine the station. The 
Dynamic button differs in that it will show a dashed line from the cursor to the base line and also 
dynamically change the station in the dialog as you move the cursor. 
 
% Slope 
The cross slope of a shape can be edited by use of the % Slope option. Users can key-in the desired 
slope, in percent format, or use the Match Shape button to set the shape slope to match an adjacent 
shape. 
 
Apply 
After editing the dialog fields to the desired parameters, pressing the Apply button will edit the shapes. 
The adjacent shapes are also changed to reflect changes in the Station or the % Slope as necessary. 
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4.16   Shape Selector 

The Shape Selector tool is used to highlight or select shapes based on a wide range of user queries. 

 
Job 
Specify the Job number for the COGO database where the chains and profiles are stored for the shapes. 
 
Process 
Two options are supported for Process: View or Fence. If View is selected, all shapes in the current view 
that match the Filter option are highlighted or selected. If Fence is selected, a MicroStation fence must 
be placed prior to pressing the Hilite or Select button. 
 
Filter 
A variety of filters are supported, as shown at right. The filters are used to 
determine which shapes are to be hilighted or selected. Depending on the 
selected Filter option, the following operands are available: 
 
    > Greater than 
    < Less than 
    >= Greater than or equal to 
    <= Less than or equal to 
    = Equal 
    != No equal 
 
After selecting the Filter, the field to the far right will change to reflect options appropriate for the 
selected filter option. 
 
Hilite 
When the Hilite button is pressed, all shapes fulfilling the query are highlighted in the MicroStation 
highlight color. 
 
Select 
When the Select button is pressed, the shapes are added to a MicroStation selection set. 
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4.17  Shape Properties 

The Shape Properties tool provides information on any GEOPAK superelevation shape. In addition, this 
shape information can be modified for individual shapes or selections of shapes. When the Shape 
Properties tool is selected, the dialog below opens. 

 
Job 
Specify the Job number for the COGO database where the chains and profiles are stored for the 
shapes. 
 

The Shape Parameters group box contains numerous shape options. To use an option, activate the 
toggle to the left of the parameter. If the Set option is used, the value must be entered prior to pressing 
the Set button. If the ID feature is chosen, the fields are populated automatically when a shape is 
selected. 
 

Baseline 
Shape cluster baseline used to create the shape. 
 
Profile  
Shape cluster profile used to create the shape. 
 
PGL Chain 
PGL Chain used to create the shape. If no PGL chain was specified when the shape was created, 
this option will read “None”. 
 
Transition ID 
For ODOT roadway design, set this option to 0 for a linear transition. 
 
Tie 
The offset distance from the PGL baseline to the shape. 
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Class 
Class used to create the shape, either Dependent or Independent 
 
From Slope 
The cross slope (in percent) at the lowest station value of the shape. 
 
To Slope 
The cross slope (in percent) at the highest station value of the shape. 

 
Three action buttons are supported at the bottom of the dialog and are described below. 
 

ID 
To populate the Shape Properties dialog with the attributes of a particular shape, press the ID 
button, and then select and accept a GEOPAK superelevation shape. GEOPAK populates every 
field where a toggle is activated. 
 
Set 
To set the parameters for a particular GEOPAK superelevation shape, activate the desired 
parameters and populate the associated fields with the desired values. Then press the Set 
button, select and accept the superelevation shape to be changed. 
 
Set Entire Selection 
If multiple shapes need to be changed, activate the desired parameters and values, define a 
MicroStation selection set to include the shapes to be changed, then press the Set Entire 
Selection button. Note that the selection set and populating the dialog can be done in either 
order as long as both steps are complete before pressing the Set Entire Selection button. 

 
TIP: You can use the GEOPAK Shape Selector tool (see Section 4.16) to select the shapes that you wish 
to edit using the Shape Properties dialog. For example, let’s assume a group of shapes were created 
using a Profile named PS185P. A design change causes you to create a new profile named A1PS185P. 
Using the Shape Selector, you could select all of the shapes created with Profile = PS185P. Using the 
Shape Properties tool, you can toggle on the Profile option and set its value to A1PS185P. Press the Set 
Entire Selection button to change the selected shapes to use the new profile. 
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4.18   Shape to DTM Surface 

The Shape to DTM tool is reads GEOPAK superelevation shapes and creates a DAT file suitable for use in 
the Build Triangles tool in the DTM tool frame.  

 
Job 
Specify the Job number for the COGO database where the chains and profiles for the shapes are stored. 
  
Chain 
Chain associated with the superelevation shape, i.e., the shape cluster baseline defined when the shape 
was created. 
  
From Station 
Lower stationing to be used as the limits of the DAT file. Enter the station value or click DP and 
graphically select. 
  
To Station 
Upper stationing to be used as the limits of the DAT file. Enter the station value or click DP and 
graphically select. 
  
Increment / Even 
The interval of points to be used for the data file. When Increment is chosen, the value is added to the 
From Station iteratively until the To Station is reached. When Even is chosen, the points are taken at 
even values within the station range. For example, if the To Station is 10+10 and the value is 25, 
Increment values are 10+10, 10+35, 10+60, etc., while Even values would be 10+25, 10+50, 10+75, etc. 
  
Plot Text Elevation 
When turned on, text is placed at each point to be included within the data file. Double click the text box 
to set the symbology for the text. 
 
 Data File 
Name of the data file to be created or appended. 
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Mode 
The file can be created or a previously created file can be used, in which case, the data created in this 
procedure is appended to the original data. 
  
Decimal 
Number of decimal places to be used when creating the Data file. 
  
Apply 
Commence processing. 
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4.19  Working Alignment Definition: Shapes 

The Shapes category of the Working Alignment contains two options to specify the shapes, as described 
below. 

 
By Search Criteria 
When using the By Search Criteria option, the user specifies the element symbology of the 
desired shapes.  
 
All In DGN 
When the All In DGN option is selected, all shapes within the specified DGN file are used. 
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4.20   Pavement Shapes and Intersection Areas 

GEOPAK pavement shapes are an effective tool to define the pavement cross slopes and superelevation 
transitions, however the radius return areas are not easily defined using shapes. GEOPAK Site can be 
used to design the profiles for the radius returns and to complete the design of the intersection area. 
The use of GEOPAK Site is beyond the scope of this training guide. A brief overview of the process is 
provided below. 
 

 Define the pavement shapes such that the through lanes of the main alignment carry through 
the intersection area. Pavement shapes for turn lanes and for side roads are best stopped at the 
radius returns, but experimentation with different stopping points for turn lanes and side roads 
may yield desirable results depending on the intersection conditions. 

 The GEOPAK Shape to DTM Surface tool can be used to export the shape information into a DAT 
file that can be imported into GEOPAK Site. 

 Import the DAT file into GEOPAK Site as a Roadway object. Add the following Elements to the 
GEOPAK Site object: 

o Add each Radius Return as a Boundary element. 
o Add an Element for the side road centerline by using option to import a COGO Chain 

and Profile into the Site Object.  

 Use the Site Modeler Elements > Edit Profile tool to design the profiles for each radius return. 

 Depending on the intersection conditions, it may be desirable to import a Break Line Element for 
the edge of the traveled lane along the side road up to the intersection with the mainline shapes 
and define a profile along these locations. 

 
Some experimentation with GEOPAK Site is necessary to yield the best results. An example of the 
contours generated by GEOPAK site for the S.R. 185 and Jameson Road intersection area is shown 
below. In this example, defining the profile elevations along the radius returns was sufficient to produce 
acceptable results. 
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Exercise 4 

Create a new design file for the superelevation shapes using the ODOT_Files application. 
 

What is the name of the design file? 
 

Which sub-directory is the file created in? 
  
Using this section as a guide, generate the superelevation shapes for S.R. 185. Name the Autoshape 
input file “SR185_Super.inp”. Use the following settings in the GEOPAK Automated Superelevation 
dialog: 
 

Job: 185 

Design Speed: 55 

Preference File: ODOT2006_Undivided 

e Selection: 8.0% eMax 202-7E 

Chain: CLPS185 

Begin: 53+00 

End: 77+50 R 2 

Facility: Undivided 

L Selection: All cases 

Profile: PS185P 

 
For the Left and Right portions of the Automated Superelevation dialog, enter the lane configuration for 
2-12’ lanes using a normal crown slope of -1.6%. Be sure to set one shape as Dependent, and the other 
as Independent. 
 
Using this section as a guide, generate the shapes for the right turn lane as described below using the 
Shape Maker tool. 
 

Shape 
Area 

Station 
From 

Station 
To 

Filler Line 
Station 

Filler Line 
Type 

Slope 
(%) 

1 63+50 64+30 64+30 Non-
Transition 

8.0 

2 64+30 65+35 (1) 64+30 
(2) 65+35 

(1) Transition 
(2) Transition 

(1) 8.0 
(2) 3.0 

3 65+35 66+11.32 65+35 Non-
Transition 

3.0 

 
Update the Working Alignment Definition for S.R. 185 to include the shape information. 
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Optional Exercise: Jameson Road Shapes 

Set the active Working Alignment to Jameson Road. Using this section as a guide, create the 
superelevation Autoshape input file for Jameson Road. Name the input file shape_jam.inp. Use the 
following design parameters for Jameson Road: 
 

Job: 185 

Design Speed: 25 

Preference File: ODOT2006_Undivided 

e Selection: 4% eMax 202-9E 

Chain: CLPSJAM 

Begin: 12+50 

End: 15+85.30 

Facility: Undivided 

L Selection: All cases 

Profile: PJAMEP 

 
For the Left and Right portions of the Automated Superelevation dialog, enter the lane configuration for 
2-12’ lanes using a normal crown slope of -1.6%. Be sure to set one shape as Dependent, and the other 
as Independent. 
 
Using the Preference File ODOT2006_Undivided.sep with an e Selection value of 4% eMax 202-9E, no 
superelevation is required for Jameson Road. 
 
Use the Shape Maker tool to create the shapes for the taper areas at the beginning of proposed 
Jameson Road as described below. 
 

Shape 
Area 

Side Station 
From 

Station 
To 

Shape Type Filler Line Type Slope (%) 

1 Left 12+00 12+50 Dependent Non-Transition -1.6 

2 Right 12+00 12+50 Independent Non-Transition -1.6 

 
Update the Working Alignment Definition for Jameson Road to include the shape information. 
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The completed shapes for Jameson Road and S.R. 185 should appear similar to the shapes shown in the 
example below (the colors may vary). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page 4-58 Chapter 4 – Superelevation 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

This page intentionally left blank



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
Chapter 5 – Proposed Cross Sections Page 5-1 
 

5 Proposed Cross Sections 

5.1 Overview 

GEOPAK provides two methods for generating proposed cross sections as summarized below: 

Corridor Modeling with Roadway Designer 

Roadway Designer uses a template based approach to build a proposed surface. The processing and 
editing is accomplished entirely in Roadway Designer and the completed cross sections are exported 
from the design surface. Roadway Designer is advantageous for projects scoped to include a proposed 
3D surface as part of the electronic deliverables. The use of Roadway Designer is not covered in this 
training guide. 

Cross Section Criteria Files 

Criteria files can be used to draw the proposed roadway on the existing cross sections. Criteria files are 
written using a simple programming language similar to Basic. Criteria files have the capability to 
evaluate conditions using If-Then conditional expressions. Depending on the results of the conditions, 
the software can draw different features. 
 
Which option is used depends on the scope of the project. This training guide will cover the procedure 
to generate cross sections processing Criteria files. 
 

5.2 Criteria Files 

A criteria file is a program, written in a simple programming language similar to Basic. Criteria files, and 
the supporting documentation, are located in the following ODOT Standards folder: 
 

I:\ODOTstd\V8istd\Geopak\Road\criteria 
 
Each criteria file is used to draw an individual portion of the cross section. For example, the file PAVT.X 
is used to draw the proposed pavement on the cross sections. Files for shoulders, curb, side slopes, etc… 
are provided. 
 
The ODOT Standard criteria files are provided as a convenience to ODOT’s internal and external 
customers. It may be necessary for users of the criteria files to write or modify the criteria for their 
specific project use. This training guide will not cover writing Criteria files. This guide will focus on the 
procedure to process previously developed Criteria files. 
 
The purpose of Criteria is not to draw all of the cross sections 100% correctly. There will always be cases 
where the user will need to manually edit the cross section graphics to make modifications such as 
changing the flow elevation of a ditch, or modifying a side slope to avoid interference with a utility 
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location. Too often, criteria writers will spend time modifying criteria trying to cover all the cases, when 
it would be more efficient to use criteria to draw 90% of the sections and graphically modify the other 
10% to fit special cases. 
 
The graphics drawn by the Criteria files are simple MicroStation elements. These elements can be 
manually edited by the user as necessary. Graphical modifications must use only lines and line strings, as 
arcs and curves are not recognized by the software for earthwork computations. Care must be taken to 
connect any modified elements, as errors will result from gaps between elements. Modifications made 
to the cross-sections will be reflected in the earthwork quantities. 
 

5.3 Requirements for Processing Proposed Cross Sections 

Before proposed cross sections can be processed, the following design considerations must be defined: 
 

 A COGO Chain representing the horizontal alignment. 
 

 A COGO Profile representing the proposed profile. 
 

 Pattern lines representing the location of the cross sections must be established. (The Pattern 
by Station option can be used in lieu of drawing pattern lines in the design file). 

 
 Plan view graphics representing the proposed roadway. 

 
 Existing ground cross sections. 

 
 Pavement Shapes. (An alternate “Shapeless” mode is also available and will be discussed in 

greater detail in section 5.12-5.14). 
 

 Criteria files. 
 
Each of these components of your proposed design is used to generate the proposed cross sections as 
described in the following sections. 
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5.4 Pavement Shapes 

Pavement shapes are used to define the basic lane width and cross slopes for the proposed roadway. 
When processing proposed cross sections, the first thing GEOPAK does is draw the top of proposed 
pavement using the pavement shapes as a guide. The example below shows the top of the pavement, 
drawn using two pavement shapes defining the left lane and right lane of the proposed pavement. 

 
The COGO profile is used to establish the profile elevation for each cross section. 

5.5 Plan View Graphics 

Criteria files have the capability to use plan view graphics to locate proposed design features (i.e., edge 
of pavement, shoulder, curb) by intersecting the design elements in the base map. 
 
In the example below, two pavement shapes were drawn representing the pavement lanes to the 
immediate left and right of the proposed centerline using the ODOT Standard criteria file PAVT.X. The 
criteria found that the proposed edge of pavement line on the right side is outside the limits of the 
pavement shapes. The additional pavement widening for a right turn lane was automatically drawn by 
the criteria. The width of the turn lane is defined by intersecting the proposed edge of pavement line in 
the plan view design file. 

 
Notice that the pavement in the example above is in a superelevated section. The criteria draws the 
superelevation based on the cross slopes stored with the pavement shapes (see Chapter 4 Pavement 
Shapes). The widening is assumed to maintain the same cross slope as the adjacent pavement shape, 
therefore, if the design required a different pavement cross slope for the right turn lane, another 
pavement shape would have been necessary. 
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5.6 Variables 

In order for ODOT’s standard criteria files to be applicable to a wide variety of projects, variables are 
used to define values that may change from project to project. The use of variables allows the criteria 
files to be generic. There are two variable types that you will need to be aware of in order to process 
standard criteria. 
 
The first variable type is the Substitution String. These are variables that can be used to specify project 
specific information rather than hard coding the values in the criteria itself. For example, one project 
may have a pavement buildup consisting of four pavement layers. Another project may have only three 
pavement layers. In order for the same pavement criteria file to successfully draw the correct number of 
pavement layers for each of these projects, the criteria provides a variable for the user to define the 
number of pavement layers to be drawn. 
 
Another type of variable is the In DGN Variable. These variables allow the user to specify the element 
symbology and the name of the design file containing the plan view graphics that the criteria will use to 
draw a specific feature. For example, if the criteria needs to locate the existing edge of pavement, the 
criteria developer can establish a DGN Variable for the existing edge of pavement. When processing the 
criteria, the user must provide the values for the level, weight, color, and line code as well as the name 
of the design file that contains the plan view graphics. 
 

5.7 Inclusion Sequence 

We previously stated that criteria files are written such that each individual file is responsible for 
drawing only a specific component of the proposed cross section design. This allows the criteria files to 
accommodate a wide variety of design scenarios. For example, a particular project may consist of the 
following components: 
 

 Proposed Pavement 
 

 Shoulder 
 

 Side Slopes 
 
When a criteria run is processed, the user will specify the individual criteria files that will be used to 
draw each component. The order in which these components are specified is significant. Criteria files 
must be included in the order that they will process from the centerline out. In other words, the 
pavement criteria must precede the shoulder criteria which must precede the side slope criteria. Each 
criteria file will start drawing where the previous criteria file ended. 
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5.8 Left Side/Right Side Processing 

Each side of a specific roadway may have different conditions. For example, the left side of our highway 
may have the following design features: 
 

 Proposed Pavement 
 Type 2 Curb 
 Side Slope 

 
While the right side may have the following features: 
 

 Proposed Pavement 
 Type 2 Curb 
 Sidewalk 
 Side Slope 

 
GEOPAK allows for different conditions on each side of the roadway. During the setup of a criteria run, 
criteria files must be independently defined for each side of the roadway. 
 
When you specify the criteria files that are to be included for each side, you have the option to select 
which side will be processed first. ODOT Standard criteria files have been configured to operate by 
processing the left side first. 
 
During processing, each cross section is processed individually. The criteria files specified for the left side 
of each cross section are processed completely before processing on the right side begins. After the left 
and right sides have been processed, the software moves on to the next cross section. 
 
Since criteria processing occurs from the “inside out”, you might think that there will be separate criteria 
files for the left side and the right side. For example, while processing the left side of the roadway, a 
curb will be drawn from the right (inside) to left (outside). When processing the right side, the same 
curb will need to be drawn from the left (inside) to right (outside). GEOPAK allows the same criteria file 
to be used on the left and right sides by identifying the positive X direction as going away from the 
center line and the negative X direction as going towards the center line. The Y direction is the same for 
both sides, positive Y towards increasing elevation, negative Y towards decreasing elevations. The figure 
below illustrates the convention: 
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5.9 ODOT Standard Criteria Library 

ODOT’s library of standard criteria files can be found in the following location: 
 

i:\ODOTstd\V8istd\Geopak\Road\criteria 
 
Each criteria file will have its own list of variables that the user must define according to the design 
conditions for their project. Documentation for each criteria file is crucial in order for the user to 
understand how each individual Criteria file works. This documentation can be found in the following 
location: 
 

i:\ODOTstd\V8istd\Geopak\Road\criteria\Doc 
 
The ODOT Criteria library is provided as a courtesy to the consulting community.  Requests from ODOT 
personnel for new criteria files should be forwarded to the Office of CADD and Mapping Services.  ODOT 
does not specifically write criteria files at the request of external clients or customers. 
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5.10   Criteria Processing Example 

Now that we have an understanding of the basic criteria rules, let’s take a look at processing some of 
ODOT’s standard criteria files. 
 
Select Proposed Cross Sections from the GEOPAK Project Manager, as shown, below to access the Select 
Run dialog shown below. 

 

 
Create a new Run, as shown on the following page, or open an existing run.  
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After creating the run, Select the Run name to access the Proposed Cross Sections dialog shown below. 

 
Selecting an item from the list box on the left of the Proposed Cross Sections dialog box will reveal a 
group of associated parameters on the right side of the dialog. These parameters are described in the 
following sections. 
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5.10.1 XS DGN File 

When XS DGN File is selected, the dialog changes as shown below. 

 
The XS DGN File item is used to identify the MicroStation design file containing the existing ground cross 
sections. If you have set up a Working Alignment Definition using the GEOPAK Project Manager, the XS 
DGN File name is taken from the currently selected Working Alignment and automatically placed in the 
Proposed Cross Section dialog box. 
 
The Tolerance is the distance that each endpoint of the cross section elements must fall within to be 
considered connected. By default, the Tolerance is set to a value of 0.1 Master Units.  
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5.10.2 Pattern 

When Pattern is selected, the dialog changes as shown below. 

 
The Pattern item is used to identify the method that was used to generate the existing ground cross 
sections; By Design File or By Station. Toggling the option to By Station will change the dialog as shown 
below: 
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If the Use Working Alignment Definition toggle is activated, the rest of the dialog is ghosted and the 
pattern definition from the active working alignment is used. If the toggle is not activated, By Design File 
or By Station can be selected. The rest of the dialog is a reflection of this selection. These parameters 
should match exactly with those used to generate the original GEOPAK XS cells and existing ground. 
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5.10.3 Existing Ground 

When Existing Ground is selected, the dialog changes as shown below. 

 
The Existing Ground item is used to identify the design file containing the ground cross sections and 
their symbology. 
 
When the Use Working Alignment Definition toggle is activated, the rest of the dialog is ghosted and 
the existing ground definition from the active Working Alignment is used. If the toggle is not activated, 
the Design File and Search Criteria must be specified to define existing ground.  
 
The Design File option is used to specify the name of the MicroStation design file containing the existing 
ground cross sections. If you do not include the full path for the design file, GEOPAK will use the current 
Working Directory. 
 
The group box for Search Criteria supports options to specify the element symbology of the existing 
ground cross sections. Simply toggle on the desired parameter, and then press the Match button. You 
may select as few or as many parameters to identify the existing ground lines as necessary. 
 
Pressing the Display button displays all existing ground elements matching the current parameters.  
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5.10.4 Shapes 

When Shapes is selected, the dialog changes as shown below. 

 
The Shapes item is used to identify the pavement shapes that will be used for the criteria run. 
 
When the Use Working Alignment Definition toggle is activated, the rest of the dialog is ghosted and 
the shape definition from the active Working Alignment is used. When the Use Working Alignment 
Definition toggle is not active, three options are supported to identify the pavement shapes: All in DGN, 
Shapeless, and By Search Criteria. 
 

All in DGN 
This option will search the specified design file for all shape clusters contained in the file. 
 
By Search Criteria 
Only shapes meeting the specified criteria will be used for processing. 
 
Shapeless 
No pavement shapes are to be used. See Section 5.11 for an example of processing shapeless 
criteria. 
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5.10.5 Shape Clusters 

When Shape Clusters is selected, the dialog changes as shown below. 

 
The Shape Clusters item is used to identify the criteria files that will be included for processing for each 
pavement shape cluster. The dialog is divided into three distinct areas as shown below. 
 
  1. Shape Clusters 
 
  2. Side Slope Conditions 
 
  3. Criteria files 
 
Each portion of the dialog is explained in detail on the following pages. 
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Shape Clusters 

 
The top right portion of the dialog, shown above, is used to identify which shape cluster you wish to use. 
Select the Scan button to activate the List of Clusters dialog box shown below. 

 
This dialog box will contain a list of all the shape clusters meeting the search conditions defined by the 
Shape item described on page 5-12. In the example above, the All In DGN option was used which 
provides a listing of all the shape clusters in the design file. 
 
Select the desired shape cluster from the list box. The values for the Chain, Tie/PGL and Profile are 
carried to the Proposed Cross Sections dialog. Select the Add button to add the shape cluster to the list 
box as shown below. 

 
As an alternative to using the Scan button, you may simply select the Chain name, the Tie value and the 
Profile name in the dialog fields as shown above. 
 
The Modify button is used to modify the information for the selected shape cluster. 
 
The Delete button is used to delete the selected shape cluster from the list. 
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If multiple shape clusters are specified for simultaneous processing, they will process in the order 
specified. The Up and Down buttons are used to change the order that the shape clusters are listed in 
the dialog. 
 
The Typical feature within proposed cross sections was originally developed in order to automate (as 
much as possible) the development of cross sections for widening and resurfacing jobs, but it can also be 
used with new construction. It enables the user to select a typical section from a cell library, and then 
copies associated criteria files into the job directory. In addition, the criteria files are placed within the 
definition of the "side slope lt" and "side slope rt" statements. The results are that the user only has to 
specify the project values for the given variables, then initiate the proposed cross section run. At this 
time, no Typical applications have been developed for ODOT use. 
 
The Thick option can be used to specify the symbology and thickness of each pavement layer to be 
drawn beneath the GEOPAK pavement shapes. Since the pavement layers are drawn by ODOT’s 
standard pavement criteria file PAVT.X, there is no need to use the Thick option. 
 

Side Slope Condition 

The Side Slope Condition portion of the Proposed Cross Sections dialog is used to define the processing 
conditions for the criteria run. 

 
After a Shape Cluster has been selected, the Define button located under the Side Slope Condition 
section of the dialog becomes available as shown above. Select Define to access the Conditions dialog 
shown on the following page. 
 
 
 
 
 
 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
Chapter 5 – Proposed Cross Sections Page 5-17 
 

 
The top of the dialog contains an option button to select the condition for which you wish to define 
criteria. The options are shown below: 

 
The Side Slope LT and Side Slope RT conditions are used to define the criteria files for the Left and Right 
sides of the pavement slopes separately. If the same list of criteria files is to be processed on both the 
Left and Right side of the roadway, the Side Slope LTRT condition may be used. 
 
Important: Always define the criteria for the left side first. The ODOT Criteria files have been designed 
to process starting with the left side first. 
 
The Offset Minus Side Slope LT, RT and Offset Plus Side Slope LT, RT options are no longer used. They 
are only included on the dialog to provide compatibility with old criteria files. 
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Several options are available to limit where the criteria will be applied as shown below.  

 
See the GEOPAK documentation for information about how each of these limiting conditions is applied. 
We’ll take a look at limiting the Station range in the example below. 
 
To limit the Station range that will be processed, take the following steps: 
 

 Toggle on the option to apply a limiting condition. 
  

 Select the Station limiting factor. 
 

 Select the desired relational operator. The options shown below are available: 

 
 Key-in the station value.  Up to five conditions can be defined using the and/or conditional 

operators. An example using two conditions is shown below. 

 
 Select the OK button to add the condition. Once the OK button is selected, the condition is 

added to the Proposed Cross Sections dialog as shown on the following page: 
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The Modify button can be used to modify the station ranges defined for a condition. 
 
The Delete button is used to remove the selected condition from the list. 
 
The Up and Down buttons are used to move the selected side slope condition up or down in the list box. 
 

Criteria Files 

After the Side Slope Conditions are defined, the options on the Process Cross Sections dialog for adding 
criteria files become available. 
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Note: 
The criteria file define.x is 
required as the first criteria 
file included for processing 
in all criteria runs using 
ODOT criteria files. 
 

To add criteria files for the currently selected condition, select the Add button at the bottom of the 
Process Cross Sections dialog. The Criteria dialog shown below is opened. 

 
Use the Select button to specify the directory where the criteria files are located.  
 
ODOT Standard criteria files are located in the following folder: 
 

i:\ODOTstd\V8istd\geopak\road\criteria 
 
To add a criteria file to the Proposed Cross Sections dialog, select the file name from the Criteria list box 
and push the To Criteria button. Continue selecting the required criteria files until you are finished. The 
Done push button is used to dismiss the Criteria dialog box. The selected criteria files are added to the 
Proposed Cross Sections dialog in the order selected, as shown below. 

 
The order in which you specify the criteria files is significant. Criteria 
files are processed in the order specified. See section 5.6 for 
information on the criteria processing sequence. 
 
If you have inadvertently added criteria files to the list box in the 
wrong order, the Up and Down buttons can be used to move the 
selected criteria file up or down in the list box order. 
 
The Delete button is used to delete the currently selected criteria file from the list. 
 
The complete information for the Shape Clusters dialog is shown on the following page. 
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In the example above, the LTRT option is used to define the Side Slope Conditions. Using this option, the 
same list of Criteria Files will be processed for both the left and right sides of the cross section. To 
process a different set of criteria for each side, separate Side Slope Conditions using the LT and RT 
options must be defined. 
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5.10.6 Define DGN Variables 

When Define DGN Variables is selected, the dialog changes as shown below. 

 
One of the most powerful aspects of criteria is the ability to read a plan view design file, determine the 
roadway elements and then draw those features onto the cross sections. Define DGN Variables are used 
to specify the symbology of the plan view elements that will be located by the individual criteria files. 
 
For example, the ODOT Standard criteria file sh301-8.x has been written so that it will determine the 
width of the shoulder by measuring the plan view graphics representing the shoulder. This allows the 
criteria to draw the shoulder correctly for each cross section while accounting for varying widths or 
tapers. In order for the criteria to locate the shoulder in the design file, it needs the following 
information: 
 

 The name of the file that contains the plan view graphical elements. 
 

 The symbology (level, weight, color, line style) for the shoulder line. 
 
Normally, the user would define the symbology for each Define DGN Variable used by the criteria by 
using the Define DGN Variables option shown above. However, ODOT’s standard criteria library has 
been developed such that the definition of the DGN Variables is hard coded as a part of the criteria file 
and therefore does not need to be defined by the user. 
 
For example, the criteria file SH301-8.x includes instructions for the criteria to look for the proposed 
shoulder using the following information: 
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define_dgn "~SHOULDER IN DGN PR" \ 

    dgn = "PROPOSED DGN FILE NAME" \ 

    lvname = PV_P_Shoulder \ 

    wt = 1, ByLevel \ 

    co = 6, ByLevel \ 

    lc = 0, ByLevel 

 
If the shoulder has been drawn according to ODOT standards, the criteria will locate all of the 
MicroStation elements meeting the above search criteria and draw the shoulder onto the cross sections. 
If the criteria is unable to locate any lines, arcs or curves meeting the definition, no shoulder will be 
drawn. 
 
The symbology information for Define DGN Variables has been hard coded in ODOT’s standard criteria 
files since the symbology itself is an ODOT standard. The name of the design file that contains the plan 
view graphics, however, will vary from project to project. For this reason, the design file name is not 
hard coded in the criteria definition for the Define DGN Variables. Instead, ODOT’s standard criteria files 
use a Define Variable to identify the design file name. This Define Variable, also known as a 
“substitution string”, must be assigned the correct file name by the user. See Section 5.9.6 for 
information on Define Variables. 
 
Since all of the information for Define DGN Variables is included in the individual criteria files, there is 
no need to fill out any information on the Proposed Cross Sections dialog for the Define DGN Variables 
item. 
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5.10.7 Define Variables 

When Define Variables is selected, the dialog changes as shown below. 

 
The Define Variables portion of the Proposed Cross Sections dialog is used to assign values for any 
Substitution Strings that are found in the criteria files. Substitution Strings are used by the criteria 
developer to specify values that will change from project to project. Consider the example below: 
 
In the ODOT Standard criteria file SH301-8.x, a shoulder will be drawn adjacent to the proposed 
pavement. The following criteria command can be used to draw the shoulder thickness: 
 

draw dx=0 dy=-0.5 

 
In this example, the shoulder thickness is hard coded to be 0.5 master units. This is not desirable since 
the shoulder thickness may vary from project to project. In order to make ODOT’s standard criteria files 
generic, a substitution string has been used in the criteria as shown in the example below: 
 

draw dx=0 dy=-”shoulder thickness” 

 
By using a substitution string in the criteria, the user can now assign the value for the variable 
”shoulder thickness” at runtime. Using substitution strings, the same shoulder criteria file can be 
used to accommodate a wide variety of design conditions. 
 
Most of the variables in ODOT’s criteria files have been assigned default values. If a variable has been 
assigned a default value, it will automatically show up in the list box, as shown above. 
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The list of variables can be displayed by individual criteria file by use of the By File option as shown in 
the example below. Select a criteria file from the list and only the variables for that file will be shown in 
the list box. Select All to display all of the variables from all of the criteria files. 

 
Variables that are given default values in the criteria file are automatically carried to the Proposed Cross 
Sections dialog as shown above. If the default value does not meet your project specifications, it can be 
changed by using the Modify button. To change the default value for a variable, select the variable from 
the Variable list box. Change the value in Value field. Select the Modify button. The new value for the 
variable is now defined in the Proposed Cross Sections dialog box as shown in the example below. 

 
Any variable that has not been assigned a default value must be given a value in order for the criteria to 
process. Use the Select Variable Name button to scan the included criteria files for substitution strings 
that have not been given default values. 

 
If all the variables have a default value assigned, the Select Variable Name Button is ghosted. If the icon 
is not ghosted, that is an indication that there are undefined variables in one or more of the included 
criteria files. The criteria run will not process if there is a variable that has been left undefined. 
 
Choose the Select Variable Name icon to access the Undefined Variable Names dialog shown on the 
following page. 
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The dialog contains a list of any undefined variables. Each variable must be defined in order for the 
criteria process to run. Select the variable name, and then choose the To Var. Names icon. The name of 
the variable is carried to the Proposed Cross Sections dialog as shown below. 

 
The variable is added to the list of defined variables. Continue to define each variable until the 
Undefined Variable Names dialog is empty. 
 

Criteria Documentation 

Each variable has been named as descriptively as possible; however the name of the variable is not 
always obvious as to what the setting controls. For example, the variable “number of layers” is 
used to set the number of pavement layers to be drawn. In other cases, the name of the variable is not 
so obvious. For example, what is the variable “terminate slope” used for? It might not be used for 
what you think. Users should review the documentation for each individual criteria file to ensure that 
the variables are set correctly to achieve the desired results. 
 
Tip: Use the By File option to sort the variables by the Criteria File when reviewing the documentation. 
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5.10.8 Plot Parameters 

When Plot Parameters is selected, the dialog changes as shown below. 

 
The options are described on the following pages. 

Cross Section Lines 

Cross section lines representing the width and cross slope of the pavement shapes are automatically 
drawn onto the cross section. The Cross Section Lines item is used to control the symbology for these 
lines if the symbology is not defined in the criteria. 

 
ODOT’s Pavement criteria files have been configured to draw the top layer of the pavement shapes on 
the level XS_P_Pavt_Surface. 
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Text 

 
The Line Text, Station Text and Baseline Name Text items are not normally used for ODOT projects. All 
of the labeling functions are typically accomplished by the criteria files. 

Plot 

 
The Pavement Thickness item is used to draw a second set of lines beneath the GEOPAK pavement 
shapes at the thickness value specified in the adjacent key-in field. Since ODOT’s standard criteria files 
for pavement draw the proposed pavement, there is no need to have GEOPAK automatically draw this 
set of lines and this option should normally be toggled off. 
 
Fill Gaps Between Clusters is used for divided highway situations. 
 
The Transition Definition item may be used to apply a different superelevation transition method to the 
GEOPAK pavement shapes. With this option toggled off, a linear superelevation transition will be 
maintained. This option should always be toggled off for ODOT projects. 
 
Intersect Between Clusters is used for divided highway situations and will not be covered in this class. 
 
By default, shape clusters are processed starting with left side first, regardless of the order in which the 
clusters are specified. With Process Clusters as Indicated toggled on, the clusters will be processed in 
the order that they are specified. This option should always be left toggled off when using ODOT 
Standard criteria files. 
 
Remove Skewed Effect 
GEOPAK draws proposed cross section elements sensitive to skew angles. Depending on the 
circumstances, the designer may not want to use this skew angle. The easiest explanation for this effect 
is an example.  
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 When the pattern line is skewed to a plan 
view element or the edge of a shape, 
GEOPAK determines the angle between 
the pattern line and the plan view 
element or shape edge as shown in the 
graphic at left. 
 
It will then use that angle for drawing 
subsequent criteria commands In this 
example, if the criteria specifies drawing a 
6:1 fill slope, GEOPAK will draw a flatter 
slope based on the degree of the skew 
angle. In this case, the cross section will 
be drawn accurately, as the 6:1 slope 
would assume being perpendicular to the 
edge of pavement.  
 

 
 

The problem arises when subsurface layers are drawn after the skew effect has been encountered. In 
this case, the skew effect is applied to the slope of the subsurface layers. As a result, the subsurface 
layers would not be parallel the surface, even when the criteria dictated for GEOPAK to do so. 
 
Process only Sections with Existing Ground 
Toggle this option on to process only cross section cells with existing ground lines drawn. 
 
Pavement Shapes 
Toggle this option off. The pavement is drawn using the ODOT criteria files. 
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5.10.9 Drainage 

When Drainage is selected, the dialog changes as shown below. 

 
To draw the drainage components onto cross sections, activate the toggle at the top of the dialog. In 
addition, the drainage project (*.gdf) and its path must be specified. The file where the drainage project 
is drawn must be specified, including the path. The file names may be manually entered or selected via 
the Files button. 
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5.10.10 Processing the Criteria Run 

After you have defined all of the parameters on the Proposed Cross Sections dialog, you are ready to 
process the criteria run. Select Files > Run from the Proposed Cross Sections dialog to access the dialog 
below. 

 

 
GEOPAK will send information to the screen as the cross sections are processed. This information may 
also be optionally saved to a Log File as shown in the example above. 
 
The Pause On Each Section option is used to specify whether GEOPAK should stop after each cross 
section is drawn. 
 
The Criteria Viewer option is used in criteria development and will not be covered in this training guide. 
 
The Disable View Update option is used to process the criteria run without displaying the cross section 
graphics as the sections are processed. This option is useful to speed up processing for long cross section 
runs. 
 
Select Apply to initiate processing of the cross section run. The processing information is displayed in 
the Process Cross Sections Display dialog as shown on the following page. 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page 5-32 Chapter 5 – Proposed Cross Sections 
 

 
If the Pause on Each Section option is toggled on, pressing Continue will process the next cross section. 
Select Abort Run to end the processing. 
 
After all of the cross sections have processed, select Next Run to return to the Proposed Cross Sections 
dialog or select Exit to end the proposed cross sections routine. 

 
Normally, the cross-sections will be run several times in order to produce the desired results. When 
GEOPAK draws proposed features on large numbers of cross-sections, the files get large very quickly. 
Practicing good file maintenance will allow the user to process the sections faster, and use a minimum 
amount of space on the computer. Here are a couple of tips to facilitate processing criteria: 
 

 Delete the proposed features before re-running the criteria. Don't just write on top of the last 
run. Be careful not to delete the GEOPAK cells (level GK_Cells), the existing ground line (level 
XS_X_Ground_Line), or any underground utilities. 
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 At the end of a session, use the MicroStation Compress command. 
 

 If the results of the criteria run are undesirable, you can use the MicroStation Undo command to 
clear out only the proposed cross section graphics that were placed during the criteria run. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip: 
To facilitate deleting proposed cross section elements after a 
criteria run, without deleting previously drawn cross section 
elements, use the MicroStation Lock command to lock elements in 
the cross section design file that you do not want to delete before 
processing the proposed cross sections. 
 
First select the desired elements, and then select Edit > Lock to 
lock the selected elements. 
 
Now you can use the Select All command to select all the elements 
in the design file, and then use the Delete command. The locked 
elements will not be deleted. 
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5.11   Updating the Working Alignment Definition 

The symbology for the proposed cross sections graphics is defined in the criteria files to meet the 
standards defined in the ODOT CADD Engineering Standards Manual. The symbology of the elements 
that make up the proposed finish grade must be added to the Working Alignment Definition. Select 
Define from the Road Project dialog to access the Working Alignment Definition dialog shown below. 

 
The Proposed Finish Grade item supports options to specify the element symbology of the proposed 
cross sections. Simply toggle on the desired parameter, the press the Match button. 
 
The elements which comprise the Proposed Finished Grade are placed on the following levels when 
using ODOT’s criteria files: 
 

XS_P_Ditch_Bottom 

XS_P_Finished_Grade 

XS_P_Subgrade 
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EXERCISE 5A - Criteria Processing using Shapes 

In this exercise, we will use the following ODOT Standard criteria files to process cross section on S.R. 
185: 
 

 define.x 
 pavt.x 
 xs_label.x 
 sh301-8b.x 
 ss307-4.x 

 
The documentation for the criteria files listed above is available in the following folder: 
 

I:\ODOTstd\V8istd\Geopak\Road\criteria\Doc 
 
After you have reviewed the criteria documentation, answer the following questions: 
 
1. What is the role of define.x ?  
   
2. What is the inclusion sequence for the criteria files listed above? 
   Side Slope LT   Side Slope RT 
   1. _______________  1. _______________ 
   2. _______________  2. _______________ 
   3. _______________  3. _______________ 
   4. _______________  4. _______________ 
   5. _______________  5. _______________ 
 
3. Given the pavement buildup below, answer the following questions: 

 
Pavement 
Layer 

Which variable(s) control the 
thickness of each layer? 

What is the default 
value for this variable? 

Which criteria file 
defines the variable? 

Layer 1    

Layer 2    

Layer 3    

Layer 4    
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4. Which criteria file defines the values for the shoulder layer thicknesses? 
 
5. Which criteria file defines the values for the shoulder step widths? 
 

Pavement 
Layer 

Which variable(s) control the 
shoulder step widths? 

What is the default 
value for this variable? 

Which criteria file 
defines the variable? 

Layer 1    

Layer 2    

Layer 3    

Layer 4    

 
6. Which variable is used to control the size of the text annotations placed on the cross sections? 
 
7. Process the cross sections for S.R. 185 from station 53+00 R 1 to station 77+50 R 2 using the criteria 

files and pavement buildup shown on the previous page. 
 
8. Update the Working Alignment Definition to include information for the Proposed Finished Grade. 
 
 
An example of a finished cross section is shown below. 
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5.12   Shapeless Criteria Processing 

GEOPAK pavement shapes are used to define the lane widths, pavement cross slope and superelevation 
transition stations for the proposed pavement. In some cases, such as a pavement resurfacing project 
where the existing pavement cross slopes will be maintained, it is desirable to develop criteria files that 
do not rely upon pavement shapes. Some of ODOT's standard criteria files are designed to operate in 
Shapeless mode. See the criteria file documentation to determine how each file operates. 

5.12.1 5.11.1 What Is Needed To Process Shapeless Criteria? 

Before Processing Shapeless Criteria the following items must be defined: 
 

 A COGO chain representing the alignment to be processed. 
 A Vertical Alignment. 
 Pattern lines defining the location of the cross sections. 
 Existing ground cross sections. 
 Criteria files. 
 Plan view graphics representing the design features the criteria files need for processing.  

5.12.2 Processing A Shapeless Criteria Run 

Processing a shapeless criteria run is almost identical to processing criteria using pavement shapes as 
described in section 5.9. When processing shapeless criteria, all the dialog functions should be 
completed as described in section 5.9 with the exception of the Shapes and Shape Clusters items. 
 
Toggle the Shapes item to Shapeless mode as shown above to specify that you wish to process a 
shapeless criteria run. 

 
When processing shapeless criteria, the Shape Clusters item is used to identify the Chain and Profile 
that will be used for processing and to identify the criteria files to be used. 
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In shapeless mode, the chain and profile name list boxes are used to identify the Chain and Profile that 
will be used for processing.  

 
 Choose the chain from the COGO database that you wish to use for this criteria run. 

 
 Select the profile that you wish to use for the criteria run. 

 
 Set the Apply Profile at: option to the desired value. 

 
After you have identified the Chain, Tie and Profile to be used for the criteria run, select the Add button 
to add this information to the Proposed Cross Sections dialog as shown above. 
 
The remaining components of the Proposed Cross Sections dialog should be completed as described in 
Section 5.9. 
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Exercise 5B – Shapeless Criteria Processing 

In this exercise we will process the ODOT criteria file pavt_exist.x in shapeless mode to draw the existing 
pavement on the cross sections. 
 
The documentation for pavt_exist.x is available online at the following URL: 
 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/Criteria.aspx 
 
After you have reviewed the criteria documentation, create a new proposed cross section run to draw 
the existing pavement with the following parameters: 
 

 Use a pavement thickness of 1.25”. 
 

 Process all the cross sections (do not put any station limits on the criteria conditions) 
 

 In order to draw the existing pavement on all the sections, which profile should you use for 
processing? 

 
An example of the completed cross section is shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/Pages/Criteria.aspx
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5.13   Processing Multiple Shape Clusters 

Divided highways are represented by multiple shape clusters defining the left and right roadways. An 
example of the shape clusters for a divided highway with a 40’ median is shown below. 

 
In this example, the same Chain and the same Profile are used for both the left and right shape clusters. 
The profile is applied on the inside edge of pavement for each shape cluster. The left shape cluster has a 
Tie value of -20. The right shape cluster has a Tie value of 20. 
 
The Shapes item in the Proposed Cross Section dialog has been defined as All in DGN. Selecting the Scan 
button reveals two shape clusters as shown in the List of Clusters dialog below. 

 
GEOPAK process all cross sections by starting on the left side of the left most shape cluster. When 
adding the shape clusters to the Proposed Cross Sections dialog, be sure to add them to the dialog so 
that the left most cluster is listed first as shown on the following page. 
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The next step is to define the criteria files that will be used on the left and right side of each shape 
cluster as shown in the example below. 

 
The complete list of criteria files for this example is defined as shown on the following page: 
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Criteria for Shape Cluster 

  shape cluster baseline = CLPS185 

  shape cluster profile  = PS185P 

  shape cluster tie    = -20.000 

  side slope LT where Station >= 53+00 R 1 and Station <= 77+50 R 2 

     include I:\V8std\Geopak\Road\criteria\define.x 

     include I:\V8std\Geopak\Road\criteria\pavt.x 

     include I:\V8std\Geopak\Road\criteria\sh301-8b.x 

     include I:\V8std\Geopak\Road\criteria\ss307-4.x 

     include I:\V8std\Geopak\Road\criteria\xs_label.x 

  

  side slope RT where Station >= 53+00 R 1 and Station <= 77+50 R 2 

     include I:\V8std\Geopak\Road\criteria\pavt.x 

     include I:\V8std\Geopak\Road\criteria\sh301-8b.x 

  

Criteria for Shape Cluster 

  shape cluster baseline = CLPS185 

  shape cluster profile  = PS185P 

  shape cluster tie    = 20.000 

  side slope LT where Station >= 53+00 R 1 and Station <= 77+50 R 2 

     include I:\V8std\Geopak\Road\criteria\pavt.x 

     include I:\V8std\Geopak\Road\criteria\sh301-8b.x 

     include I:\V8std\Geopak\Road\criteria\med304-1.x 

  

  side slope RT where Station >= 53+00 R 1 and Station <= 77+50 R 2 

     include I:\V8std\Geopak\Road\criteria\pavt.x 

     include I:\V8std\Geopak\Road\criteria\sh301-8b.x 

     include I:\V8std\Geopak\Road\criteria\ss307-4.x 

 
 
An example of the completed cross section is shown below. 
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6 Cross Section Labeling 

6.1 Overview 

The Cross Section Labeling tool is used to automate the composition and placement of cross section 
labels. This interactive tool permits the creation of very simple to complex labels using many of the 
following features:  
  

 Numerous Computed Text Inserts permit standardized computed values to be incorporated into 
labels. These standardized computed values are based on the type of element to be labeled and 
change as different elements are selected by the user. Types of elements available for computed 
inserts include points, lines, arcs, complex graphic elements, COGO features, and drainage 
features. 

 

 User Text Inserts allow user defined text strings to be included in the label. These User Inserts 
can be customized to allow frequently used labeling terms to be saved for repeated use. 

 

 Standard shapes can be placed around. 
 

 Standard leader lines and leader line terminators can also be used to create the desired label 
formats. 

 

 Frequently used labels can be stored as Label Styles for subsequent recall. The complete label, 
including computed text inserts, user inserts, shapes, and leaders, are all stored within the Style. 

 

 Tools to edit, move, and extract labels are also provided to make manipulation and plan changes 
easier. 

 
The Cross Section Labeler dialog, shown on the following page, is accessed by selecting Applications > 
GEOPAK Road > Cross Sections > Labeling from the MicroStation menu bar or from the Road tool 
palette as shown on the following page. 
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When Cross Section Labeling is selected, the Cross 
Section Navigator and the Cross Section Labeler 
dialogs shown below are opened. 
 
For details on the Cross Section Navigator, see page 2-
26. 
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6.2 The Cross Section Labeler Dialog 

6.2.1 Text Options 

The first tab within the Cross Section Labeler dialog is the Text option. 

 
Navigator Station (display only) 
This displays the current cross section station for which the computed inserts are to apply. To navigate 
through the cross sections, use the Cross Section Navigator. See Chapter 2, section 2.6, Cross Section 
Navigator, for a complete description of the Cross Section Navigator tool. 
 
Label Feature 
Two options are available to label individual data points, or cross section elements, as described below. 
 

Data Point Location 
 

This option is used to place labels corresponding to a single data point location, such as 
a station and offset. Press this button, then issue a data point on the screen to identify 

the point to be labeled. 
 
Select XS Element 
 

This option is used to label cross section elements, such as the length of a cross section 
segment. Press this button, then select the GEOPAK or MicroStation element to be 

labeled. 
 

The power of the labeling tools is their use of computed text inserts. Based on the element type being 
labeled (i.e., point or line), there are numerous values which can be computed and included in a label. 
Once these inserts are added to a label, these values are automatically recomputed for subsequent 
elements identified. 
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Computed Inserts or User Inserts  

Two options are supported: Computed Inserts and User Inserts. The Computed Inserts are values 
computed by the labeler for various elements such as points, lines, arcs, the GEOPAK coordinate 
geometry database, or drainage features. The User Inserts are user defined ASCII files containing 
commonly used words. In lieu of typing, the user simply selects the word from the list. 
 
Computed Inserts  
Based on the element type being labeled, a list of available inserts that can be computed for the 
element will be displayed. This list will change depending on whether the Identify Element Data Point 
Location or Select XS Element button has been selected.  
 
To use a Computed Insert, first highlight the desired variable. The computed value is then displayed in 
the field below the list of text inserts. If the value cannot be computed because of missing information 
or computing error, the value will be shown as "Not Available" or "Error". 
 
Double-clicking the Computed Insert adds it to the label at the current cursor position in the label 
editing field at the upper right portion of the dialog. Note: The number of decimal places for the label 
must be selected before double-clicking the Computed Text item.  

 
Note: If the value of a computed text insert is manually edited, it loses the intelligence of a computed 
label, becoming inserted text. 
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User Inserts  
If the User Inserts toggle is active, the dialog displays a list of commonly used words stored in a user 
defined file. Each line of the file is one word or phrase followed by a space. In this way, when two words 
are placed together by successive data points, a space is placed between them. Several ASCII text insert 
files are located in the default GEOPAK directory. There is no limit to the number of text insert files that 
can be developed by the user. However, they may only be used one at a time. 
 

 
User Insert Options 
When the User Insert toggle is active, the icons for file 
manipulation are displayed. The far left icon edits the current text 
file, while the second icon opens an insert file. The third icon (disk) 
saves the current file, while the fourth icon is the Save As…. 
option. The last two icons sort the current insert file in ascending 
or descending alphabetical order. 
 
 

 
Label Edit Field 
 

 
The Label Edit Field, located in the upper right portion of the dialog, 
reflects the text in the current label. Labels can be constructed by any 
combination of Computed Text, Inserts, User Inserts, or manually 
typed text strings. 
 
 
 
 
 

 
Space 
Press to add a Space within a label. A single space is added with each pressing of the button. 
 
Return 
Press to add a Return within a label and move to the next line down. 
 
Clear 
Press to clear the entire label from the label display window. 
 
Delimit 
Press to place a delimiter between lines. 
 
Place Label 
When the label is constructed and ready to place, press this button, then move the cursor for 
dynamic placement. 
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6.2.2 Parameters Options 

When the Params. tab is selected, the dialog changes dynamically, as shown below, to control the Text 
Preferences / Symbology for the label. 

 
These options are used to set the text parameters and symbology for the label. The four icons at the 
bottom of the dialog have the following functions. 
 
By Current 

Select this icon to have GEOPAK determine the active MicroStation symbology (level, weight, color 
and style) and populate the dialog accordingly. 

 
By Element 

Select this icon to select a previously drawn MicroStation element, and populate the dialog with its 
element symbology. 

 
By D&C Symbology 

Select this icon to use a D&C Manager item to set the element symbology. 
 

 
Set All 

Select this icon to have GEOPAK read the current settings (level, weight, color and style) within the 
Params. tab, and populate the Shape and Leader tabs accordingly. 
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6.2.3 Shape Options 

When the Shape tab is selected, the dialog dynamically changes as shown below. 

 
Shape Preferences 
Several shapes are supported in addition to a shapeless option. Selection of a shape draws the selected 
shape around the label. The shape is proportional to the size of the label. As the label gets larger, the 
shape is expanded to fit. 
 
Shape Offset 
The distance from the edge of the text to the shape 
 
Symbology 
Options are provided to set the Level, Color, Style and Weight for the shape. The same four icons as 
described on page 6-6 are available to set the symbology. 
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6.2.4 Leader Options 

When the Leader tab is selected, the dialog dynamically changes as shown below to control the type of 
leader and leader terminator. 

 
Leader Type 
Four leader types and a no leader option are supported. Depending on the type selected, the user is 
prompted for data point(s) to provide maximum flexibility over location of the leader. Each shape has 
several origination points around the circumference to accommodate leaders. 
    
Terminator 
Supported options include no terminator, closed arrow, open arrow, and AT (active terminator). To use 
the active terminator, the MicroStation line terminator must be defined and the cell library containing 
the terminator must be attached. If a terminator is selected and no cell library is attached, an Alert 
message is displayed. 
 
Symbology 
Options are provided to set the Level, Color, Style and Weight for the shape. The same four icons as 
described on page 6-6 are available to set the symbology. 
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6.2.5 Rotation Options 

When the Rotate tab is selected, the dialog dynamically changes, as shown below, to set the rotation 
options for the label. Note that these commands can also be issued from the Label Control tool frame 
before or during label placement. 

 
Current Angle 
Select this icon to place a label at the current angle. 
 
Element Angle 
Select this icon to set the label angle according to the angle along a MS graphic element. 
 
Alignment Angle 
Select this icon to rotate a label, either before or during placement, at an angle relative to a Chain. This 
icon is used by the Plan View Labeler only and is not available for the cross section labeler. 
 
Set Angle By 
Three options are supported: DP, Element and AA (Active Angle.) These buttons are used in the Text 
Angle commands above. 
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6.2.6 Styles Options 

When the Styles tab is selected, the dialog dynamically changes as shown below to create a new label 
style, or modify or reuse previously defined Label Style. 

 
One of the most useful tools of the labeler is its ability to store labels. The computed and text inserts, 
shapes, leaders, element and text parameters of the label can all be stored under a unique name 
enabling the user to create a complete library of labels to use in subsequent sessions. The styles are 
stored in *.lsf files. Some default files for cross section (def_xs.lsf) are delivered with the GEOPAK 
software. 
 
New style files can be created, opened, and saved via the Style Files pull-down in the upper left corner 
of the main dialog. With each Style file, a hierarchical system is employed to easily and quickly organize 
and subsequently locate the desired label styles. The user has complete control over the naming of 
categories and labels within each category. Several utilities are supported within the dialog for creating, 
editing, and renaming styles, which are detailed below. Invoking these utilities can be accomplished via 
icons or push buttons. 
 
New Style 
To create a new style, begin by creating and placing the label. The label can be a copy or modification of 
another style, or a totally new label. Once the label is placed, highlight the folder where the new style is 
to be stored. Once a folder is highlighted, the new style button is un-ghosted. Next, press the New Style 
button, which invokes the Create Style dialog shown on the following page. 
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Type in the values for the Style Name and the Style Scale. The Style 
Scale should be set according to the Text Size entered in the Text tab. 
In the example, the text height and width were set to a value if 0.14 
master units. When the label is recalled for placement, the scale for 
the cross sections can be set within the Cross Section Labeler which 
will be applied to the Style Scale to determine the text size for the 
placed labels. 
 
Select OK to add the style to the current Style File as shown in the 
dialog below. 
 
 
 

 
 

To use a style that has already been stored in a Style File, simply select the style name, select either the 
Data Point Location or Select XS Element icon on the Text Tab, identify the data point location or 
MicroStation element to be labeled, and then select Place Label to place the label. 

 
Once a Style item has been selected, icons are available for the following functions. 
 

Select Style Item 
Pressing this icon makes the highlighted style the active style. 

 
Delete Style Item 

Pressing this icon deletes the current highlighted style.  
 

Copy Style Item 
Select the style to be copied, and then press the Copy Style Item icon. A copy of the style is               
created. 
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Rename Style / Category 
To rename a style or category, simply highlight the item to be renamed, and then press the 
Rename icon, invoking the dialog below. 

 
Change the name, and then press the OK button. The display list is dynamically changed to 
reflect the new name. 

 
Refresh Style List 

To refresh the Style List, simply press the Refresh icon. 
 

Create Style Category 
This icon is available if a Category is selected in the Item Selector list box. To create a new 
category, simply press the Create Style Category icon, invoking the dialog below. 

 
Type in the name of the new category, and then press the OK button. The category is added to 
the bottom of the label list. 

 
Delete Style Category 

This icon is available if a Category is selected in the Item Selector list box. To delete a 
category, simply select the category and then press the Delete Style Category icon. 

 
Update Style 

 
After modifying a style, the user may want to save the current modifications. Simply press the Update 
Style button to invoke the dialog depicted below. Both Before and After labels are shown, so the user 
can easily discern the changes. 
 
Important: Before you can save a label you must first place the label in the design file. The New Style 
button will remain ghosted until you place the label. To save the label in the style file select the category 
where the label is to be stored, press the New Style button, assign a new name and scale, and save. 
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6.2.7 Pull-Down Menu Options 

The Cross Section Labeler menu bar options include: 
 

Style Files - file utilities to create, open and save stored Style files containing label layouts. 
 
Options - user definable options for tool and dialog control over labeling functions. 
 
Scale - proportionalizes any label in addition to displaying the current scale. 
 
Tools - Currently only one tool is supported, Label Updater. It updates any label containing 
computed text inserts as per user options (i.e., all labels, those within a fence, etc. 

 

Style File Options 

 
In order to un-ghost the entire Style Files pull-down menu, the tab must be set to Styles. Styles are 
layouts of commonly used labels, each stored with a user-defined name, leaders, computed text inserts, 
etc., for easy retrieval. These are stored in *.lsf files which default to the …geopak\bin directory. 
Standard options are provide to create New style files, Open existing files, Save or Save As style files. 
 
 
 
 
 
 
 
 
 
 
 
 
 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page 6-14 Chapter 6 – Cross Section Labeling 
 

Options 

 
The options below are supported under the Options pull-down menu. 
 
Minimize Dialog 
When the Place Label button on the main dialog is pressed, toggling this option will minimize the main 
labeling dialog to allow for easier label placement. 
 
Label Tools   
The Label Control tool frame contains a variety of useful tools during the actual placement of labels. It is 
resizable and dockable, so it can be open, yet out of the way during placement. As it is an independent 
tool frame, the main labeler dialog can be minimized while the Label Control is active. The twelve tools 
are detailed below. 

 
Rotate Label to Active Angle 
Select this tool to rotate a label, either before or during placement, to the active angle.  
 
Rotate Label By Element Angle 
Use this toll to rotate a label to the angle of a selected MicroStation graphic element. 

 
Rotate Label by Two Data Points 
Use this tool to rotate a label to an angle between two data points. 
 
Rotate Label 180 
Use this tool to rotate a label 180 degrees from the current rotation of the label. 
 
Increase Text Size 
Each press of this button increases the text size of the dynamic label by the scale specified in the 

dialog. 
 
Decrease Text Size 
Each press of this button decreases the text size of the dynamic label by the scale specified in the 

dialog. 
  

Data Point 
This button is a shortcut for the Data Point Location button located on the main dialog. 
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Identify Element 
This button is a shortcut for the Select XS Element button on the main dialog. 
    
Edit Label 
Once a label has been placed with any of the GEOPAK labelers, it can easily be edited. Select this 

button, and then select the label to edit. GEOPAK populates the dialog, including all tabs, with the 
information on the selected label. The label can be modified as desired, then placed again. 
 

Move Label 
Once a label has been placed with any of the GEOPAK labelers, it can be easily moved. Note: The 

data points for any leader lines are not retained and must be placed again. 
 
Extract Label 
To place several labels similar to a previously placed label, the user does not have to know the 

style, sizes, etc. Select this button, and then the label from which to extract. GEOPAK loads the style, and 
all required element and text parameters into the dialog. 
 

 Place Label 
This button is a shortcut for the Place Label button on the mail dialog. 

 
Restore Label Dialog 
When the main dialog is minimized, pressing this button restores the main dialog to full size. 

 
Label Viewer 

 
When the Label View option is active, the Label View dialog is always 
visible on the screen. When the Minimize Dialog option is activated, the 
Label View dialog at left is invoked whenever the Place Label button in 
the main dialog is pressed. A single label can be placed by pressing the 
Place Label button (if not already pressed in the main dialog), then a 
data point is placed at the desired location. The Automatic Label option 
is only supported when the sample label includes computed text inserts. 
When the Automatic Label button is pressed and a data point is 
selected, the placed label includes the updated computed text inserts in 
the same style as the original label. 
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Scale  

 
When Scale > Change Scale is selected, the dialog shown below is opened. 

 
This tool allows labels to be scaled from their original creation scale. For example, if a label was created 
with a text scale of one (TH = 0.14, TW = 0.14) and is to be used on 5 scale cross section sheet, changing 
the scale from one (1) to 5 would set the size of all the items contained in the label to the correct scale. 
 
 
Tools 

 
The options under the Tools pull-down menu are not supported by the Cross Section Labeler. 
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7 Earthwork Quantities 

7.1 Overview 

GEOPAK provides the capability to calculate earthwork quantities from cross section elements or from 
DTM volume differences. In this training class, we will focus on generating earthwork quantities from 
the final cross sections. 
 
In order to compute earthwork, GEOPAK requires: 
 

 A MicroStation design file containing proposed cross-section and existing ground lines 
 

 A GEOPAK job number and baseline (only required if the baseline has station equations) 
 
GEOPAK computes earthwork using the average end area method by reading and interpreting the areas 
between the existing ground and the proposed finished grade on the cross sections. This approach 
affords the user maximum flexibility in that it is immaterial whether the cross section elements were 
created entirely by GEOPAK or were created, or modified, using generic MicroStation commands. 
GEOPAK can compute earthwork volumes from any reasonable graphical representation of a cross 
section. 
 
GEOPAK is extremely flexible when computing earthwork, using several types of excavation and fill, 
numerous material types (known as soil types), and different shrink/expansion factors. In order to tell 
the software how to compute earthwork, a thorough understanding of these concepts is necessary. 
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7.2 Creating an Earthworks Run 

From the Road Project dialog box, select Earthwork to access the Select Run dialog box shown below. 

 
By default, a run named Untitled is always created. To create a new run, select Run > New... from the 
Select Run dialog box to access the New Run Name dialog box shown on the following page.  
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Key-in the Run Name and an optional Description. Select OK to initiate creation of the new run.  
In the select Run dialog box, select the new run from the list box and then pick OK to open the new run. 
The Earthwork dialog box shown below is opened. 
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7.3 Configuring the Earthwork Dialog Box 

After you have opened an earthwork Run, the Earthwork dialog box shown below is displayed. 

 
Select an item from the list box on the left side of the dialog to access the various parameters of the 
earthwork run. A description of the items in the Earthwork dialog box can be found in the following 
sections of this document. See the GEOPAK documentation for additional information. 
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7.3.1 XS DGN File 

When XS DGN File is selected, the dialog will change as shown below: 

 
If you have set up a Working Alignment Definition with the GEOPAK Project Manager, the following 
information is taken from the currently selected Working Alignment and automatically placed in the 
Earthwork XS DGN File dialog box: 
 

XS DGN File - The name and location of the design file containing the cross sections. 
 

Baseline - The name of the Chain representing the Horizontal Alignment. 

 
Begin Station - The beginning station of the cross sections found in the specified XS DGN File. 

 
End Station - The ending station of the cross sections found in the specified XS DGN File. 

 
The remaining items are given default values as described below: 
 

The Tolerance item defines the maximum distance between the endpoints of two MicroStation 
elements for them to be considered connected. 

 
The Vertical Search Distance is used to define how far above and below each cross section axis 
GEOPAK will search for MicroStation elements that make up each individual cross section. By 
default, GEOPAK places existing ground cross sections horizontally 1000 master units and 
vertically 500 master units apart. These values are specified when the existing ground cross 
sections are initially generated. 

 
Note: If you elected to change the value for the Distance Between Cross Sections Vertical item 
when you generated the existing ground cross sections, it will be necessary to assign the same 
value for the Earthwork Vertical Search Distance item. 
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7.3.2 Soil Types 

When the Soil Types item is selected, the dialog box will change as shown below: 

 
The Soil Types portion of the Earthwork dialog is used to define any number of soil types to be 
computed by GEOPAK. Each Soil Type is given a user defined name. At least two Classifications are 
necessary to define a Soil Type. The available Classifications are shown below: 

 
The Class is extremely important, as it dictates which Soil Type materials are re-used and which 
materials are not. 
 

Existing Ground 
This Class is used to define the elements that comprise the existing ground line. The elements 
defining the existing ground must be contiguous between the proposed tie down points. 
 
The soil type name specified with the existing ground is important as it is the default excavation 
material. Only one default cut material may be specified. This material is computed by the 
software in areas where the proposed finish grade is below the existing ground. 
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Existing Suitable 
Materials defined as this type will be removed down to the proposed subgrade. Any portion of 
this material that is below the proposed subgrade will be left in place and not tabulated in the 
earthwork quantities. 

 
Existing Unsuitable 
Materials defined as this type will be completely removed. Portions of an Existing Unsuitable 
material below the proposed subgrade will be removed and backfilled. The areas beneath the 
proposed subgrade that are to be backfilled will be automatically included in the Fill quantities 
for the cross section, but are not automatically included in the excavation quantities. 
 
Proposed Finished Grade 
For ODOT projects, the proposed finish grade is defined to include the bottom of the proposed 
pavement, shoulders, curb and gutter, side slopes, top of proposed ditches, etc. The software 
must be able to contiguously draw from the centerline to the touchdown point using these 
levels. 
 
The soil type name specified with the proposed finish grade is important as it is the default fill 
material. Only one default material may be specified. This material is utilized by the software in 
areas where the proposed finish grade is above the existing ground. 
 
Proposed Undercut 
The proposed undercut is used to define undercuts or subcuts. It is important to remember that 
the soil type name you assign for the proposed undercut is not the material being removed, but 
what the area will be backfilled with. The material being removed is computed as part of the 
default excavation unless it is an existing suitable or unsuitable material. 
 
Excavation Limit 
Excavation limits are short lines drawn onto cross sections to tell the software where to stop 
removing existing unsuitable or suitable material. They have no direct correlation to proposed 
features, except that the removals normally end at the outside edge of proposed construction. 
 
Excavation limits are required whenever existing suitable or unsuitable classifications are 
specified. See section 7.6.2 for more information on Excavation Limits. 
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In this example, we will define a Soil Type named “203-EARTH” representing the cut and fill volumes for 
the cross sections. 
 
The soil type 203-EARTH will be defined by the existing ground and the proposed finished grade. Take 
the following steps to define the Existing Ground: 
 

 Select Existing Ground from the Class drop down menu as 
shown at right. 

 
 Key-in the Soil Type name 203-EARTH 

 
 Toggle on the Use Working Alignment Definition item under 

the Search Criteria section of the dialog box, as shown below. 
The Criteria Status section in the lower right portion of the dialog box is updated to reflect the 
values assigned in the current Working Alignment Definition for the Existing Ground. 
 
If you have not assigned values for the Existing Ground item in the GEOPAK Project Manager, do 
not toggle on the Use Working Alignment Definition item. In this case, it will be necessary to 
manually assign values for the Lv Names, Weight, Colors, Styles and Types shown under the 
Search Criteria portion of the dialog box. 

 
 Key-in the values for the Multiplication Factors, also known as shrink/swell factors if desired. 

The default values are 1.0. 
 

 Select the Add button to add Existing Ground to the Soil Type Items list box as shown below: 
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The steps to define the Proposed Finish Grade are the same as those used to define the existing ground, 
and are summarized below: 
 

 Select Proposed Finish Grade from the Class drop down menu. 
 

 Use the same Soil Type name as the Existing Ground. 
 

 Toggle on the Use Working Alignment Definition item under the Search Criteria section of the 
dialog box as shown below, or define the Search Criteria manually. 

 
 Select the Add button to add Proposed Finish Grade to the Soil Type Items list box as shown 

below: 
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7.3.3 Earthwork Shapes 

When Earthwork Shapes is selected, the dialog box changes as shown below: 

 
The Earthwork Shapes item is used to draw MicroStation Shape elements in the cross section design file 
representing the cut and fill areas. 
 
Toggle the Draw Earthwork Shapes option on to draw shapes in the MicroStation design file specified by 
the XS DGN File item. 
 
Double-click the Parameters symbology box to access the GEOPAK Set Feature dialog, shown below. The 
level XS_P_Earthwork_Shapes has been defined for placement of the earthwork shapes. 

 
With the Stratify Shape Color option toggled on, GEOPAK will draw each cut and fill area using a 
different color. GEOPAK assigns (in ascending numerical order) each material type two colors, one for 
cut and one for fill. An example of the shapes drawn for cut and fill areas is shown below: 
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7.3.4 Output Format 

When Output Format is selected, the dialog box will change as shown below: 

 
When earthworks are processed, GEOPAK generates an earthwork log file that is used to report the 
quantities for the cross sections. The Output Format options are used to define how the earthwork 
quantities are reported in this log file. 
 
The log file is an ASCII file. A portion of the a file is shown below: 
 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

  53+00.000 203_EARTH 

                Common Exc      72.7          0          0   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill        33.0          0          0   1.00        0 

 

  53+25.000 203_EARTH 

                Common Exc      58.6         61         61   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill        31.1         30         30   1.00       31 
 
Excavation and fill quantities are reported for each cross section. By default, three classifications of 
excavation volumes are listed in the GEOPAK Earthwork Log file. These excavation classifications are as 
follows: 
 

 Common Excavation 

 Subgrade Excavation 

 Subsoil Excavation 
 
In some cases, the designer may not wish to separate the excavation quantities into separate 
classifications. The output format can be changed to combine the excavation quantities into one listing. 
For example, if the user desires to combine all three excavation classifications into an earthwork listing 
consisting of just cut and fill, press the < or > arrows until the desired option is displayed. 
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With Excavation and Fill specified, the excavation quantities are combined as one item in the Earthwork 
Log file as shown in the example below: 
 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

  53+00.000 203_EARTH 

                Excavation      72.7          0          0   1.00 

                    Fill        33.0          0          0   1.00        0 

 

  53+25.000 203_EARTH 

                Excavation      58.6         61         61   1.00 

                    Fill        31.1         30         30   1.00       31 
 
Options for reporting the excavation and embankment quantities include: 
 

 Common Exc, Subgrade Exc, Subsoil Exc, and Fill 

 Excavation (Common and Subgrade), Subsoil Exc, and Fill 

 Excavation (Common and Subsoil), Subgrade Exc, and Fill 

 Excavation (Subgrade and Subsoil), Common Exc, and Fill 

 Excavation (all types) and Fill 
 
Accumulate Adjusted Volume Column 
When activated, an additional column is added to the earthwork report where the adjusted volume of 
each excavation and fill, for each material, is cumulatively totaled. 
 
Accumulate Unadjusted Volume Column 
When activated, an additional column is added to the earthwork report where the unadjusted volume of 
each excavation and fill, for each material, is cumulatively totaled. 
 
Calculate Only Between Excavation Limits 
Another option within this dialog is Calculate Only Between Excavation Limits. In this option, the use of 
excavation limits is to demarcate earthwork processing. This is extremely useful in projects where 
earthwork is staged, or a separate quantity for each roadway in a multiple alignment scenario is 
necessary. When the toggle is activated, all earthwork calculations, not just existing removals, are 
restricted to user-defined excavation limits. 
 
End Area Decimal Places 
From 0 to 4 decimal places may be set for the output values. 
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7.3.5 Add/Subtract Volume 

When Add/Subtract Volume is selected, the dialog box changes as shown below: 

 
The Add/Subtract Volume item is used to specify quantities to be added to or subtracted from the 
GEOPAK earthwork calculations. This procedure involves the following steps: 
 

 Toggle on Process Add/Subtract Volumes if you wish to define additional earthwork volumes to 
be added to, or subtracted from, the GEOPAK Earthwork calculations. 

 
 Select the soil type using the Soil Type option button. The soil types defined for the run are 

available in the option button. 
 

 Select the EW Operation that you want to have the quantity added to or subtracted from. The 
available options are Common Exc, Subgrade Exc, Subsoil Exc and Fill. 

 
 Key-in the Station and the Volume you wish to add, or subtract, at the specified station. 

Subtracted volumes should be entered as negative numbers. The station does not necessarily 
have to be at a cross section station. However, it must be within the specified station range. 

 
 Select the Add button to add the station and volume to the List box. 

 
To modify data, highlight the line to be modified. Change the desired value, and then press the Modify 
button. The change is reflected in the list box. 
 
To delete a line, highlight the line to be deleted, and then press the Delete button. The line is deleted 
from the list box. 
 
There is no limit to the number of defined Add/Subtract Volumes. 
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7.3.6 Centroid Adjustment 

When Centroid Adjustment is selected, the dialog box changes as shown below: 

 
Earthwork volumes are calculated by averaging end areas and then multiplying these averaged areas by 
the distance between two successive cross sections, as measured along the baseline. If the bulk of the 
earthwork areas are located predominantly to either the left or the right of the baseline, an error occurs 
in the volume calculations for all non-tangential portions of the baseline. This error can be negligible, or 
substantial, depending on the degree of baseline curvature as well as the distance to which cross section 
areas are offset from the baseline. 
 
The Centroid Adjustment option invokes a procedure that adjusts volumes based upon the lateral offset 
between the centroid of the cross section end areas and the baseline. This procedure involves the 
following steps: 
 

 A centroid is calculated for each cross section. 
 

 An offset between the centroid and the baseline is computed for each cross section. 
 

 Between two successive cross sections, the individual centroid offsets are averaged. A 
concentric chain, offset by this averaged distance, is then calculated. The longitudinal distance 
along this chain between the cross sections is determined.  

 

 The resultant volume is then determined by multiplying the end area average by the adjusted 
longitudinal length, along the concentric chain. 
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7.3.7 Skip Areas 

When Skip Areas is selected, the dialog box changes as shown below: 

 
The Skip Areas item is used to define a station range where earthwork quantities are computed, but are 
not included in the grand totals for the earthwork run. This procedure involves the following steps: 
 

 Toggle on Process Skip Areas to have GEOPAK omit earthworks calculations for the specified 
station range. 

 
 Key-in the Begin Station and End Station for the skip area. If the baseline has station equations, 

the regions must be included.  
 

 Select the Add button to add the station range to the list box. 
 
To modify data in the list box, highlight the line to be modified. Change the desired value, and then 
press the Modify button. The change is reflected in the list box. 
 
To delete a Skip Area in the list box, highlight the line to be deleted, and then press the Delete button. 
The line is deleted from the list box. 
 
There is no limit to the number of defined Skip Area station ranges. 
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7.3.8 Ignore Areas 

When Ignore Areas is selected, the dialog box changes as shown below: 

 
The Ignore Areas option is used to define a station range where no quantities will be computed. This 
option differs from the Skip Area option in the following way: 
 

 Earthwork quantities are computed for the station range defined as a Skip Area, but not 
included in the Grand Total. 

 
The Ignore Areas option involves the following steps: 
 

 Toggle on Ignore Areas to have GEOPAK omit earthworks calculations for the specified station 
range. 

 
 Key-in the Begin Station and End Station for the area to be ignored. If the baseline has station 

equations, the regions must be included.  
 

 Select the Add button to add the station range to the list box. 
 
To modify data in the list box, highlight the line to be modified. Change the desired value, and then 
press the Modify button. The change is reflected in the list box. 
 
To delete an Ignore Area, in the list box highlight the line to be deleted, and then press the Delete 
button. The line is deleted from the list box. 
 
There is no limit to the number of defined Ignore Area station ranges. 
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7.3.9 Sheet Quantity 

When Sheet Quantity is selected, the dialog box changes as shown below: 

 
Earthwork quantities can be written directly onto cross sections sheets. A two step process is required: 
 

1. An ASCII text file is produced from the earthwork calculations. This ASCII text file contains the 
area and/or volume quantities that are to be written onto the cross section sheets. 

 
2. The sheet quantities can be placed on the cross section sheets using one of two options: 

 

 The GEOPAK Cross Section Sheet Layout utility can be configured to read the Sheet 
Quantity ASCII file to place the appropriate text onto the cross section sheets. 
 

 An ODOT VBA Application can be used to place the sheet quantities directly in the cross 
section cell design file. The quantities are displayed on the cross section sheets, along 
with the cross section graphics, using reference attachments. 

 
Regardless of the method used to place the quantities on the cross section sheets, a Sheet Quantity File 
must be generated as described below. 
 
The dialog box items are discussed below: 
 

Write Sheet Quantities File 
Toggle on Write Sheet Quantities File for GEOPAK to create the ASCII text file containing the 
earthwork quantities. 

 
ASCII File 
Key-in the name of the ASCII File that you wish GEOPAK to write the earthwork quantities into. If 
you use the Select button to browse the directory structure for an existing file name, GEOPAK 
will overwrite the file that you select with the new values for this earthwork run. 
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It is recommended you use the name of the COGO chain used to generate the cross sections in 
the filename as shown below. 

 
The remaining items in the dialog box are used to define which volumes you would like to include in the 
ASCII File containing the earthwork calculations. The instructions to set up the ASCII File to contain Cut 
End Areas, Fill End Areas, Cut Volumes and Fill Volumes are as follows: 

Including Common Excavation (Cut) End Areas in the Earthwork ASCII File 

We will store the cut end areas in column one of the earthwork ASCII File. 
 

 Toggle the Column item to 1 
 

 Toggle the Decimal Places option to 0 for projects in English units 
 

 The Total Quantity Length option button is used to define the column width for each earthwork 
type stored in the ASCII File. The default value of 10 should be sufficient 

 
There are three option buttons located at the bottom of the dialog box which allow the user to define 
the Soil Type, Earthwork Operation and Quantity Type. Take the following steps to define the Common 
Excavation end areas: 
 

 Select the Soil Type. The soil types that you have previously defined for the run will be available 
in the left most option button. The soil type 203-EARTH is the only type defined in this example. 

 
 The next option button is used to select the desired Earthwork Operation. For this example, 

select Common Exc. 
 

 The Quantity Type can be selected using the next option button. For this example, select End 
Area. 

 
Select the Add button to include the Common Excavation End Area in the list box, as shown below: 
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Including Fill End Areas in the Earthwork ASCII File 

We will store the Fill end areas in column two of the earthwork ASCII File. 
 

 Toggle the Column item to 2. 
 

 Toggle the Decimal Places option to 0 for projects in English units. 
 

 The Total Quantity Length option button is used to define the column width for each earthwork 
type stored in the ASCII File. The default value of 10 should be sufficient.  

 
There are three option buttons located at the bottom of the dialog box which allow the user to define 
the Soil Type, Earthwork Operation and Quantity Type. Take the following steps to define the Fill end 
areas: 
 

 Select the Soil Type. The soil types that you have previously defined for the run will be available 
in the option button. The soil type 203-EARTH is the only type defined in this example. 

 
 The next option button is used to select the desired Earthwork Operation. For this example, 

select Fill. 
 

 The Quantity Type is selected using the next option button. For this example, select End Area. 
 
Select the Add button to include the options set above for the Fill End Area in the list box as shown 
below: 
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Including Common Excavation (Cut) Volumes in the Earthwork ASCII File 

We will store the Common Excavation volume in column three of the earthwork ASCII File. 
 

 Toggle the Column item to 3. 
 

 Toggle the Decimal Places option to 0 for projects in English units. 
 

 The Total Quantity Length option button is used to define the column width for each earthwork 
type stored in the ASCII File. The default value of 10 should be sufficient.  

 
There are three option buttons located at the bottom of the dialog box which allow the user to define 
the Soil Type, Earthwork Operation and Quantity Type. Take the following steps to define the Common 
Excavation Unadjusted Volumes: 
 

 Select the Soil Type. The soil types that you have previously defined for the run will be available 
in the left most option button. The soil type 203-EARTH is the only type defined in this example. 

 
 The next option button is used to select the desired Earthwork Operation. For this example, 

select Common Exc. 
 

 The Quantity Type is selected using the next option button. For this example, select Unadjusted 
Volumes. 

 
Select the Add button to include the options set above for the Common Excavation Unadjusted Volumes 
in the list box as shown below: 
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Including Fill Volumes in the Earthwork ASCII File 

We will store the Fill Volume in column four of the earthwork ASCII File. 
 

 Toggle the Column item to 4. 
 

 Toggle the Decimal Places option to 0 for projects in English units. 
 

 The Total Quantity Length option button is used to define the column width for each earthwork 
type stored in the ASCII File. The default value of 10 should be sufficient.  

 
There are three option buttons located at the bottom of the dialog box which allow the user to define 
the Soil Type, Earthwork Operation and Quantity Type. Take the following steps to define the Fill 
Unadjusted Volumes: 
 

 Select the Soil Type. The soil types that you have previously defined for the run will be available 
in the left most option button. The soil type 203-EARTH is the only type defined in this example. 

 

 The next option button is used to select the desired Earthwork Operation. For this example, 
select Fill. 

 
 The Quantity Type is selected using the next option button. For this example, select Unadjusted 

Volumes. 
 
Select the Add button to include the options set above for the Fill Unadjusted Volumes in the list box as 
shown below: 
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Sheet Quantity File Format 

When the earthworks run is processed, the Sheet Quantity file is written to the current Working 
Directory. The first few lines of the file are shown below. 
 

000000000000 1111111111 2222222222 3333333333 4444444444 

 

53+00.000/1          73         33          0          0 

53+25.000/1          59         31         61         30 

53+50.000/1          44         33         47         30 

53+75.000/1          35         40         36         33 

54+00.000/1          29         42         29         38 

54+25.000/1          29         40         27         38 

54+50.000/1          32         34         28         35 

 
The first row of the output file is a header row containing the column numbers. Each subsequent row of 
the file contains the following information as defined in the Earthworks dialog box: 
 

Column 0 - The station and region number 
Column 1 - Cut end area for the station 
Column 2 - Fill end area for the station 
Column 3 - Cut unadjusted volume for the station 
Column 4 - Fill unadjusted volume for the station 

 
The procedure to include the sheet quantities on the cross sections sheets is detailed in the next 
chapter. 
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7.4 Processing an Earthworks Run 

After you have configured the various options of the Earthwork dialog box, you are ready to have 
GEOPAK calculate the earthwork quantities. From the GEOPAK Earthwork dialog, select File > Run. This 
will bring up the following dialog box: 

 
An option button is available to allow the user to choose to send error messages to the Screen Only or 
to save error messages in a Log File. To save a log file, select To Log File and key-in the name for the file. 
The log file will be saved in the Working Directory that has been assigned for the project. 
 
The Pause on Each Section option forces the earthworks process to stop at each cross section as it is 
processed. 
 
As the earthworks are processed, GEPOPAK cycles through the cross sections. The Disable View Update 
option will speed up processing the earthwork quantities without waiting for the MicroStation view to 
update. 
 
Select Apply to begin the earthwork calculations. The following dialog box opens: 

 
As the cross sections are processed, the status is displayed in the GEOPAK Process Cross Sections Display 
dialog box, as shown above. When processing is complete, the options Exit or Next Run become 
available for the user to choose from. 
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7.4.1 Diagnosing Problems 

As the cross sections are processed, GEOPAK expects the elements that make up the Existing Ground 
and the Proposed Finished Grade to connect as a continuous string of elements. If there is a gap in the 
elements that make up one of the Soil Types, GEOPAK will alert you of the problem as shown in the 
example below. 

 
In this example, one of the Proposed Finish Grade elements does not connect with another element. 
The DP button can be used to find the location where the problem occurs as follows: 
 

 Select the MicroStation Zoom In command 
 

 Repeatedly pick the Earthwork Error Message DP button until you zoom in close enough to see 
the problem. 

 

 
 
In the example above, the ditch backslope does not tie to the existing ground within the specified 
tolerance. Use the MicroStation Extend Element to Intersect command to resolve the problem. 
 
After the graphics have been corrected, select the Earthwork Error Message Redo button to continue 
processing the earthwork quantities. 
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Exercise 7 

Using this Chapter as a guide, compute the earthwork quantities for S.R. 185. 
 

 Save a Sheet Quantities file 

 Save an Earthworks Log File 

 What folder are these two files written to? 

 Which file contains the grand totals for the earthwork quantities? 
o What is the total excavation for the project? 
o What is the total embankment for the project? 
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7.5 Undercut 

Undercuts are used to define any proposed component which is not part of the finished grade. This 
includes undercuts, proposed topsoil placement, or aggregate quantities. 
 
The ODOT standard criteria file undercut.x can be used to draw undercut on the cross sections. An 
example of the undercut is shown below. 
 

 
 
According to GEOPAK earthwork guidelines, proposed undercuts must connect to another proposed 
undercut or proposed finished grade, not to existing ground. For this reason, it is necessary to define 
two proposed undercut layers. One layer will be the proposed undercut layer (level XS_P_Undercut) 
and the other layer will define the limits of undercut removal (level XS_P_Undercut2).  
 
When processing an earthworks run with undercut, all of the Earthwork dialog box functions should be 
completed as described in the previous sections of this guide with the exception of the Soil Types items.  
 
From the Soil Types portion of the Earthwork dialog box, take the following steps to define the 
symbology of the elements that will make up the first Proposed Undercut layer: 
 

 Select Proposed Undercut from the Class option button as shown on the following page. 
 

 Type in 203-EARTH for the name of the Soil Type. When defining the soil type name for the 
undercut, it is important to remember that the soil type is not the material being removed, but 
what the area will be backfilled with. The material being removed is computed in the default 
excavation unless it is defined as an existing suitable or unsuitable material. 

 
Since there is no item in the Working Alignment Definition for Proposed Undercut, it will be necessary 
to manually assign values for the Level, Weight, Colors, Styles and Types shown under the Search 
Criteria portion of the dialog box. Take the following steps: 
 

 Toggle on these items under the Search Criteria section of the dialog box. 
 

 Press the Match button. The software prompts you to identify and accept an element. When 
accepted, its symbology is added to the Search Criteria and all elements which match the search 
criteria are highlighted. To clear the current search parameters, press the Reset button. 
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 Toggle on the Common Excavation Only option, if desired (see the notes at the end of this 
section about this option). 

 
 Key in the values for the Multiplication Factors, also known as shrink/swell factors, if desired. 

The default values are 1.0. 
 

 After you have defined the parameters for the Proposed Undercut, select the Add button to add 
the Proposed Undercut to the Soil Type Items list box, as shown below: 

 
The steps to define layer two of the Proposed Undercut are the same as the steps used to define the 
first layer, with the exception that you must pick the undercut elements from level XS_P_Undercut2. 
 

 Select Proposed Undercut from the Class option button. 
 

 Type in 203-EARTH for the name of the Soil Type. 
 
Since there is no item in the Working Alignment Definition for Proposed Undercut, it will be necessary 
to manually assign values for the Level, Weight, Colors, Styles and Types shown under the Search 
Criteria portion of the dialog box. 
 

 Press the Reset button to clear the current search parameters. 
 

 Toggle on the items under the Search Criteria section of the dialog box as shown above. Press 
the Match button. The software prompts you to identify and accept an element. When 
accepted, its symbology is added to the Search Criteria and all elements which match the search 
criteria are highlighted. 
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 Toggle on the Common Excavation Only option. if desired (see the notes at the end of this 
section about this option). 

 
 After you have defined the parameters for the second Proposed Undercut, select the Add 

button to add the Proposed Undercut to the Soil Type Items list box. as shown below: 

 
I the Soil Type Items list box, the software will place a number 1 after the first Proposed Undercut and 
will add a number 2 to the second Proposed Undercut as shown above. 
 
An example of the shapes drawn for the undercut is shown below. 
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7.5.1 Undercut Quantities 

If the Earthwork dialog components are completed as described in this section, the undercut quantities 
will be included in both the excavation and fill quantities. That is, the area of the shape for the undercut 
will be counted once for the cut quantities and again for the fill quantities. An example of the quantities 
reported in the earthworks log file is shown below: 
 

 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

REGION = 1 

   64+00.00 203-EARTH 

                Excavation     277.5        236        236   1.00 

                    Fill       189.1        162        162   1.00        0 

                Mass ordinate for 203-EARTH = 546 

 
The undercut quantities can be split as a separate excavation value by use of the Common Excavation 
Only check box. Turning this option off, and changing the Output Format, will separate the undercut 
excavation areas as a separate subgrade excavation quantity. Take the following steps: 
 

 From the Soil Types option, select the Proposed Undercut1 item 
 Toggle off the Common Excavation Only option 
 Select the Modify button to accept the change 
 Repeat these steps for the Proposed Undercut2 item 
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Next change the Output Format for the earthwork quantities. Take the following steps: 
 

 From the Output Format item, use the < or > buttons to set the output as shown below: 

 
When the earthworks quantities are processed, the earthwork log file will now report the undercut 
excavation as a separate subgrade excavation quantity, as shown in the example below. The backfilling 
of the undercut area is still included in the Fill quantity for the soil type. 
 

 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

REGION = 1 

   64+00.00 203-EARTH 

                Common Exc     163.9        136        136   1.00 

              Subgrade Exc     113.6        100        100   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill       189.1        162        162   1.00        0 

                Mass ordinate for 203-EARTH = 546 
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Including the Undercut in the Sheet Quantities 

When the Sheet Quantity option is selected, the Earthwork dialog box will appear as shown below: 

 
In addition to the columns previously defined for 203-EARTH quantities, it may be necessary to define 
additional columns to account for the undercut quantities as discussed below. 
 
Case 1: If the Soil Type items for the undercut were defined with Common Excavation Only toggled on, 
the excavation quantities for the undercut are included with the quantities reported for the Common 
Excavation and no additional steps are necessary. 
 
Case 2: If the Soil Type items for the undercut were defined with Common Excavation Only toggled off, 
the excavation quantities for the undercut are tabulated separately and must be combined with the 
Common Excavation values for the sheet quantities. Take the following steps to combine the quantities: 

Column 1 

The excavation for the undercut is reported as Subgrade Excavation. This value must be added to the 
203-EARTH Common Exc value, which has been previously defined in Column 1 of the ASCII File, to 
tabulate the total excavation area for the cross section. To add the end area for the undercut to the 203-
EARTH Common Excavation End Area, take the following steps: 
 

 Toggle the Column item to 1 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type “203-EARTH” 
 Toggle the Earthwork Operation item to Subgrade Exc 
 Toggle the Quantity Type to End Area 
 Toggle the +/- option to +. This is used to add together values defined for the same column 
 Select the Add button to add the item to the list 

 
The excavation value for the undercut is included in the list as shown on the following page. 
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Column 3 

Column 3 has been previously defined to contain the Common Exc Unadjusted Volume. To add the 
volume items for the undercut to the 203-EARTH Common Exc volume, take the following steps: 
 

 Toggle the Column item to 3 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type “203-EARTH” 
 Toggle the Earthwork Operation item to Subgrade Exc 
 Toggle the Quantity Type to Unadjusted Volume 
 Toggle the +/- option to +. This is used to add values defined for the same column together 
 Select the Add button to add the item to the list 

 
The excavation value for the undercut is included in the list as shown below. 

 

Column 2 and Column 4 

There is no need to define additional items for the Fill quantities in Columns 2 and 4. GEOPAK 
automatically includes the subgrade excavation areas in the fill quantities for the cross sections. 
 
After defining the Sheet Quantity items, continue to process the earthworks run as defined previously in 
this training guide. The quantities contained in the ASCII file will now account for the undercut end areas 
and volumes. 
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7.6 Special Benching 

Special benching should be used whenever the designer anticipates that there will be a stability problem 
and/or weak soils are present in an existing slope. See the Geotechnical Bulletin GB 2 for more 
information on special benching. 
 
When special benching is required, the designer must draw the benching manually. At this time, there 
are no criteria files provided by ODOT to draw the special benching. 
 
The level XS_P_Special_Benching is provided to draw the benching. An example is show below. 
 

 
 
As shown in the example above, the elements drawn to designate the special benching must be drawn 
so that they connect to the existing ground to form a closed shape. 
 
Tabulation of the earthwork quantities by GEOPAK will be described in the following pages of this 
section. 
 

7.6.1 Functional Classes 

In addition to the functional classes discussed earlier, GEOPAK allows users to designate specific areas as 
suitable or unsuitable materials. Areas designated as unsuitable, such as the special benching area, must 
be backfilled with a suitable material. 
 
When the earthworks are computed, unsuitable areas are computed as part of the excavation quantity 
and also as part of the fill since these areas must be filled with a suitable material. 
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7.6.2 Excavation Limits 

Excavation limits are designated by drawing lines on the cross sections which define the horizontal limits 
of existing suitable or unsuitable material. Excavation limits are required by GEOPAK whenever existing 
suitable or unsuitable classifications are used. 
 
A sample cross section with excavation limits drawn is shown below. 
 

 
 
The following rules apply when using excavation limits: 
 

1. Excavation limits must be used in pairs on the cross sections. An odd number of limits is not 
supported. 
 

2. The limits must be drawn as line elements. Line strings, curves, curve strings, etc. are not 
supported. 
 

3. Excavation limits must intersect the existing ground line. In cases where the suitable or 
unsuitable areas are not defined as closed shapes (e.g. muck or rock), the excavation limits must 
intersect these elements to form a closed shape. 

 
 The level XS_P_Excavation_Limits has been designated for drawing the excavation limits. 
 
The ODOT criteria file Excavation_Limits.x can be used to draw the excavation limits at a set offset on 
the cross sections. See the criteria documentation on the ODOT CADD Support website for details. 
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7.6.3 Configuring an Earthworks Run for Special Benching 

To compute earthwork quantities for the special benching areas, the earthworks run must be configured 
to compute the cut and fill quantities as previously described. 

Soil Types 

In the Earthwork dialog box, select the Soil Types item. The previous definitions for the Existing Ground 
and the Proposed Finished Grade are saved in the Earthwork Run as shown below: 

 
Two additional classes must be defined in the Soil Types portion of the Earthwork dialog box to 
compute the special benching area; one to define the special benching and another to define the 
excavation limits. Take the following steps to define the elements which make up the special benching: 
 

 Select the Existing Unsuitable option from the Class drop option button 
 Use a new Soil Type name to compute the special benching. The name “SPEC_BENCHING” is 

used in the example above. 
 Define the symbology for the special benching items. 
 Select the Add button to add the Existing Unsuitable item to the list of Soil Type Items. 

 
Take the following steps to define the Excavation Limits: 
 

 Select the Excavation Limit option from the Class drop down menu. 
 Define the symbology for the excavation limit elements. 
 Select the Add button to add the Excavation Limit item to the list of Soil Type Items. 
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The settings for the Excavation Limits are shown below. 

 

Earthwork Shapes 

When computing earthwork quantities using multiple soil types, it is advisable to toggle on the Stratify 
Shape Color option. This option is used to the draw various cut and fill areas using unique colors in the 
cross sections. 
 
Using the order within the Soils Type dialog, GEOPAK assigns (in ascending numerical order) each 
material type two colors, one for cut and one for fill. Color assignments initialize at zero, regardless of 
the color defined in the plot parameters of the Draw Earthwork Shapes symbology box. 

 
 
 



October, 2012 Ohio Department of Transportation, GEOPAK Road Training Guide 

 

 
Chapter 7 – Earthwork Quantities Page 7-37 
 

Double-click the Parameters symbology box, to the right of the Draw Earthwork Shapes toggle, to 
access the Set Feature dialog box shown below.  

 
The level XS_P_Earthwork_Shapes has been designated for the placement of the Earthwork Shapes. 
 

Output Format 

The Output Format portion of the Earthwork dialog box is used to define how the quantities will be split 
in the earthworks log file. When the Output Format option is selected, the Earthwork dialog will appear 
as shown below: 

 
Use the < > arrows to scroll through the available options to select Excavation, Subsoil Exc, and Fill, as 
shown in the example above. 
 
Note: Even though Excavation Limits are required when computing earthworks including Existing 
Suitable or Existing Unsuitable areas, it is not necessary to toggle on the Calculate only between 
Excavation Limits option unless you specifically want to restrict the computation to the excavation limits 
for staged construction estimates, or to separate quantities for multiple alignments shown on the same 
cross section. 
 
When the earthwork quantities are computed, the excavation, fill, and special benching areas are drawn 
similar to the example below. The colors may vary depending on the number and order of the Soil Type 
items defined for the earthworks run. 
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The quantities are split by the Soil Types in the earthwork log file as shown in the example below: 
 

 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

REGION = 1 

   53+00.00 203-EARTH 

                Excavation      71.6          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill        67.8          0          0   1.00        0 

                Mass ordinate for 203-EARTH = 0 

            SPEC-BENCHING 

                Excavation       0.9          0          0   1.00 

               Subsoil Exc      34.8          0          0   1.00 

                    Fill         0.0          0          0   1.00        0 

                Mass ordinate for SPEC-BENCHING = 0 

 

 
The special benching area beneath the proposed pavement will be excavated, and then backfilled. The 
quantities reported in the Log file must be added together to compute the end areas for the x-sections: 
 

Excavation Quantities 
The Excavation quantity for the cross section is determined as follows: 
 
203-EARTH Excavation + SPEC_BENCHING Excavation + SPEC_BENCHING Subsoil Exc = Total 
 
Fill Quantities 
The Fill area reported for the soil type 203-EARTH is the total for the cross section. The GEOPAK 
earthwork process will automatically include the SPEC_BENCHING Subsoil Exc quantity, which is 
to be backfilled, in the 203-EARTH total. 
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Including the Special Benching in the Sheet Quantities 

When the Sheet Quantity option is selected, the Earthwork dialog box will appear as shown below: 

 
In addition to the columns previously defined for 203-EARTH quantities, it is necessary to define 
additional columns to account for the special benching quantities as discussed below. 

Column 1 

The excavation for the Special Benching is reported as two values, for Excavation and Subsoil Excavation, 
as previously detailed. Both of these values must be added to the 203-EARTH Common Exc value, which 
has been previously defined in Column 1 of the ASCII File, to tabulate the total excavation area for the 
cross section. To add the end area items for the Special Benching to the 203-EARTH Common Excavation 
End Area, take the following steps: 
 

 Toggle the Column item to 1 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type “SPEC_BENCHING” 
 Toggle the Earthwork Operation item to Common Exc 
 Toggle the Quantity Type to End Area 
 Toggle the +/- option to +. This is used to add together values defined for the same column 
 Select the Add button to add the item to the list 
 Toggle the Earthwork Operation item to Subsoil Exc 
 Select the Add button to add the item to the list.  

 
The excavation values for the Special Benching are both included in the list as shown below. 
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Column 3 

Column 3 has been previously defined to contain the Common Exc Unadjusted Volume. To add the 
volume items for the Special Benching to the 203-EARTH Common Exc volume, take the following steps: 
 

 Toggle the Column item to 3 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type SPEC_BENCHING 
 Toggle the Earthwork Operation item to Common Exc 
 Toggle the Quantity Type to Unadjusted Volume 
 Toggle the +/- option to +. This is used to add values defined for the same column together 
 Select the Add button to add the item to the list 
 Toggle the Earthwork Operation item to Subsoil Exc 
 Select the Add button to add the item to the list 

 
The Unadjusted Volume items for the Special Benching are added to the list as shown below. 

 

Column 2 and Column 4 

There is no need to define additional items for the Fill quantities in Columns 2 and 4. GEOPAK 
automatically includes the subsoil excavation areas in the fill quantities for the cross sections. 
 
After defining the Sheet Quantity items, continue to process the earthworks run as defined previously in 
this training guide. The quantities contained in the ASCII file will now account for the special benching 
end areas and volumes. 
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7.7 Concrete Removal 

The ODOT criteria file pavt_exist2.x is used to draw the existing pavement on the cross sections. The 
criteria file can also be configured draw concrete removal areas as shown in the example below. 
 

 
 
In this example, the quantities will be tabulated as follows: 
 

 The earthwork will be computed using Item 203 Excavation and Item 203 Embankment 

 The existing asphalt pavement will be removed using Item 202 Pavement Removal, Asphalt 

 The existing concrete pavement will be removed using Item 202 Pavement Removal 

 The backfill of the existing pavement removal will be paid for using item 203 Embankment 
 
Each of these material types must be defined as a Soil Type in the GEOPAK Earthworks dialog box. 

7.7.1 Soil Types 

The Excavation and Embankment have been defined using a soil type named “203-EARTH” as previously 
defined in this document. 
 
Additional soil types must be defined to form a closed shape for each Soil Type that is used to define the 
existing pavement. Soil Types are defined identifying the elements that make up the bottom of each soil 
type definition. The symbology of the elements that make up the top of each soil type do not need to be 
defined. 
 
The existing asphalt and concrete removal will be defined as unique soil types using the elements 
identified below. 
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The ODOT standard criteria file pavt_exist2.x has been configured to draw the existing pavement 
elements shown above using the following symbology: 
 

 Level Color Weight Style 

 Asphalt Pavement and Shoulders XS_X_Pavt 0 0 3 

Concrete Pavement XS_X_Pavt 36 0 3 

 

7.7.2 Defining the Asphalt Pavement Soil Type 

The Soil Type for the existing asphalt pavement is defined as shown below: 

 
 Select the Existing Suitable option from the Class drop down menu, as shown above, to define 

the asphalt pavement elements. 
 Define a new Soil Type name for the concrete removal. The name “ASPHALT” is used in the 

example above. 
 Define the symbology for the asphalt pavement. 
 Select the Add button to add the Existing Suitable item to the list of Soil Type Items. 

 
Note: The elements that make up the bottom of each soil type are the key elements that must be 
singled out in the symbology list. It is not necessary to define the symbology for the elements that make 
up the top of the soil type. 
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7.7.3 Defining the Concrete Removal Soil Type 

The Soil Type for the concrete removal is defined as a new soil type as shown below: 

 
 Select the Existing Unsuitable option from the Class drop down menu. 
 Define a new Soil Type name for the concrete removal. The name “CONCRETE” is used in the 

example above. 
 Define the symbology for the concrete removal item. 
 Select the Add button to add the Existing Unsuitable item to the list of Soil Type Items. 

 
Notes: 
It is only necessary to define the symbology for the bottom of the CONCRETE soil type. GEOPAK always 
identifies areas by the elements that constitute the bottom of a closed area. 
 
Unsuitable materials that are removed below the proposed pavement will always be backfilled using the 
Common Fill material, which has been previously defined as the Soil Type 203-EARTH. 
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7.7.4 Defining the Excavation Limits 

Excavation Limits are required whenever the Existing Suitable or Existing Unsuitable items are used. 
Take the following steps to define the Excavation Limits: 
 

 Select Excavation Limit from the Class option button. 
 Define the symbology for the excavation limit elements. 
 Select the Add button to add the Excavation Limit item to the list of Soil Type Items. 

 
The settings for the Excavation Limits are shown below: 
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7.7.5 Processing Notes 

The concrete removal areas can interface with the proposed cross section in one of three conditions, as 
detailed below: 
 
Case 1: The proposed finished grade is below the existing pavement. The asphalt and concrete removal 
areas are totally enclosed by the excavation for the proposed cross section. 

 
In the example above, three shapes are drawn on the cross section. 
 
An example of earthwork quantities reported in the Earthwork Log file is shown below: 
 

 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

   56+50.00 203-EARTH 

                Common Exc      63.4         55         55   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill         0.0          0          0   1.00      -15 

            ASPHALT 

                Common Exc      18.2         17         17   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill         0.0          0          0   1.00        2 

            CONCRETE 

                Common Exc      36.7         34         34   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill         0.0          0          0   1.00        2 

                Mass ordinate for CONCRETE = 475 

 
The values reported in the Earthwork Log file are split by Excavation, Subsoil Excavation, and Fill for 
each Soil Type. In Case 1, everything is in cut so all the values are reported as Excavation quantities. 
 
The areas for the ASPHALT Excavation and the CONCRETE Excavation are not included in the total for the 
203-EARTH Excavation. 
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Case 2: The concrete removal, asphalt removal, or both are bisected by the proposed finished grade. 

 
In the example above, eight shapes are drawn on the cross section delineating the earthwork areas. The 
values are reported in the Earthwork Log file, as shown below: 
 

 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

   55+25.00 203-EARTH 

                Common Exc      29.8         26         26   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill        35.0         38         38   1.00     -237 

            ASPHALT 

                Common Exc      16.0         14         14   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill         0.0          0          0   1.00     -223 

            CONCRETE 

                Common Exc      13.2          9          9   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc      23.5         24         24   1.00 

                    Fill         0.0          0          0   1.00     -223 

                Mass ordinate for CONCRETE = 305 

 
Notes about the quantities: 
 

 The portion of the concrete pavement beneath the proposed cross section is reported as a 
“Subsoil Exc” item. 

 The total concrete removal area for this cross section is obtained as follows: 
 

CONCRETE Excavation + CONCRETE Subsoil Exc = Total Concrete Removal 
 

 Had the proposed cross section intersected the asphalt removal area, the quantities for the 
ASPHALT item would have been split between the ASPHALT Excavation and Subsoil Exc items. 

 The 203-EARTH Fill end area automatically includes the Subsoil Exc totals for the ASPHALT and 
the CONCRETE soil types. There is no need to add the Subsoil Exc values to the 203-EARTH Fill 
area to obtain the total. 

 The ASPHALT Soil Type has been defined as an Existing Suitable material. As such, any portion of 
the material that is below the proposed subgrade is left in place. If you wish to have the 
ASPHALT removed, and subsequently backfilled, the ASPHALT Soil Type would need to be 
defined as an Existing Unsuitable material. 
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Case 3: The proposed finished grade is above the existing pavement. The asphalt and concrete removal 
areas are both beneath the proposed cross section. 

 
In the example above, four shapes are drawn on the cross section. The shapes for the asphalt and 
concrete removal areas are drawn with the same color as the fill area. 
 
The excavation and fill values are reported in the earthworks log file as shown below. 
 

 

            Material Name    End Areas  Unadjusted Adjusted   Mult   Mass 

Station                                 Volumes    Volumes    Factor Ordinate 

                             (sq. ft.)  (cu. yd.)  (cu. yd.)                  

----------- ---------------- ---------- ---------- ---------- ------ -------- 

   60+00.00 203-EARTH 

                Common Exc      11.7         15         15   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc       0.0          0          0   1.00 

                    Fill       143.7        106        106   1.00     1356 

            ASPHALT 

                Common Exc       0.0          1          1   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc      18.2         16         16   1.00 

                    Fill         0.0          0          0   1.00     1373 

            CONCRETE 

                Common Exc       0.0          0          0   1.00 

              Subgrade Exc       0.0          0          0   1.00 

               Subsoil Exc      36.6         34         34   1.00 

                    Fill         0.0          0          0   1.00     1373 

                Mass ordinate for CONCRETE = 950 

 
Notes about the quantities: 
 

 The ASPHALT Subsoil Exc and the CONCRETE Subsoil Exc totals are included in the 203-EARTH Fill 
total. 
 

 Even though the ASPHALT soil type has been defined as an Existing Suitable material, it must be 
removed to get to the Existing Unsuitable CONCRETE soil type that is below it. 

 
 
 
 
 
 
 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page 7-48 Chapter 7 – Earthwork Quantities  
 

7.7.6 Earthwork Log File: Grand Summary Totals 

The Earthwork Log file includes a summary total, as shown in the example below: 
 

 

                 G R A N D     S U M M A R Y     T O T A L S 

               Material Name         Unadjusted Adjusted   Mult 

                                     Volumes    Volumes    Factor 

                                     (cu. yd.)  (cu. yd.) 

        ---------------------------- ---------- ---------- ------ 

        203-EARTH 

                          Common Exc       5795       5795   1.00 

                        Subgrade Exc          0          0   1.00 

                         Subsoil Exc          0          0   1.00 

                            Fill          10972      10972   1.00 

        ASPHALT 

                          Common Exc        513        513   1.00 

                        Subgrade Exc          0          0   1.00 

                         Subsoil Exc        839        839   1.00 

                            Fill              0          0   1.00 

        CONCRETE 

                          Common Exc        602        602   1.00 

                        Subgrade Exc          0          0   1.00 

                         Subsoil Exc       2206       2206   1.00 

                            Fill              0          0   1.00 

 
Additional notes about the totals: 
 
These notes apply to the Grand Summary Total, as well as the totals for the individual cross sections. 
 

 The 203-EARTH Fill total includes the ASPHALT Subsoil Exc and the CONCRETE Subsoil Exc totals. 
 

 If the backfilling of the existing concrete pavement removal is to be included with Item 202 
Pavement Removal, it will be necessary to adjust the 203-EARTH Fill values as follows: 
 

203-EARTH Fill – CONCRETE Subsoil Exc = 203-EARTH total 
 
If the existing asphalt pavement is also to be backfilled using item 202, include it in the adjusted 
total as follows: 
 

203-EARTH Fill – CONCRETE Subsoil Exc – ASPHALT Subsoil Exc = 203-EARTH total 
 

 The total ASPHALT removal volume is obtained by adding the ASPHALT Excavation and ASPHALT 
Subsoil Exc values together. 
 

 If the ASPHALT is to be removed as part of the 203 Excavation, the values must be added 
together as follows: 

 
203-EARTH Excavation + ASPHALT Excavation +ASPHALT Subsoil Exc = Total Excavation 

 

 The total CONCRETE removal volume is obtained by adding the CONCRETE Excavation and 
CONCRETE Subsoil Exc values together. 
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7.7.7 Including the Concrete Removal in the Sheet Quantities 

When the Sheet Quantities option is selected, the Earthwork dialog box will appear as shown below: 

 
In addition to the columns previously defined for 203-EARTH excavation and fill quantities, it may be 
necessary to define additional columns to account for the asphalt and concrete removal, depending on 
how you wish to tabulate the quantities for your project. 

Column 1 

In the example above, Column 1 has been previously defined to contain the Common Exc End Area for 
the Soil Type 203-EARTH. 
 
If the existing asphalt pavement is removed using Item 202 Pavement Removed, Asphalt, there is no 
need to make adjustments to the sheet quantities. 
 
If the existing asphalt pavement is to be removed as part of the 203 Excavation item, the total 
excavation area for the cross section is computed as follows: 
 

203-EARTH Common Exc + ASPHALT Common Exc + ASPHALT Subsoil Exc = Total Excavation 
 
Take the following steps to add the ASPHALT Common Exc End Area to the list: 

 Toggle the Column item to 1 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type “ASPHALT” 
 Toggle the Earthwork Operation item to Common Exc 
 Toggle the Quantity Type to End Area 
 Toggle the +/- option to +. This is used to add values defined for the same column together 
 Select the Add button to add the item to the list 
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Next, add the ASPHALT Subsoil Exc End Area to the list: 
 Toggle the Earthwork Operation item to Subsoil Exc. 
 Select the Add button to add the item to the list. 

 
Both items are now included in the list, as shown below: 

 

Column 2 

Column 2 has been previously defined to contain the 203-EARTH Fill End Area. As stated previously, the 
Fill quantity includes the areas for the ASPHALT and CONCRETE Subsoil Exc totals. If these areas are to 
be backfilled using Item 203 Embankment, no additional computation is necessary. 
 
If the pavement removal is to be backfilled using Item 202, then these areas must be subtracted from 
the 203-EARTH Fill total. Take the following steps to subtract the ASPHALT Subsoil Exc area: 

 Toggle the Column item to 2 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type “ASPHALT” 
 Toggle the Earthwork Operation item to Subsoil Exc 
 Toggle the Quantity Type to End Area 
 Toggle the +/- option to (-) to subtract the item from other values defined for the same column 
 Select the Add button to add the item to the list 

 
Next, add the CONCRETE Subsoil Exc End Area to the list: 

 Select the Soil Type “CONCRETE” 
 Toggle the Earthwork Operation item to Subsoil Exc 
 Select the Add button to add the item to the list as shown below 

 
Both items are now included in the list as shown below. 
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Column 3 

Column 3 has been previously defined to contain the Common Exc Unadjusted Volume for the Soil Type 
203-EARTH.  
 
If the existing asphalt pavement is removed using Item 202 Pavement Removed, Asphalt, there is no 
need to make adjustments to the sheet quantities. 
 
If the existing asphalt pavement is to be removed as part of the 203 Excavation item, the total 
excavation volume for the cross section is computed as follows: 
 

203-EARTH Common Exc + ASPHALT Common Exc + ASPHALT Subsoil Exc = Total Excavation 
 
Take the following steps to add the ASPHALT Common Exc Unadjusted Volume to the list: 
 

 Toggle the Column item to 3 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type “ASPHALT” 
 Toggle the Earthwork Operation item to Common Exc 
 Toggle the Quantity Type to Unadjusted Volumes 
 Toggle the +/- option to (+) to add values defined for the same column together 
 Select the Add button to add the item to the list as shown below 

 
Next, add the ASPHALT Subsoil Exc Unadjusted Volume to the list: 
 

 Toggle the Earthwork Operation item to Subsoil Exc 
 Select the Add button to add the item to the list as shown below 

 
Both items are now included in the list as shown below. 
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Column 4 

Column 4 has been previously defined to contain the 203-EARTH Fill Unadjusted Volume. As stated 
previously, the Fill quantity includes the volumes for the ASPHALT and CONCRETE Subsoil Exc totals. If 
these areas are to be backfilled using Item 203 Embankment, no additional computation is necessary. 
 
If the pavement removal is to be backfilled using Item 202, then these volumes must be subtracted from 
the 203-Earth Fill Unadjusted Volume total. Take the following steps to subtract the ASPHALT Subsoil 
Exc volumes: 
 

 Toggle the Column item to 4 
 Toggle the Decimal Places item to 0 
 Select a value of 10 for the Total Quantity Length 
 Select the Soil Type “ASPHALT” 
 Toggle the Earthwork Operation item to Subsoil Exc 
 Toggle the Quantity Type to Unadjusted Volume 
 Toggle the +/- option to (-) to subtract the item from other values defined for the same column 
 Select the Add button to add the item to the list 

 
Next, add the CONCRETE Subsoil Exc End Area to the list: 
 

 Select the Soil Type “CONCRETE” 
 Select the Add button to add the item to the list as shown below 

 
Both items are now included in the list as shown below. 

 
After defining the Sheet Quantity items, continue to process the earthworks run as defined previously in 
this training guide. The quantities for the ASCII file will now include the concrete removal end areas and 
volumes. 
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8 Seeding Quantities 

8.1 Overview 

GEOPAK provides the capability to calculate seeding quantities from cross section elements and save 
them to an ASCII text file. GEOPAK currently does not provide the capability to place seeding quantities 
from the seeding report file onto the cross section sheets. 
 
 

8.2 Generating Seeding Quantities 

To generate a seeding report, select Reports and XS Quantities from the Road Project dialog to access 
the XS Report dialog shown on the following page. 
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Select Seeding from the XS Report dialog to access the Seeding Report dialog shown at right below. 

 
Information stored in the GEOPAK Project Manager Working Alignment Definition can be shared with 
the Seeding Report dialog box. The following information is taken from the active Working Alignment 
definition: 
 

 Job - The GEOPAK COGO data base job number. 
 

 Chain - The name of the COGO Chain from which to extract seeding quantities. 
 

 Beg Station - The station of the first cross section available for the selected chain. 
 

 End Station - The station of the last cross section available for the selected chain. 
 

 Existing Ground Line - The symbology for the cross section elements that make up the existing 
ground.  

 
 Proposed Finish Grade - The symbology for the cross section elements that make up the 

proposed grade. 
 
The remaining dialog box items are described below. 
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Report Decimal 

 
The Report Decimal (number of decimal places for the slope distance values) options range 
from zero to six. All area calculations are based upon this rounded value. 
 
Candidate Seeding Elements 
This section is used to define the symbology of the cross section elements that will be used by 
GEOPAK to calculate the seeding quantities. Press the Match button. The software prompts you 
to identify and accept an element. When accepted, its symbology is added to the Candidate 
Elements dialog as shown below. 
 
ODOT’s criteria files place graphics that can be used as the Candidate Seeding Elements on the 
following levels: 

 
o XS_P_Finished_Grade 
o XS_P_Finished_Grade_Seeded 
o XS_P_Ditch_Bottom 

 
Max Allowable Slope 

 
This option dictates the maximum slope that will be included in the calculations. For example, if the 
Maximum Allowable Slope is set to 2:1 (Run:Rise), then a cross-section element with a slope of 1:1 will 
not be included in the calculations. Two key-in fields are provided for the values and an option button 
specifies Run:Rise or Rise:Run. If this option is desired, simply activate the toggle to the left. 
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Subtotal Split Slope 

 
This feature (when activated by the toggle to the left) will split the area quantities based on the 
provided slope. For example, if the specified Subtotal Split Slope is 3:1, then the area quantities will be 
split into areas steeper than 3:1 slope and areas flatter than or equal to a 3:1 slope. 
 
Subtotals are provided at the user-defined intervals defined by Sub Every key-in field. The Incr or Even 
option button specifies whether the distances should be calculated along the alignment or whether the 
distances should be rounded to the even station. The First Sub At key-in field identifies the first subtotal 
station as well as the station from which subtotals are calculated. 
 
 
Scale Factor 

 
By default GEOPAK will report seeding areas in square feet. For ODOT plans the seeding areas should be 
reported in square yards. This can be accommodated by use of the Scale Factor option. To force 
GEOPAK to report seeding areas in square yards, change the Scale Factor and Label settings to those 
shown above. 
 
ByPass Segments 
Pressing the ByPass Segments opens the dialog shown below: 

 
Any combination of the four options can be activated via the toggle(s) to the left. To determine whether 
the cross-section is in Cut or Fill, the software examines the segments that tie to existing ground. When 
the software encounters a condition that has been activated, it will ignore the specified number of 
segments at the tie down point that extend towards the centerline. 
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Additional Distance 
Pressing the Additional Distance push button opens the following dialog. 

 
Any combination of the three options can be activated via the toggle(s) to the left. To determine 
whether the cross-section is in Cut or Fill, the software tests segments that tie to existing ground. When 
the software encounters an activated condition, it will add (or subtract if the value is a negative number) 
the specified horizontal distance value (in master units) to the measured distance on the cross-section. 
 
 
Additional Distance via Station 
If the additional seeding is not consistent throughout the project, pressing the Additional Distance via 
Station button invokes the dialog shown below, where Additional Distances can be specified by station 
range, right, left, or right and left. 

 
Key-in the desired stations and Width, and then select the Side option. Press the Add button, which 
populates the list box. To modify a line, highlight the line, which populates the edit fields. Make the 
desired change, and then press the Modify button. The list box updates to the edited data. To delete a 
line, simply highlight the line, then press the Delete button. 
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Pause on Each XS 

 
An option for processing sections one at a time may be used by activating the Pause on Each XS toggle. 
When activated, GEOPAK will process the first section, display the cross-section on the screen (within 
the limits of the cell), and display the station in the Current Sta display field located at the top of the 
dialog. The elements specified in the search criteria are also highlighted. To continue to the next cross-
section, simply press the Apply button on the bottom of the dialog. 
 
 
ASCII File 

 
At the bottom of the dialog, you can specify the name of the ASCII file to be generated. The designer has 
the option of keying in the file name, or upon selection of the File button, the Files dialog will appear, 
allowing the designer to select the desired file. The file will be placed in the working directory, if a full 
path is not specified. If the specified file name already exists, the file will be overwritten with no warning 
message given. 
 
 
Apply 

 
When the dialog has been completed, simply select the Apply button to begin the report generation. A 
portion of the seeding report is shown on the following page. 
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                                                                                                    Page# 1      

                                                        SEEDING REPORT 

 

NUMBER OF LEFT  CUT  SLOPES TO BE BYPASSED             = 0       

NUMBER OF LEFT  FILL SLOPES TO BE BYPASSED             = 0       

NUMBER OF RIGHT CUT  SLOPES TO BE BYPASSED             = 0       

NUMBER OF RIGHT FILL SLOPES TO BE BYPASSED             = 0       

ROUNDING DISTANCE FROM CUT SLOPE STAKE                 = 0.00           Ft  

MAXIMUM ALLOWABLE SLOPE FOR SEEDING/SODDING            = ****  

ADDITIONAL SEEDING    LEFT   SIDE                      = 0.00           Ft 

ADDITIONAL SEEDING    RIGHT  SIDE                      = 0.00           Ft 

ADDITIONAL SEEDING IN CUT                              = 10.00          Ft 

ADDITIONAL SEEDING IN FILL                             = 10.00          Ft 

SUBTOTALS EVERY     500.0000 Ft BEGINNING AT STATION 53+00.000 R 1 METHOD INCR 

SCALING FACTOR   =        0.11111   WITH LABEL  [ SY ] 

 

 

STATION             SLOPE DISTANCE  AVERAGE SLOPE DIST        A R E A      SY    SUBTOTAL  A R E A    SY 

                     LT       RT      LT       RT          LT      RT      BOTH    LT         RT      BOTH  

                       (TOTAL)   

 

 

53+00.000 R 1         35       42                                                      0        0        0 

                    (      77)          35        42       97      117      214 

53+25.000 R 1         34       42 

                    (      76)          34        42       94      117      211 

53+50.000 R 1         33       42 

                    (      75)          33        43       92      119      211 

53+75.000 R 1         33       43 

                    (      76)          33        43       92      119      211 

54+00.000 R 1         32       42 

                    (      74)          32        42       89      117      206 
 
The report is separated into columns with the various quantities. For ODOT cross section sheets, the 
SLOPE DISTANCE (TOTAL) and the SY BOTH values are to be shown on the final cross section sheets. 
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8.3 Adding Seeding Quantities to the Cross Section Sheets 

When cross section sheets are generated, GEOPAK provides the ability to add the earthwork quantities 
to the cross section sheets by reading an earthworks report file. However, GEOPAK does not provide the 
capability to automatically place seeding quantities on the cross section sheets directly from the seeding 
report. The following options are available to place the seeding quantities on the cross section sheets: 
 

 The seeding quantities can be added to the Earthworks report, using an ODOT provided 
program, and subsequently placed on the cross section sheets. This procedure is detailed in 
Chapter 10 of this guide. 

 

 Users can manually place the seeding quantities on the cross sections sheets using MicroStation 
commands as detailed below. 

8.3.1 Manually Placing Seeding Quantities on Cross Section Sheets 

The first two stations from a sample seeding report are shown below. 
 
STATION             SLOPE DISTANCE  AVERAGE SLOPE DIST        A R E A      SY    SUBTOTAL  A R E A    SY 

                     LT       RT      LT       RT          LT      RT      BOTH    LT         RT      BOTH  

                       (TOTAL)   

 

 

53+00.000 R 1         35       42                                                      0        0        0 

                    (      77)          35        42       97      117      214 

53+25.000 R 1         34       42 

                    (      76)          34        42       94      117      211 
 
For ODOT cross section sheets, the SLOPE DISTANCE (TOTAL) and the SY BOTH values are to be shown 
on the final cross section sheets. 
 
Placing the End Width Quantity 
The quantity at station 53+00 R 1 under the heading "SLOPE DISTANCE" represents the seeding end 
width for the "LT" and "RT" sides of the cross section. Directly beneath the individual left and right side 
quantities is the (TOTAL) quantity for the station. This quantity should be placed on the cross sections in 
the End Width column as shown in the example on the following page. 
 
Placing the End Area Quantity 
The quantity at station 53+00 R 1 shown under the heading “SY Both” represents the seeding area 
between stations 53+00 R 1 nd 53+50 R 1. This quantity should be placed in the cross section in the SQ. 
YDS. column as shown in the example on the following page. 
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Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page 8-10 Chapter 8 – Seeding Quantities 
 

Exercise 8 

Using the chapter as a guide, generate the seeding quantities for S.R. 185. 
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9 Limits of Construction 

9.1 Overview 

Two options are available to plot the construction limits in the plan view basemap file. Each option has 
advantages and disadvantages as described below: 
 
GEOPAK Limits of Construction 
Construction limits can be automatically plotted in the plan view design file using the GEOPAK Limits of 
Construction command. This command is used to locate the tie down points where the proposed cross 
section graphics meet the existing ground line. The offset from the cross section centerline to the tie 
down point is measured and a line is placed in the Plan View design file using these offsets. 

 
Advantages 

 The construction limits are generated directly from the tie down points of the proposed 
cross section graphics. Manual edits to the cross sections are automatically accounted 
for when the construction limits are processed. 
 

Disadvantages: 

 Typically construction limit lines are shown an additional four feet outside the tie down 
points. Unfortunately, the GEOPAK Limits of Construction command cannot 
accommodate placing the construction limit lines an additional distance from the tie 
down points. It is necessary to use the Move Parallel command to offset the 
construction limit graphics after they have been plotted in the plan view basemap. 

 
Criteria “Key Point” Text 
ODOT’s side slope criteria files place a piece of text on each cross section at the construction limit 
location. The offset of these text elements can be read from the cross sections to generate a COGO 
chain representing the construction limit line. The GEOPAK Design and Computation Manager can be 
used to plot the construction limit chains in the plan view basemap. 
 

Advantages: 

 The construction limit text is placed at an offset from the tie down point. The offset 
value is defined during the criteria processing. There is no need to use the Move Parallel 
command to modify the construction lines in the plan view once then have been 
plotted. 

 
Disadvantages: 

 If the cross section graphics are manually edited the user must also modify the location 
of the key point text. The text must be moved carefully as the text origin must fall 
directly on the existing ground line in order for GEOPAK to recognize it. 

 
The method used is a matter of personal preference. Each method is presented in the following 
sections. 
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9.2 GEOPAK Limits of Construction 

The Limits of Construction dialog is accessed from the Road Project dialog as shown below. 

 
It can also be accessed by selecting Applications > Road > Cross Sections > Limits of Construction. After 
creating a new Run, the dialog below is opened. 

 
The following dialog items are read from the current GEOPAK Working Alignment definition: 
 

 Job - The GEOPAK COGO data base job number. 
 

 Chain - The name of the COGO Chain from which to extract seeding quantities. 
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 Beg Sta - The station of the first cross section available for the selected chain. 
 

 End Sta - The station of the last cross section available for the selected chain. 
 

 Plan DGN File – The name of the design file used to plot the construction limit lines 
 

 Existing Ground Line - The symbology for the cross section elements that make up the existing 
ground.  

 
 Proposed Finish Grade - The symbology for the cross section elements that make up the 

proposed grade. 
 
The remaining dialog items are described below: 
 

Plot Parameters 
The Plot Parameters item is used to define the symbology for the construction limit lines 
plotted in the Plan DGN file. 

 
Separate symbologies can be set for the construction limit lines to designate whether the cross 
sections are in Cut, Fill, or transitioning between the two. For ODOT projects,  the symbyology 
should be set as follows: 
 

Level RW_P_Const_Limits 

Color ByLevel 

Style ByLevel 

Weight ByLevel 

 
Tie Down Option 
Two options are provided. Set this to Outer Tie Downs for most ODOT projects. 

 
Apply 
Select Apply to initiate the process. The construction limit lines are drawn in the Plan DGN File. 
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The construction limits are drawn as individual line elements in the plan view design file with the 
endpoints of the lines defined by the cross section tie down point offset from the centerline. 
 
Typically, construction limits are shown an additional four feet outside the tie down points. The 
MicroStation Move Parallel command can be used to move the construction limit lines an additional 
four feet from the centerline. Since the construction limits are placed as a series of line elements, 
connecting the lines as a complex chain will make it easier to move the construction line as one element 
rather than moving the individual line segments. Take the following steps to create a complex chain 
from the construction limit lines and move the resulting complex chain by the four foot construction 
limit offset. 
 

 Set the MicroStation Active Level to RW_P_Const_Limits 
 

 Select the MicroStation Create Complex Chain command using the settings below. Pick the first 
line segment of the construction limit lines, accept the element. The Automatic Method will 
automatically make a complex chain out of all the connected elements. 

 
 Select the Move Parallel command. Use the Miter Mode to move the construction limit line 

four feet parallel as shown below. 
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9.3 The Profile Grade Report 

The GEOPAK Profile Grade Report can be used to search the cross sections design file for the key point 
text in order to generate a COGO chain and/or profile. COGO chains are generated by measuring the 
offset from the centerline of the cross section to the origin of the “key point” text. Profiles are 
generated by measuring the cross section elevation at the origin of the “key point” text. 

9.3.1 Criteria “Key Point” Text 

ODOT’s side slope and median criteria files are configured to place text at specific “key points” along the 
proposed cross section lines as shown in the figure below. 
 

 
 
The marked point numbers are the same on the left and right side of the cross sections. Points on the 
left side are appended with the letter “L”. Points in the median are appended with the letter “M”. Points 
on the right side are appended with the letter “R”. The “key point” text is placed on the following level: 
 

XS_P_Text_MarkedPoint. 

 
The marked point numbers are as follows: 
 

Point Location Point number 

Edge of graded shoulder 10 

Inside edge of ditch 33 

Center of ditch 34 

Outside edge of ditch 35 

Backslope break point 36 

Proposed to existing ground 37 

Construction limits 40 

 
In order for the GEOPAK Profile Grade report to function properly, the marked point text must fall on 
the cross section graphics within a user specified tolerance. If the user has made some edits to the 
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proposed cross section graphics, to move the ditches or change the backslope for example, the marked 
point text must me moved along with it in order to be used to store chains or profiles in COGO using the 
Profile Grade report. 

9.3.2 Processing the Profile Grade Report 

The Profile Grade Report is accessed from the GEOPAK XS Report dialog box. To access the XS Report 
dialog box, select Reports & XS Quantities from the Road Project dialog as shown below: 

 
The XS Report dialog has a variety of cross section reports. Each report is detailed on the GEOPAK on-
line help. This chapter will focus on the Profile Grade Report. Select Profile Grade to access the Profile 
Grade Report dialog shown on the following page. 
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When the Profile Grade Report dialog is opened, information stored with the GEOPAK Working 
Alignment is shared with the Profile Grade Report dialog box. The following information is taken from 
the active Working Alignment: 
 

 Job Number - The GEOPAK COGO data base job number. 
 

 Chain - The name of the COGO Chain that was used to extract the cross sections. 
  

 Existing Ground Line - The symbology for the elements that make up the existing ground line. 
 

 Proposed Finish Grade - The symbology for the elements that make up the proposed finish 
grade. 

 
The remaining dialog items are described on the following pages. 
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Beg Sta/End Sta 
GEOPAK determines the beginning and ending station from the cross sections within the MicroStation 
file. They are noted below the chain and placed in the key-in areas. If these defaults are used, the report 
is generated for the entire file. However, if a report for a smaller range is required, the user can simply 
key in the required beginning and/or ending station. 
 
Three options are supported in the center of the dialog: 

 
 The Criteria Elements option uses graphic cross section elements to store a chain and/or profile 

by finding the low points along the proposed cross section 
 

 The Search Text option uses text placed during the proposed cross section processing to store 
chains and/or profiles. 

 

 The Offset option creates a profile for any given chain and offset value. 
 
Use the Search Text option to store a chain at the location of the construction limits by reading the 
criteria Key-Point text. When the Search Text option is selected, the center portion of the dialog 
dynamically changes as shown below. 

 
The Store Text item is used to identify the marked point text for which you wish to search for in the 
cross section design file. For this example, we will search for the text 40R to store a chain representing 
the construction limits on the right side of the cross sections. 
 
Two options are available to control how the new chain and/or profile will be stationed as described 
below. 
 

Sta Design Alignment - With this option selected, you can only store a COGO profile, not a 
COGO chain. The stationing of the Chain listed in the top of the dialog will be used for the new 
profile. 
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Sta Text Alignment - With this option selected, you can store a COGO chain and/or profile. The 
chain and/or profile will be stored with a beginning station of 0+00. When Sta Text Alignment is 
selected, the dialog dynamically changes to allow the user to store a chain as shown below. 

 
The Add button is used to add the Text, Chain, Profile and Preference to the list box as shown below. 
Once a group of text parameters has been added to the list box, you can use the Delete or Modify 
button to remove the text item from the list, or to modify the value of the selected item. 

 
The Beginning Point Number field is used to identify the first point number for the stored COGO chain. 
Points will be stored incrementally for the total number of cross sections processed.  
 
IMPORTANT!!! If you select a point number that already exists in the COGO database, the points will be 
overwritten without notification, even if the COGO Redefine option is toggled off. 
 
The ASCII File option is used to specify the name of the file that will contain a list of the COGO 
commands used to store the chain. 
 
There is one important limitation of the Profile Grade Report that we must consider before processing. 
This function was written with the assumption that the user would always be searching for text that lies 
on the Proposed Finished Grade. In the case of construction limits, the text 40L and 40R are outside the 
Proposed Finished Grade and lie on the existing ground line. In order for the Profile Grade Report to 
pick up the text 40L and 40R you need to change the symbology settings for the Proposed Finished 
Grade to be the same as the Existing Ground Line. 
 
Select the Proposed Finish Grade item from the Search Criteria group to define the symbology for the 
Proposed Finished Grade. 

 
Set the symbology as shown on the following page. 
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Select Apply to begin processing. After processing, the following dialog will appear. 

 
New profiles and/or chains are stored in the COGO database. In this example, one chain was stored 
representing the location of the construction limits for the right side of the cross section. The chain can 
be plotted in the plan view design file using the Design and Computation Manager as shown on the 
following page. 
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After selecting the Construction Limits item, as shown above, select Draw COGO Element to access the 
Draw dialog shown on the right. Toggle the Operation to Chains and select the name of the chain that 
you would like to plot using the Construction Limits symbology. The construction limits are plotted on 
level RW_P_Const_Limits. 
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9.4 Exercise 9 

Use the key-point text 40R and 40L to save two COGO chains representing the construction limits. 
 

 According to Section 305.2 of the ODOT CADD Engineering Standards Manual, what should you 
assign as the Beginning Point Number? 

 

 According to Section 305.2 of the ODOT CADD Engineering Standards Manual, what should you 
assign as the name for the COGO chains representing the construction limits? 

 

 Plot the construction limits in the file 12345bp001.dgn using the D&C Manager. 
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10 Cross Section Sheets 

10.1  Overview 

The GEOPAK Cross Section sheet layout command provides a tool to generate cross section sheets from 
cross section graphics. Each cross section is referenced into the sheet design file to compile the cross 
section sheets. 
 
As the sheets are processed, the earthwork quantities can be included on the sheets. Most ODOT 
projects require cross section sheets early in the design process, before the quantities have been 
generated. GEOPAK does not provide an automated way to add, or update, the quantities to the sheets 
once they have been generated. The only method GEOPAK provides to update the quantities is to 
reprocess the sheets, discarding the previous sheet design file(s). 
 
ODOT has provided three MicroStation Visual Basic applications to assist the user with preparing the 
cross sections for the sheet clipping process. These tools can be used to include the earthwork and 
seeding quantities on the sheets without the need to reprocess the sheets. These applications are 
summarized below: 
 

ODOT_CombineQuantities.exe 
This application is used to read GEOPAK Earthworks and Seeding quantity output files to 
combine the quantities in one text file that can be used to place the earthwork and seeding 
quantities on the cross sections. 
 
ODOT_XSBoundary.mvba 
This application is used to draw a boundary element on the GEOPAK Cross Section cells. The 
boundary element is useful to define the clipping limits of each cross section when clipping the 
cross section sheets using GEPOPAK. Additionally, the boundary element contains insertion 
points for cross section quantities. 
 
ODOT_XSQuantities.mvba 
This application is used place earthwork and seeding quantities in a cross section boundary 
element created using the ODOT_XSBoundary.mvba application. The quantities are read from 
the file created using the CombineSeedine.exe application. 

 
These applications are documented in detail on the ODOT website: 
 
http://www.dot.state.oh.us/Divisions/Engineering/CADDMapping/CADD/MicroStation%20Applications/ODOT_XS_Utilities.pdf 

 
Each application is briefly summarized on the following pages. 
 
 
 
 

http://www.dot.state.oh.us/Divisions/Engineering/Production/CADD/MicroStation%20Applications/ODOT_XS_Utilities.pdf
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10.2   ODOT_XSBoundary.mvba 

The ODOT_XSBoundary.mvba application is used to draw a boundary around a GEOPAK Cross Section 
similar to the one shown in the example below. 

 
The boundary element is drawn at the width of a standard ODOT Cross section sheet cell and includes 
columns for the cross section quantities. The bounding element is intended to be used when clipping 
cross section sheets to set the XS Search Criteria limits for each cross section. This is explained in further 
detail on page 10-18. 
 
When clipping cross section sheets with GEOPAK, there are several advantages to using a bounding 
element to define the XS Search Criteria: 
 

 Using a bounding element allows you to define the XS Search Criteria symbology for only one 
element rather than selecting each element that is drawn on the cross sections. 

 
 Any cross section that does not have a bounding element will not be included on the final cross 

section sheets. This allows you to easily control which sections actually appear on the completed 
sheets without deleting cross sections or cross section cells. 

 
 The boundary element is beneficial when drawing and labeling graphics in the cross section cell 

design file to ensure that your new graphics will fit within the reference file clipping limits of the 
cross sections on the completed sheets. 

 
 Cross section quantities can be imported into the cross section cell design file using the 

ODOT_XSQuantities.mvba application, and subsequently referenced to the cross section sheets. 
This allows users to easily update earthworks and seeding quantities without re-clipping the 
cross section sheets. 

 
To run ODOT_XSBoundary.mvba, select ODOT > XS Utilities > XS Boundary from the MicroStation pull 
down menu, or key in the following command in MicroStation: 
 

vba load ODOT_XSBoundary.mvba;vba run xsBoundaryMain 

 
The dialog shown below will appear. 
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The XS Boundary element is initially displayed as temporary graphics using a weight zero dotted line. 
When the Draw XS Boundary button is selected, the boundary is drawn in the file as shown below, using 
the following symbology: 
 

Level Name = XS_P_Boundary 
Color = 131 

 

 
 
Tip: 
The vertical limits of the clipping border will determine the vertical extent of each cross section on the 
completed sheets. With this in mind, the clipping limits don’t necessarily have to be set as tightly as 
possible on each cross section. You can allow some extra space to control how many cross sections will 
appear on the completed sheets. For example, on a 5-scale cross section sheet, there are 21 horizontal 
grid lines encompassing 105’ of vertical cross section space per sheet. If you wish to place three cross 
sections on each cross section, draw the boundary elements with no more than 35’ vertically for each 
cross section.  If you wish to have four cross sections on a sheet, draw each border with a vertical extent 
of 25’. Etc… 
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10.3   ODOT_CombineQuantities.exe 

Chapter 7 – Earthwork Quantities details the process to generate cut and fill quantities for the cross 
sections. The resulting quantities are output to an ASCII text file that can be used to place the quantities 
on the cross section sheets when the sheets are clipped.  
 
GEOPAK also provides the capability to generate seeding quantities as detailed in the Chapter 8 – 
Seeding Quantities. The seeding file is not in a format that can be included on the cross section sheets. 
 
ODOT_CombineQuantities.exe is used to read the seeding quantity output file and append these 
quantities to the earthworks text file.  With the quantities combined into one file, both the earthwork 
and seeding quantities can be included on the cross section sheets. 
 
The application can be accessed from the MicroStation pull down menu by selecting ODOT > XS Utilities 
> Combine Quantities. The dialog shown on the following page is opened. 

 
Select the GEOPAK Seeding File and the Earthwork File to combine. Key-in the name of the Output file 
to be created by the application. Select Apply to append the seeding quantities to the earthwork 
quantities and generate the new output file. An example of the combined quantities is shown below: 
 
000000000000 1111111111 2222222222 3333333333 4444444444 5555555555 6666666666 

53+00.00/1           73         33          0          0      56.90          0 

53+25.00/1           58         31         61         30      55.71        157 

53+50.00/1           44         33         47         30      54.90        154 

53+75.00/1           35         40         36         34      55.90        153 

54+00.00/1           29         42         29         38      54.03        152 

54+25.00/1           29         40         27         38      53.06        149 

54+50.00/1           32         35         28         35      50.51        143 

54+75.00/1           39         25         33         28      48.26        138 

55+00.00/1           49         17         41         20      46.05        131 

 
The seeding quantities are appended in column 5 and 6 as shown above. 
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10.4    ODOT_XSQuantities.mvba 

This application is used place earthwork and seeding quantities within the limits of the cross section 
boundary elements created using the ODOT_XSBoundary.mvba application. The quantities are read 
from an ASCII text file created using the GEOPAK Earthwork computation process, or created by 
combining GEOPAK Earthwork and Seeding quantity files by use of the CombineSeeding.exe application. 
 
To run ODOT_XSQuantities.mvba, select ODOT > XS Utilities > XS Quantities from the MicroStation pull 
down menu, or key in the following command in MicroStation: 
 

vba load ODOT_XSQuantity.mvba;vba run xsQuantityMain 

 
The dialog shown below will open. 

 
Select the ASCII text file containing the quantities. The file is assumed to be in the same format as a 
GEOPAK Earthworks ASCII file as shown in the example below: 
 

000000000000 1111111111 2222222222 3333333333 4444444444 

 

53+50.00/1           66         33          0          0 

54+00.00/1           50         41        108         69 

54+50.00/1           53         34         96         69 

55+00.00/1           72         17        116         47 

55+50.00/1           90          5        150         21 

56+00.00/1          115          0        190          5 

56+50.00/1          141          0        237          0 

57+00.00/1          159          0        278          0 

 
The first row is assumed to be the header row and contains the column id information. The remaining 
rows are assumed to contain the cross section quantities. 
 
Column zero is assumed to contain the station and region as shown in the example above. 
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The ASCII file can contain either 4 or 6 columns containing the cross section quantities. The contents of 
each column are user definable, but it is recommended that you follow the guidelines detailed in the 
Chapter 7 – Earthwork Quantities. 
 
If an ASCII file is opened containing 6 columns of quantities, the dialog will appear as shown in the 
example below. 

 
The quantity values contained in columns 1, 2, 3, and 4 are user definable when the original earthworks 
quantity file is generated with GEOPAK. The ODOT GEOPAK Road 2 training guide recommends defining 
the columns in the following order: 
 

Column 1 = Cut End Area 
Column 2 = Fill End Area 
Column 3 = Cut Volume 
Column 4 = Fill Volume 

Columns 5 and 6 were generated using the ODOT_CombineQuantities.exe application and contain the 
following values: 
 

Column 5 = Seeding End Width 
Column 6 = Seeding Area 

 
If the order of the quantities contained in the columns does not match the values 
listed above, the user has the option to define the contents of each column using the 
drop down menu below each column as shown at right. 
 
 
Draw Quantities 
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When the Draw Quantities option is selected, the quantities are drawn on the currently selected cross 
section. The points placed within the cross section boundary are used as the insertion points for the 
quantities as shown in the example below. 

 
If a set of quantities has been previously placed for the cross section(s) using this application, the 
previously placed quantities will be automatically deleted from the cross section(s) when the Draw 
Quantities button is selected. 
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Exercise 10A – Cross Section Boundaries 

In this exercise we will prepare the cross sections for the sheet clipping process. 
 

1. Draw boundaries for the cross sections from station 52+00 R 1 to station 78+00 R 2 using the 
ODOT_XSBoundary.mvba application. 
 
As you place the clipping borders, keep in mind that these borders will be used to define the 
vertical limits of each cross section on the completed sheets. 
 

2. Use the ODOT_CombineQuantities.exe application to combine the earthwork and seeding files 
into one new file. 
 

3. Use the ODOT_XSQuantities.mvba application to place the quantities on the clipping borders. 
 
The completed sections should have a boundary element with quantities as shown in the example 
below. 
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10.5   Cross Section Sheet Design Files 

Before processing the cross sections, the user must create a new design file for the cross section sheets. 
Use the ODOT_Files.mvba application to create the new sheet design file. 
 
The application can be accessed by selecting ODOT > File Management > New Design File from the 
MicroStation pull down menu. 

 
Cross section sheets should always be processed into the Sheet Model of the newly created design file. 
If you use the ODOT_Files.mvba application to create the sheet file, the Sheet model will be set as the 
active model. If you create the file yourself, be sure to open the design file and select Files > Models to 
set the sheet model as the active model, and then select File > Save Settings. 
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10.6   Processing Cross Section Sheets  

10.6.1 Preparing the XS Cell File for Processing 

The cross section sheet clipping process uses reference files to display the cross sections on the 
completed sheets. The levels that are turned on in the cross section cell design file will be turned on in 
the sheets. Before processing, be sure to turn on/off the levels you wish to display on the cross section 
sheets.  
 
The following table lists some of the levels that should be turned off before processing the cross section 
sheets. This is not a complete listing; there may also be other levels that you may want to turn off. 
 

GK_Cells 
XS_P_Boundary 
XS_P_Earthwork_Shapes 
XS_P_Finished_Grade_Seeded 
XS_P_Pavt_Layers 

XS_P_Pavt_Surface 
XS_P_Shoulder_Surface 
XS_P_Text_Info 
XS_P_Text_MarkedPoint 

 

10.6.2 Cross Section Sheets 

The Cross Section Sheet function can be accessed by selecting Applications > Road > Cross Sections > 
Cross Section Sheet Composition from the MicroStation pull down menu, the GEOPAK Road tool 
palette, or the Road Project dialog as shown below. 
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After creating a new run, the Cross Section Sheet Composition dialog shown below is opened. 
 

 
 
The left side of the dialog contains a list of parameters required to process cross sections into sheets. 
When each parameter is selected, a graphic explanation of the parameter appears in the lower left 
portion of the dialog and key-in fields for each variable appear to the right.  
 
The various parameters, and the settings necessary to generate cross section sheets according to ODOT 
specifications, are described on the following pages. 

10.6.3 File Menu 

The File menu on the Cross Section Sheet Composition dialog has several choices, as shown below. 

 
Each option is described below: 
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Sheet Library 
The parameters for the Cross Section Sheet Composition dialog can be saved in a Sheet Library. 
The Sheet layout configuration can be saved and recalled for future use. Sheet libraries have a 
default extension of .xssl. Options are available to create a New sheet library, Attach an existing 
library, or Save a library. 
 
The sheet library ODOT.xssl has been configured for use with ODOT’s standard cross section 
sheet cells. This library can be obtained from the ODOT website. For ODOT users, the library is 
located in the following directory: 
 

I:\ODOTStd\V8iStd\geopak\road\sheet_library\odot.xssl 
 
Sheet 
Options are available to create a new sheet, delete a sheet, or update a sheet to the current 
settings. 
 
Load V7 Input File… 
To use a cross section sheet input file from a previous version of GEOPAK, create a new sheet, 
select Load V7 Input File and select the old sheet input file. The input file is used to populate the 
corresponding dialog fields. 
 
Save Settings 
This option is used to save the dialog settings for the current sheet run 
 
Scale Cross Sections 

 
This option is available to adjust the horizontal and vertical ration of the cross sections. The 
scaled sections are created in the file specified by the Output DGN File Name field. 
 
Layout Sheets 
This option starts the cross section sheet processing. This is the same as selecting the Layout 
Sheets button on the face of the Cross Section Sheet Composition dialog. 
 
Exit 
This exits the cross section sheet application, but does not exit MicroStation. 
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10.6.4 XS DGN File 

When the XS DGN File option is selected, the Cross Section Sheets dialog will appear as shown below. 

 
The parameters for the XS DGN File option are described below. 
 

Active Cross Section Sheet 
After attaching the ODOT cross section sheet library, the Active Cross Section Sheet option will 
display the sheet layout options shown below. 

 
The three Extended Width options are used when clipping sheets using XS Boundary elements. 
For each of these three options, the width of the clipping area has been extended to include the 
seeding and earthworks quantity columns within the reference boundaries for each cross 
section. 
 
XS DGN File 
This key-in field is used to specify the name of the design file containing the original cross 
sections. The file name can be typed in manually or selected by use of the Select XS Design File 
icon. 
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XS Baseline 
This drop down list is used to select the baseline chain for the cross sections to be processed.  
Note: The XS Baseline list is generated by reading the cross section cells contained in the file 
specified by the XS DGN File key-in field. This is not a list of chains in the GPK file. 
 
Begin Station 
Key-in the Begin Station for cross section sheet processing. This option defaults to the lowest 
stationed cross section, for the selected XS Baseline chain, in the file specified by XS DGN File. If 
a partial processing is desired, simply type in the desired station. 
 
End Station 
Key-in the End Station for cross section sheet processing. This option defaults to the highest 
stationed cross section, for the selected XS Baseline chain, in the file specified by XS DGN File. If 
a partial processing is desired, simply type in the desired station. 
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10.6.5 Sheet DGN File 

When the Sheet DGN File option is selected, the Cross Section Sheet Composition dialog will appear as 
shown below. 

 
Sheet DGN File 
Use this field to specify the name of the MicroStation design file where GEOPAK will compose 
the cross section sheets. GEOPAK does not create this file. The file must be created prior to 
processing. 
 
Section 302 of the ODOT CADD Engineering Standards Manual specifies that plan sheets should 
be placed in the Sheet Model of the design file. Take the following steps to ensure that the cross 
section sheets are placed in a sheet model: 
 

 Use ODOT_Files.exe to create the cross section sheet design file. The cross section sheet file 
will automatically be set with the sheet model as the active model. 

 
If you elect to create the sheet file manually, take the following steps after creating the file: 

 
1. Open the cross section sheet design file. The file will contain two Models, one Design 

Model and one Sheet Model. Select File > Models to access the Models dialog. 
2. Double-click the Sheet model to make it the active model. 
3. From the MicroStation pull-down menu select File > Save Settings. 

 
 
 
 
 
 



Ohio Department of Transportation, GEOPAK Road Training Guide October, 2012 

 

  
Page 10-16 Chapter 10 – Cross Section Sheets 
 

Horizontal Scale 
Vertical Scale 
These key-in fields are used to specify the scale for the cross section sheets. 
 
Sheet Placement Point 
The option is used to specify the X,Y coordinate location for the first cross section sheet. All 
other sheets will be placed in relation to this point. For ODOT projects, we recommend using the 
default values of 0,0. 
 
Detach Existing Sheets before Processing 
This option is only used when you elect to process cross section sheets into a design file that 
contains cross section sheets previously generated by GEOPAK. When this is toggled ON, any 
reference files that were attached in a previous run are detached and replaced with new 
references. Also any graphics from a previous run are deleted and replaced. 
 
Attachment 
Three options are provided to control how the sheets are placed in the cross section sheet 
design file. 

 
Each option is described below: 
 

All Sheets in Active Model - When using this option, all sheets are placed in the active 
model of the sheet design file. 
 
One Sheet Per Model - Each sheet is placed in its own model. The models will be named 
XS_SHEET_sheet_#. Nothing is placed in the active model of the sheet design file.  

  
One Sheet Per Model/Display All - Each sheet is placed in its own model. The models 
will be named XS_SHEET_sheet_#. All sheets are attached to the active model of the 
sheet design file as references. 

 
Section 302 of the ODOT CADD Engineering Standards Manual specifies that each sheet of the 
plan shall be contained in its own design file when submitted to the Department. The GEOPAK 
Attachment options above do not provide the capability to generate each cross section sheet in 
a separate design file. 
 
For ODOT plans, we recommend using the All Sheets in Active Model option. The ODOT 
program ODOT_XSSplitSheets.mvba application can be used to split the sheets into separate 
design files for digital submissions. 
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10.6.6 Sheet Dimensions / Cell  

When Sheet Dimensions/Cell is selected, the Cross Section Sheet Composition dialog will appear as 
shown below. 

 
The options have been configured to produce cross section sheets compliant with ODOT standards and 
should not normally be changed by the user. 
 

Sheet Dimensions 
The Width and Height values for the cross section sheet cells. These dimensions are multiplied 
by the Horizontal Scale and Vertical Scale options on the Sheet Design File option to set the 
scale for the cross section sheet cells. 
 
Place Sheet Cell 
These options are used to specify the cell Library and cell Name for the cross section sheet cell. 
The Scale is multiplied by the Horizontal Scale and Vertical Scale values on the Sheet Design File 
option to set the scale for the cross section sheet cells. The Sheet Offset from Cell Origin values 
are used to specify the location where the cross section data will be placed on the sheet cell. 
 
Sheet Cell Placement 
The sheet cells are normally placed using the Place Sheet Cell in XS Sheet file option for ODOT 
projects. 
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10.6.7 XS Search Criteria 

When the XS Search Criteria option is selected, the Cross Section Sheet Composition dialog will appear 
as shown below. 

 
These options are used to specify the vertical extents of each cross section which, in turn, determines 
the clipping limits for cross section reference attachments. Note that the XS Search Criteria is only used 
to set the vertical extents of each cross section on the completed sheets. The horizontal limits are set in 
the Margins and Spacing item. 
 

XS Element Search Criteria 
The XS Element Search Criteria option is used to specify which elements in the cross section will 
be used to define the vertical limits of each cross section. 
 
If you are clipping sheets using the cross section boundary element using one of the Extended 
Width sheet types, use the boundary element to define the search criteria as shown above. 
 
Note: This option is not used to specify which elements will be visible in the cross section 
references. The search criteria should not be defined to include the cross section cells. 
 
Vertical Search Range 
The Lower and Upper Range Limits are used to define the maximum vertical search range for 
each cross section. GEOPAK will search for elements meeting the XS Search Criteria within the 
limits of the Vertical Search Range. 
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10.6.8 Sheet Stack Orientation 

When the Sheet Stack Orientation option is selected, the Cross Section Sheet Composition dialog will 
appear as shown below. 

 
Sheet Stack Orientation 
Cross section sheets can be stacked either vertically or horizontally. The ODOT sheet 
configurations have been defined for Vertical orientation as shown above.  
 
Horizontal / Vertical Spacing 
These values are used to specify the distance between successive cross section sheets, from top 
to bottom when stacking is Vertical, from right edge to left edge if Horizontal stacking is used. 
 
Max Number of Sheets per Column 
By specifying the maximum number of sheets in the stack, the software will place each row or 
column with the specified number of sheets. The Cross Section Sheet configurations within 
ODOT.xssl have been configured with a default value of 3 as shown above. 
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10.6.9 Sheet Stack Columns 

When the Sheet Stack Columns option is selected, the Cross Sections Sheet Composition dialog will 
appear as shown below. 

 
Four options are supported: Single Stack, (one column per sheet), Double Stack (two columns per 
sheet), Triple Stack (three columns per sheet), and Quadruple Stack (four columns per sheet). 
 

Baseline X Offset 
The distance from the left edge of the sheet to the zero offset of the cross sections. The baseline 
of the cross section cell defines the zero offset. 
 
Col 2/3/4 Left Edge Offset 
When the cross sections are to be placed in Double Stack, Triple Stack, or Quadruple Stack 
mode, the zero offset of the left-hand stack of cross sections is determined by the Baseline X 
Offset. The center of the right-hand stack of cross sections is located a distance from the left 
edge of the sheet to the Second Column XS Stack Offset. 
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10.6.10 Margins and Spacing 

When the Margins and Spacing option is selected, the Cross Section Sheet Definition dialog will appear 
as shown below. 

 
When using ODOT.xssl, the values for the Margins and Spacing portion Cross Sections Sheet Composition 
dialog have been configured to conform to the dimensions of the ODOT standard cross section sheet 
cells and should not be changed by the user. 
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10.6.11 Station Labels 

When the Station Labels option is selected, the Cross Section Sheet Definition dialog will appear as 
shown below. 

 
The options in the Station Labels portion of the Cross Sections Sheet Composition dialog are used to 
define the symbology and offsets for Station Labels placed on the cross section sheets. For ODOT 
projects, users will typically place station labels in the cross section cell design file by use of the ODOT 
standard cross section criteria file XSLABEL.X, therefore, the Label Stations option should normally be 
left toggled off. 
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10.6.12 Offset Labels 

When the Offset Labels option is selected, the Cross Section Sheet Definition dialog will appear as shown 
below. 

 
Offset Labels can be placed at the top and bottom of the cross section sheets by defining the Offset 
Label Y Offset 1 and Offset Label Y Offset 2 values. 
 
For ODOT projects, users will typically place offset Labels at the bottom of the cross section sheets, but 
not at the top. When using ODOT.xssl, the values for the Offset Labels portion Cross Sections Sheet 
Composition dialog have been configured to conform to the dimensions of the ODOT standard cross 
section sheet cells and should not be changed by the user. The offset labels are placed on the level 
SH_Data. 
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10.6.13 Elevation Labels 

When the Elevation Labels option is selected, the Cross Section Sheet Definition dialog will appear as 
shown below. 

 
Elevation Labels can be placed at the left and right sides of the cross section sheets by defining the 
Elevation Label X Offset 1 and Elevation Label X Offset 2 values. 
 
For ODOT projects, users will typically place elevation labels at both sides of the cross section sheets. 
When using ODOT.xssl, the values for the Elevation Labels portion of the Cross Sections Sheet 
Composition dialog have been configured to conform to the dimensions of the ODOT standard cross 
section sheet cells and should not be changed by the user. The offset labels are placed on the level 
SH_Data. 
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10.6.14 Earthwork Quantity Labels 

When the Earthwork Quantity Labels option is selected, the Cross Section Sheet Composition dialog will 
appear as shown below. 
 

 
 
When using the cross section boundaries, the cross section quantities will be placed in the cross section 
design file and referenced into the sheets. In this case there is no need to configure the Earthwork 
Quantity Labels item. 
 
In cases where the boundary elements will not be used, the Earthwork Quantity Labels item can be 
configured to place the quantities in the sheet design file as detailed below. 
 
Earthwork quantities that have been generated by GEOPAK (see Chapter 7) are saved in an ASCII text 
file. To place these earthwork quantities on the cross section sheets, toggle on the Label Earthwork 
Quantities option and then key-in the name of the Earthwork Quantity File or select the file via the 
Select Earthwork Data File icon. A portion of a GEOPAK earthwork quantity file is shown below: 
 

000000000000 1111111111 2222222222 3333333333 4444444444 

 

53+50.00/1           66         33          0          0 

54+00.00/1           50         41        108         69 

54+50.00/1           53         34         96         69 

55+00.00/1           72         17        116         47 

55+50.00/1           90          5        150         21 

56+00.00/1          115          0        190          5 

56+50.00/1          141          0        237          0 

57+00.00/1          159          0        278          0 
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The first line of the file designates the column numbers. Column 0 represents the station and the region 
number. The content of the remaining columns is user definable and can contain many different values. 
In this example, column 1-4 were defined for the earthwork run as follows: 
 Column 1 = Cut End Area 
 Column 2 = Fill End Area 
 Column 3 = Cut Volume 
 Column 4 = Fill Volume 
 
Each column of the Earthwork Quantity File can be placed on the cross section sheets at user defined 
offsets as shown below. 

 
The selected earthworks file contains five columns as shown on the previous page. Within the dialog, 
the ID number corresponds to the column number defined on the first line of the Earthwork Quantity 
File. Using ODOT.xssl, columns 1-4 will be placed on the cross section sheets but column 0, representing 
the cross section station, is not plotted on the cross section sheets. 
 
In addition to the four columns defined for the earthwork quantities, column ID 5 and 6 have been 
configured with the proper offsets for seeding quantities. In the example above, column ID 5 and 6 are 
both ghosted since these columns are not contained within the file earthwork185.txt. 
 
If the selected earthworks file included seeding quantities, Columns 1-6 are defined as follows. 
 
 Column 1 = Cut End Area 
 Column 2 = Fill End Area 
 Column 3 = Cut Volume 
 Column 4 = Fill Volume 

Column 5 = Seeding End Width 
Column 6 = Seeding End Area 

 
Select the combined earthwork and seeding file. Column ID 5 and 6 are now un-ghosted and will be 
placed on the cross sections at the offsets shown on the following page. 
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The Display option is used to set symbology for the earthwork and seeding quantity text placed on the 
cross section sheets. Double-click the word “Sample” to access the EW Quantity Label dialog, as shown 
below. 
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10.6.15 Sheet Labels 

When the Sheet Labels option is selected, the Cross Section Sheet Composition dialog will appear as 
shown below. 

 
The Sheet Labels item can be used to place various labels on the cross section sheets. These labels can 
include title block information such as the beginning and ending station for each sheet, or the County-
Route-Section label. 
 
The labels are placed as text elements on top of the cross section sheet cell and cannot be placed using 
the Enter Data fields in the cell. This is not desirable since ODOT’s programs for sheet numbering and 
sheet indexing search the Enter Data fields for the values. For this reason, the Sheet Labels item will not 
be used. 
 
The ODOT application ODOT_XSSheetLabels.mvba can be 
used to complete the title block information after the 
sheets have been clipped.  The application can be accessed 
from the ODOT pull-down menu by selecting ODOT > XS 
Utilities > XS Sheet Labels. When the program is accessed, 
the dialog shown at right is opened.  
 
For more information on the application, select the Help 
icon on the dialog. 
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10.6.16 Digital InterPlot 

When the Digital InterPlot option is selected, the Cross Section Sheet Composition dialog will appear as 
shown below. 

 
This option can be used to generate a Digital InterPlot Plot Set. ODOT does not currently use Digital 
InterPlot. 
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10.6.17 Layout Sheets 

After you have configured the parameters of the Cross Section Sheet Composition dialog, select Layout 
Sheets to initiate the process. 
 
An example of a completed cross section sheet is show below.  

 
The ODOT MicroStation Visual Basic Application ODOT_XSSheetLabels.mvba can be used to complete 
the cross section sheet title block information. The application is located on the MicroStation menu by 
selecting ODOT > XS Utilities > XS Sheet Labels. 
 

 
 

For more information on this application, select the Help icon. 
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10.6.18 Post Processing Considerations 

XS Ground Lines 

Notice that the existing ground line extends through the quantity columns on the completed sheets. 
Users may wish to partial delete the ground line in the original cross section cell file so that it falls within 
the limits of the border element as shown in the example below. 

 

Offset Labels 

Since the horizontal clipping limits of the sheets has been extended to include the quantity columns, and 
extra Offset Label is drawn on the lower left and lower right of each cross section sheet. These labels 
should be deleted. This extra label, which should be deleted, is at the lower right of the cross section 
sheet, as shown in the example below. 

 
 
Note:  These labels can be removed using the ODOT_XSSheetLabels application showno n the previous 
page. 
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Match Lines and Cross Sections 

When clipping cross section sheets, GEOPAK does not provide the capability to automate match lining 
cross sections that extend beyond the width of the cross section sheet. Users can manually create match 
lines for specific cross sections as needed and use the boundary element to control the vertical limits of 
each cross section as it is referenced into the cross section sheets. 
 
In the example below, the cross section will extend into the quantity columns on the right side of the 
cross section sheets. 

 
Use the boundary element with a grid to facilitate breaking up the cross section into a match line 
segment as shown in the example below. 

 
The boundary element is used to define the vertical extents of the cross section on the completed sheet. 
The example on the following page shows the cross section on the completed sheet. 
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Note: The elevations on the side of the cross section sheet are placed by GEOPAK for the vertical extent 
of the boundary element. In the case where match lines are included within the clipping limits of these 
elevations must be manually edited to reflect the correct elevation values of the match line segment. 

Reference Levels 

The ODOT_XSBoundary.mvba application places 
boundary elements, and optionally grid lines, in 
the cross section cell design file that should not be 
displayed on the cross section sheets. Before 
clipping the cross section sheets with GEOPAK, be 
sure to turn off the following levels and Save 
Settings: 
 

SH_Major_Grid_Line 
XS_P_Boundary 

 
Note: ODOT’s cross section criteria files place 
elements on several other levels in the cross 
section cell design file that should not be 
displayed on the completed cross section sheets. 
Some of these levels are shown in the example at 
right. It is up to the user to review the levels 
shown in the cross sections to turn on/off the 
appropriate levels for the cross section sheets. 
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10.7   Preparing XS Sheet Files for Electronic Submission 

When cross section sheets are generated using the All Sheets in Active Model option, the sheets are 
plotted in the design file similar to the example shown below. 

 
Section 304.4 of the ODOT CADD Engineering Standards Manual states that each sheet of the completed 
plans shall be contained in separate design files when submitted to the Department. The ODOT 
application ODOT_XSSplitSheets.mvba can be used to split the cross sections into separate design files. 
The application is located on the MicroStation menu by selecting ODOT > XS Utilities > XS Split Sheets. 

 
For more information on this application, select the Help icon. After processing the sheets with this 
application, a new design file is created for each sheet. The Title and Comments fields for the sheets are 
populated with information from the sheet as shown below. 
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Exercise 10B 

Using this section as a guide, generate the cross section sheets for S.R. 185. 
 

1. Use the ODOT_Files application to create the new cross section sheet design file.  
 

What is the name of the cross section sheet design file? 
 
Which sub-directory is this file created in? 

 
2. Configure the Cross Section Sheets dialog and process the sheets using the All Sheets in Active 

Model option. 
 

3. Use the application ODOT_XSSheetLabels.mvba to fill in the title block information. 
 

4. Separate the cross section sheets into separate design files using ODOT_XSSplitSheets.mvba. 
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